N600 WiFi DSL Modem Router
Model D3600

AC750 WiFi DSL Modem Router
Model D6000

User Manual

December 2015
202-11386-02

350 East Plumeria Drive
San Jose, CA 95134
USA
Support
Thank you for purchasing this NETGEAR product. You can visit www.netgear.com/support to register your product, get help, access the latest downloads and user manuals, and join our community. We recommend that you use only official NETGEAR support resources.

Conformity
For the current EU Declaration of Conformity, visit http://kb.netgear.com/app/answers/detail/a_id/11621.

Compliance
For regulatory compliance information, visit http://www.netgear.com/about/regulatory.
See the regulatory compliance document before connecting the power supply.

Trademarks
© NETGEAR, Inc., NETGEAR and the NETGEAR Logo are trademarks of NETGEAR, Inc. Any non–NETGEAR trademarks are used for reference purposes only.
Contents

Chapter 1  Hardware Overview of the Modem Router

Unpack Your Modem Router ................................................................. 9
Top Panel with LEDs ............................................................................ 10
Back Panel with Ports, Buttons, DC Connector, and Antennas .......... 11
Bottom Panel Product Label ................................................................. 13

Chapter 2  Install and Access the Modem Router and Its Network

Position Your Modem Router ............................................................... 15
Before You Connect to the Modem Router .......................................... 16
Wired Connection .................................................................................. 16
WiFi Connection ................................................................................... 16
Types of Logins ..................................................................................... 17
NETGEAR genie Setup Wizard .............................................................. 17
Set Up Your Modem Router for DSL Service ..................................... 18
DSL Service ......................................................................................... 18
Cable the Modem Router for DSL Service and Access the Modem Router 19
Set Up Your Modem Router for Cable or Fiber Service ..................... 26
Log In to the Modem Router After Setup to View or Change Settings . 33
Change the Language ............................................................................ 34
Change the admin Password ................................................................. 35
Let the Modem Router Automatically Update Its Firmware ................. 36
Access the Modem Router with the NETGEAR genie App ................. 37

Chapter 3  Manage the Internet Settings Manually

Use the Setup Wizard After Initial Setup ............................................. 39
Manually Set Up the Internet Connection ........................................... 44
Specify an Internet Connection Without a Login .............................. 44
Specify an Internet Connection That Uses a Login and PPPoE Service 47
Specify an Internet Connection That Uses a Login and PPPoA Service 50
Manage the MTU Size ......................................................................... 52
MTU Concepts ..................................................................................... 52
Change the MTU Size ......................................................................... 53

Chapter 4  Manage the WiFi Network Settings

Manage the Basic WiFi Settings and WiFi Security of the Main Network 56
View or Change the Basic WiFi Settings .............................................. 56
Configure WEP Legacy WiFi Security ............................................... 62
Use WPS to Add a Device to the WiFi Network ................................. 64
Use WPS with the Push Button Method ........................................ 64
Use WPS with the PIN Method ....................................................... 66
Manage the WiFi Settings and WiFi Security of the Guest Network .... 67
Set Up and Enable a Guest Network .............................................. 67
Configure WEP Legacy WiFi Security for the Guest WiFi Network ..... 71
Control the WiFi Radios ............................................................... 73
Use the WiFi On/Off Button .......................................................... 73
Enable or Disable the WiFi Radios .................................................. 74
Manage the WPS Settings .............................................................. 75
Manage Advanced WiFi Features .................................................. 76
Manage Wi-Fi Multimedia Quality of Service ............................... 78

Chapter 5  Control Access to the Internet

Set Up Parental Controls ............................................................... 81
Use Keywords to Block Internet Sites .......................................... 85
Set Up Blocking ........................................................................... 85
Remove a Keyword or Domain from the Blocked List ...................... 86
Remove All Keywords and Domains from the Blocked List ............... 87
Specify a Trusted Computer .......................................................... 87
Manage Simple Outbound Firewall Rules for Services and Applications ... 89
Add an Outbound Firewall Rule ..................................................... 89
Add an Outbound Firewall Rule for a Custom Service or Application ... 91
Change an Outbound Firewall Rule ................................................. 93
Remove an Outbound Firewall Rule ................................................ 94
Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules ... 95
Set Up a WiFi Access List and Manage WiFi Access ......................... 97
Set Up and Enable a WiFi Access List ............................................. 97
Change the Settings for a Device on the WiFi Access List ................ 98
Remove a Device From the WiFi Access List .................................... 99
Set Up Security Event Email Notifications ...................................... 100

Chapter 6  Share a Storage Device

USB Device Requirements ............................................................. 104
Connect a USB Device to the Modem Router ................................ 104
Access a Storage Device Connected to the Modem Router .......... 105
Back Up Windows Computers with ReadySHARE Vault ................ 106
Back Up Mac Computers with Time Machine ............................... 106
Set Up a USB Hard Drive on a Mac ................................................. 106
Prepare to Back Up a Large Amount of Data .................................. 107
Use Time Machine to Back Up onto a Storage Device ..................... 107
Control Access to a Storage Device ................................................. 108
Use FTP Within Your Network ....................................................... 110
View Network Folders on a Device ............................................... 111
Add a Network Folder on a Storage Device .................................... 112
Change a Network Folder, Including Read and Write Access, on a USB Drive 113
Safely Remove a USB Device ........................................................... 115
**Chapter 7  Share a USB Printer**

- Install the Printer Driver and Cable the Printer .......................... 117
- Download the ReadySHARE Printer Utility .................................. 117
- Install the ReadySHARE Printer Utility ...................................... 118
- Use the Shared Printer ............................................................ 119
- View or Change the Status of a Printer ...................................... 120
- Use the Scan Feature of a Multifunction USB Printer .................... 121
- Change NETGEAR USB Control Center Settings ......................... 122
- Change the NETGEAR USB Control Center Language .................. 123
- Specify the Time-out .............................................................. 123

**Chapter 8  Access Storage Devices Through the Internet**

- Set Up and Manage Dynamic DNS ............................................ 125
- Your Personal FTP Server ...................................................... 125
- Set Up Dynamic DNS ............................................................ 126
- Access Storage Devices Through the Internet ............................. 127
- Set Up FTP Access Through the Internet ................................... 127
- Access Storage Devices Through the Internet with FTP ............... 129

**Chapter 9  Manage the WAN and LAN Network Settings**

- Manage the ADSL Settings ..................................................... 131
- Change the Type of Physical WAN Connection ........................... 133
- Manage the WAN Security Settings ......................................... 134
- Set Up a Default DMZ Server .................................................. 135
- Manage IGMP Proxying and VPN Pass-Through ........................... 136
- Manage NAT Filtering ............................................................ 137
- Manage the SIP Application-Level Gateway .............................. 137
- Manage the Modem Router's LAN IP Address Settings ............... 138
- Manage Reserved LAN IP Addresses ....................................... 139
- Reserve a LAN IP address ....................................................... 139
- Change a Reserved IP Address ................................................. 140
- Remove a Reserved IP Address Entry ...................................... 141
- Change the Modem Router’s Device Name ................................. 141
- Manage the DHCP Server Address Pool ................................... 142
- Disable the Built-In DHCP Server ............................................ 143
- Set Up and Manage Custom Static Routes .................................. 144
- Set Up a Static Route ............................................................. 145
- Change a Static Route ........................................................... 147
- Remove a Static Route ........................................................... 147
- Improve Network Connections with Universal Plug and Play .......... 148

**Chapter 10  Manage the Modem Router and Monitor the Traffic**

- Update the Firmware of the Modem Router .............................. 151
- Check for New Firmware and Update the Modem Router ............. 151
- Manually Upload New Firmware and Update the Modem Router .... 152
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage the Configuration File of the Modem Router</td>
<td>153</td>
</tr>
<tr>
<td>Back Up the Settings</td>
<td>153</td>
</tr>
<tr>
<td>Restore the Settings</td>
<td>154</td>
</tr>
<tr>
<td>Return the Modem Router to Its Factory Default Settings</td>
<td>155</td>
</tr>
<tr>
<td>Use the Reset Button</td>
<td>155</td>
</tr>
<tr>
<td>Erase the Settings</td>
<td>156</td>
</tr>
<tr>
<td>View the Status and Statistics of the Modem Router</td>
<td>157</td>
</tr>
<tr>
<td>View Information About the Modem Router and the Internet, Modem, and WiFi Settings</td>
<td>157</td>
</tr>
<tr>
<td>View the Traffic Statistics</td>
<td>161</td>
</tr>
<tr>
<td>View or Change a PPPoE or PPPoA Internet Connection</td>
<td>164</td>
</tr>
<tr>
<td>View or Change a TCP/IP Internet Connection</td>
<td>165</td>
</tr>
<tr>
<td>Manage the Activity Log</td>
<td>167</td>
</tr>
<tr>
<td>View the Logs</td>
<td>167</td>
</tr>
<tr>
<td>Specify Which Activities Are Logged</td>
<td>168</td>
</tr>
<tr>
<td>View Devices Currently on the Network</td>
<td>169</td>
</tr>
<tr>
<td>Manage the Modem Router Remotely</td>
<td>170</td>
</tr>
<tr>
<td>Chapter 11 Manage Port Forwarding and Port Triggering</td>
<td></td>
</tr>
<tr>
<td>Manage Port Forwarding to a Local Server for Services and Applications</td>
<td>173</td>
</tr>
<tr>
<td>Forward Incoming Traffic for a Default Service or Application</td>
<td>173</td>
</tr>
<tr>
<td>Add a Port Forwarding Rule with a Custom Service or Application</td>
<td>174</td>
</tr>
<tr>
<td>Change a Port Forwarding Rule</td>
<td>176</td>
</tr>
<tr>
<td>Remove a Port Forwarding Rule</td>
<td>177</td>
</tr>
<tr>
<td>Application Example: Make a Local Web Server Public</td>
<td>178</td>
</tr>
<tr>
<td>How the Modem Router Implements the Port Forwarding Rule</td>
<td>179</td>
</tr>
<tr>
<td>Manage Port Triggering for Services and Applications</td>
<td>179</td>
</tr>
<tr>
<td>Add a Port Triggering Rule</td>
<td>180</td>
</tr>
<tr>
<td>Change a Port Triggering Rule</td>
<td>182</td>
</tr>
<tr>
<td>Remove a Port Triggering Rule</td>
<td>183</td>
</tr>
<tr>
<td>Specify the Time-Out Period for Port Triggering</td>
<td>184</td>
</tr>
<tr>
<td>Disable Port Triggering</td>
<td>185</td>
</tr>
<tr>
<td>Application Example: Port Triggering for Internet Relay Chat</td>
<td>185</td>
</tr>
<tr>
<td>Chapter 12 Troubleshooting</td>
<td></td>
</tr>
<tr>
<td>Quick Tips for Troubleshooting</td>
<td>188</td>
</tr>
<tr>
<td>Troubleshoot with the LEDs</td>
<td>189</td>
</tr>
<tr>
<td>Power LED Is Off</td>
<td>189</td>
</tr>
<tr>
<td>WiFi LED Is Off</td>
<td>189</td>
</tr>
<tr>
<td>Ethernet LED Is Off</td>
<td>190</td>
</tr>
<tr>
<td>You Cannot Log In to the Modem Router</td>
<td>190</td>
</tr>
<tr>
<td>Troubleshoot the Internet Connection</td>
<td>191</td>
</tr>
<tr>
<td>Troubleshoot the DSL Link</td>
<td>191</td>
</tr>
<tr>
<td>Internet LED Is Off</td>
<td>192</td>
</tr>
<tr>
<td>Obtain an Internet IP Address</td>
<td>192</td>
</tr>
<tr>
<td>Troubleshoot PPPoE or PPPoA</td>
<td>193</td>
</tr>
<tr>
<td>Troubleshoot Internet Browsing</td>
<td>194</td>
</tr>
</tbody>
</table>
Appendix A  Supplemental Information

Factory Settings .......................................................... 199
Technical and Environmental Specifications ...................... 201
Hardware Overview of the Modem Router

This manual describes the following models:

- **NETGEAR® N600 WiFi DSL Modem Router, Model D3600.**
  Provides two radios with WiFi connection speeds up to 300 Mbps per radio for a total aggregate throughput of 600 Mbps. The 2.4 GHz radio supports 802.11n and the 5 GHz radio supports 802.11na.

- **NETGEAR® AC750 WiFi DSL Modem Router, Model D6000.**
  Provides two radios with WiFi connection speeds up to 300 Mbps for the 2.4 GHz radio and up to 433 Mbps for the 5 GHz radio for a total aggregate throughput of 750 Mbps. The 2.4 GHz radio supports 802.11n and the 5 GHz radio supports 802.11ac.

For each model, both radios can be active simultaneously. These models are compatible with most major DSL Internet service providers and also supports cable or fiber Internet service.

In this manual, both models are referred to as the modem router. Also, in this manual, the terms wireless and WiFi are interchangeable.

The chapter contains the following sections:

- Unpack Your Modem Router
- Top Panel with LEDs
- Back Panel with Ports, Buttons, DC Connector, and Antennas
- Bottom Panel Product Label

---

**Note:** For more information about the topics that are covered in this manual, visit the support website at support.netgear.com.

---

**Note:** Firmware updates with new features and bug fixes are made available from time to time at downloadcenter.netgear.com. You can check for and download new firmware manually. If the features or behavior of your product does not match what is described in this guide, you might need to update your firmware.

---

1. Actual data throughput and WiFi coverage will vary. Network conditions and environmental factors, including volume of network traffic, building materials and construction, and network overhead, lower actual data throughput rate and WiFi coverage. NETGEAR makes no express or implied representations or warranties about this product’s compatibility with any future standards.
Unpack Your Modem Router

Your package contains the following items.

Figure 1. Package contents for the modem router

Your package might contain more items. The filter or phone cable provided depends on the region, and in some locations, a CD is included.
Top Panel with LEDs

The modem router displays status LEDs on top.

![Modem router top panel with LEDs](image)

Figure 2. Modem router top panel with LEDs

The following table describes the LEDs from right to left and their behavior. For information about how to troubleshoot with the LEDs, see *Troubleshoot with the LEDs* on page 189.

Table 1. LED descriptions

<table>
<thead>
<tr>
<th>LED</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| Power   | ![Green LED] | - **Solid green.** The power is on and the modem router is functioning normally.  
- **Blinking green.** The modem router is starting up, the firmware is upgrading, or someone pressed the *Reset* button.  
- **Off.** The modem router is not receiving power. |
| DSL     | ![Eye] | - **Solid green.** The modem router is providing a DSL connection. In technical terms, the DSL port is synchronized with an ISP’s network-access device.  
- **Blinking green.** The modem router is negotiating the best possible speed on the DSL line.  
- **Off.** The modem router is not negotiating the speed on the DSL line and is not providing a DSL connection. |
| Internet| ![Internet] | - **Solid green.** The modem router is connected to the Internet.  
- **Blinking green.** The Internet port is transmitting or receiving traffic.  
- **Off.** The modem router is not connected to the Internet. |
| WiFi    | ![WiFi] | - **Solid green.** The modem router is providing WiFi connectivity.  
- **Blinking green.** The WiFi link is transmitting or receiving traffic.  
- **Off.** The modem router is not providing WiFi connectivity. You can still plug an Ethernet cable into one of the LAN ports to get wired connectivity. |
Table 1. LED descriptions (continued)

<table>
<thead>
<tr>
<th>LED</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| WPS  | ![WPS Icon](image) | • **Solid green.** WPS (Wi-Fi Protected Setup) is ready for use. By default, the WPS LED lights solid green when the power is on.  
• **Blinking green for two minutes.** Someone pressed the WPS button on the modem router to join the WiFi network. For more information, see *Use WPS to Add a Device to the WiFi Network* on page 64. |
| USB  | ![USB Icon](image) | • **Solid green.** A USB device is connected and is ready.  
• **Blinking green.** A USB device is plugged in and is trying to connect.  
• **Off.** No USB device is connected, or someone clicked the *Safely Remove Hardware* button and it is now safe to remove the attached USB device. |
| Ethernet | ![Ethernet Icon](image) | • **Solid green.** One or more Ethernet ports are connected to powered-on devices.  
• **Blinking green.** One or more Ethernet ports are transmitting or receiving traffic.  
• **Off.** None of the Ethernet ports are connected to a powered-on device. |

**Back Panel with Ports, Buttons, DC Connector, and Antennas**

The following figure shows the ports, button, DC connector, and antennas on the back panel of the modem router.

![Modem router back panel](image)

**Figure 3. Modem router back panel**
Viewed from left to right, the back panel contains the following components:

- **Antenna.** One fixed antenna that you can swivel in any direction.

- **DC power connector.** Connect the power adapter that came in the product package to the DC power connector.

- **USB port.** One USB 2.0 port.

- **Ethernet LAN ports.** Four Gigabit Ethernet RJ-45 LAN ports to connect the modem router to LAN devices. These ports are colored yellow. The LAN4 WAN port can also function as a WAN port for cable or fiber service.

- **ADSL port.** One RJ-11 asynchronous DSL (ADSL) port for connecting the modem router to an ADSL line. This port is colored gray.

  **Note:** You can use either the ADSL port or the LAN4 WAN port for Internet connectivity.

- **Reset and WPS button.** This button provides the following two functions:
  - **Activating WPS.** Pressing this button for 1–5 seconds activates WPS (Wi-Fi Protected Setup) to let you add a WiFi device to the WiFi network without typing the WiFi password. For information about this function, see *Use WPS with the Push Button Method* on page 64.
  - **Resetting the modem router to factory default settings.** Pressing this button for 6–15 seconds resets the modem router to factory default settings. For more information, see *Use the Reset Button* on page 155.
  - **Powering off the modem router.** Pressing this button for 15 seconds or more powers off the modem router. To power on the modem router, disconnect the power adapter from the modem router and plug it back in.

- **WiFi On/Off button.** Press the **WiFi On/Off** button to turn the WiFi radios on or off.

- **Antenna.** A second fixed antenna that you can swivel in any direction.

Although you can swivel the antennas in any direction, for best performance, NETGEAR recommends that you position the antennas perpendicular, that is, at a 90-degree angle to each other.

Figure 4. Recommended antenna angle
Bottom Panel Product Label

The product label on the bottom panel of the modem router lists the login information, WiFi network name (SSID), network key (password), serial number, and MAC address of the modem router.

![Modem router product label](image)

**Figure 5. Modem router product label**
Install and Access the Modem Router and Its Network

This chapter describes how you can install and access the modem router and its network.

The chapter contains the following sections:

• Position Your Modem Router
• Before You Connect to the Modem Router
• Set Up Your Modem Router for DSL Service
• Set Up Your Modem Router for Cable or Fiber Service
• Log In to the Modem Router After Setup to View or Change Settings
• Change the Language
• Change the admin Password
• Let the Modem Router Automatically Update Its Firmware
• Access the Modem Router with the NETGEAR genie App
Position Your Modem Router

The modem router lets you access your network anywhere within the operating range of your WiFi network. However, the operating distance or range of your WiFi connection can vary significantly depending on the physical placement of your modem router. For example, the thickness and number of walls the WiFi signal passes through can limit the range.

Additionally, other WiFi access points in and around your home might affect your modem router’s signal. WiFi access points are routers, repeaters, WiFi range extenders, and any other device that emits a WiFi signal for network access.

Position your modem router according to the following guidelines:

• Place your modem router near the center of the area where your computers and other devices operate and within line of sight to your WiFi devices.

• Make sure that the modem router is within reach of an AC power outlet and near Ethernet cables for wired computers.

• Place the modem router in an elevated location, minimizing the number walls and ceilings between the modem router and your other devices.

• Place the modem router away from electrical devices such as these:
  - Ceiling fans
  - Home security systems
  - Microwaves
  - Computers
  - Base of a cordless phone
  - 2.4 GHz cordless phone

• Place the modem router away from large metal surfaces, large glass surfaces, insulated walls, and items such as these:
  - Solid metal door
  - Aluminum studs
  - Fish tanks
  - Mirrors
  - Brick
  - Concrete

If you are using adjacent access points, use different radio frequency channels to reduce interference.

For information about the best angle for the antennas of the modem router, see Back Panel with Ports, Buttons, DC Connector, and Antennas on page 11.
Before You Connect to the Modem Router

During and after installation, you can connect to the modem router’s network through a wired or WiFi connection. If you set up your computer to use a static IP address, change the settings of your computer so that it uses Dynamic Host Configuration Protocol (DHCP).

Wired Connection

You can connect your computer to the modem router using an Ethernet cable and join the modem router’s local area network (LAN).

WiFi Connection

You can connect to the modem router’s WiFi network, which is listed on the product label in the WiFi Network Name (SSID) field. The password that you must use to connect to the WiFi network is listed in the Network Key (Password) field.

Figure 6. Modem router product label with WiFi network name (SSID) and password (network key)
Types of Logins

Separate types of logins serve different purposes. It is important that you understand the difference so that you know which login to use when.

Types of logins:

- **ISP login.** The login that your Internet service provider (ISP) gave you logs you in to your Internet service. Your ISP gave you this login information in a letter or some other way. If you cannot find this login information, contact your ISP.

- **WiFi network key or password.** Your modem router is preset with a unique WiFi network name (SSID) and password for WiFi access. This information is on the product label. Use this information to connect a WiFi device to the WiFi network of the modem router.

- **Modem Router login.** This logs you in to the modem router interface as admin from an Internet browser.

NETGEAR genie Setup Wizard

How you can use the NETGEAR genie Setup Wizard during installation and setup of your modem router depends on the type of Internet service that you use:

- **DSL service.** If you install your modem router for DSL service, you can set up your modem router with the NETGEAR genie Setup Wizard, which launches the first time that you set up the Internet connection for your modem router. The NETGEAR genie Setup Wizard runs on any device with a web browser.

For more information, see *Set Up Your Modem Router for DSL Service* on page 18.

- **Cable or fiber service.** If you install your modem router for cable or fiber service, you must cancel the NETGEAR genie Setup Wizard when it launches the first time that you set up the Internet connection for your modem router. You must first use the web management interface to change the default WAN connection method and then manually start the NETGEAR genie Setup Wizard.

For more information, see *Set Up Your Modem Router for Cable or Fiber Service* on page 26.

**Note:** After installation and setup, the NETGEAR genie Setup Wizard is always accessible, either for an installation with cable or fiber service or for an installation with DSL service.

Whether you install your modem router for DSL service or for cable or fiber service, you can always use the genie menus and screens to set up your modem router manually.

Before you start the setup process, get your ISP information and make sure that the settings that are described here are specified for the computers and devices in the network.
When your Internet service starts, your Internet service provider (ISP) typically gives you all the information that you need to connect to the Internet.

For DSL service, you might need the following information to set up your modem router:

- The ISP configuration information for your DSL account
- ISP login name and password
- Fixed or static IP address settings (special deployment by ISP; this setting is rare)

If you cannot locate this information, ask your ISP to provide it. When your Internet connection is working, you no longer need to launch the ISP login program on your computer to access the Internet. When you start an Internet application, your modem router automatically logs you in.

**Set Up Your Modem Router for DSL Service**

You can install your modem router for DSL service or for cable or fiber (Ethernet WAN) service. If you use a DSL modem, follow the procedure that is described in *Cable the Modem Router for DSL Service and Access the Modem Router* on page 19. If you use a cable or fiber modem, follow the procedure that is described in *Set Up Your Modem Router for Cable or Fiber Service* on page 26.

**DSL Service**

Make sure that your DSL service is active before you install the modem router. You need the following information to install your DSL modem and connect to the Internet:

- **DSL user name and password.** This information is included in the welcome letter your DSL ISP sent you when you signed up for your service. Record your DSL Internet service account user name and password.

- **Your telephone number or DSL account number.** If you do not use voice service, you can use your DSL account number in place of a phone number.

If you do not know or cannot locate your DSL user name and password, call your DSL Internet service provider (ISP). Be specific when speaking with your DSL Internet service provider. For example, you could say, “I need my DSL service user name and password. Can you help me?”

---

**Note:** If your provider says that they do not support NETGEAR services, tell them that you need only your DSL user name and password; you do not need support.
Cable the Modem Router for DSL Service and Access the Modem Router

The following figure shows the cabling of your modem router for DSL service.

Figure 7. Modem router cabling for DSL service

To connect your modem router to a DSL service:

1. Unplug your DSL modem’s power, leaving the DSL modem connected to the wall jack for your Internet service.
2. If your DSL modem includes a battery backup, remove the battery.
3. Install an ADSL microfilter between the phone line and the phone.
   
   The product package contains an ADSL microfilter.
4. Use a phone cable to connect the microfilter to the gray ADSL port on the modem router.
   
   The product package contains a phone cable.
5. If your DSL modem includes a battery backup, reinsert the battery.
6. Plug in your DSL modem’s power and turn on your DSL modem.
7. Connect the power adapter to the modem router and plug it into an electrical outlet.

Wait for the Power LED to light solid green, which takes about 80 seconds. (The Power LED lights solid green for about 20 seconds and then blinks for about one minute before it lights solid green again.)
8. Connect a computer to the modem router by one of the following methods:
   • **Ethernet cable.** Use an Ethernet cable to connect your computer to a yellow Ethernet port on the modem router.
     The product package contains a yellow Ethernet cable.
     Your computer connects to the modem router's LAN.
   • **WiFi.** Connect to the default WiFi network of the modem router:
     a. On your computer or WiFi device, find and select the WiFi network.
        The WiFi network name (SSID) is on the product label.
     b. Join the WiFi network and enter the WiFi password.
        The password (network key) is on the product label.
     Your computer or WiFi device connects to the modem router's WiFi network.

9. Launch a web browser.
   The NETGEAR genie Setup Wizard displays.

   ![Configuring the Internet Connection](image)

   If the NETGEAR genie Setup Wizard displays, skip to *Step 11*. If it does not display, do the following:
   a. In the address field of the web browser, enter **www.routerlogin.net**.
   b. When prompted, enter **admin** for the user name and **password** for the password.

   If the NETGEAR genie Setup Wizard displays, skip to *Step 11*. If the NETGEAR genie Setup Wizard still does not display, see *Step 10*.

10. If the browser cannot display the web page, do the following:
    • Make sure that the computer is connected to one of the LAN Ethernet ports or over WiFi to the modem router.
    • Make sure that the Power LED of the modem router is lit green.
    • Make sure that your browser does not cache the previous page by closing and reopening the browser.
• Clear the browser cache.
• If the computer is set to a static or fixed IP address (this setting is uncommon), either change the computer to obtain an IP address automatically from the modem router through DHCP, or change the IP address of the computer to a static or fixed IP address in the 192.168.1.2–192.168.1.254 range.

11. Keep the Yes radio button selected (which is the default setting) and click the Next button. The Setup Wizard starts.

12. From the Country menu, select the country in which you use the modem router.
13. From the ISP menu, select the ISP that you are using.
   If your ISP is not in the menu, select Other.
14. Select the Yes radio button.
15. Click the Next button.
   The Setup Wizard searches your Internet connection for servers and protocols to determine your ISP configuration.

When the modem router is connected to the Internet, the Congratulations! screen displays, and you successfully completed the setup process.

If the Congratulations! screen does not display, other screens might display and you might need to provide more information, in which case you must continue with the next step. The screens that display depend on your type of ISP connection and configuration.
16. (Only if the following screen displays) Specify a full scan to let the Setup Wizard find the PVC protocol.

The screen that displays might ask you if you need the Setup Wizard to do a full scan to find the PVC protocol. If this screen does not display, continue with the next step.

Do the following:

a. Select the Yes radio button.

b. Click the Next button.

The Setup Wizard performs a full scan, which might take up to six minutes.

17. (Only if the following screen displays) Specify how to manage problems with the detection of the Internet connection.

The screen that might display states that a problem occurred while detecting the Internet connection. If this screen does not display, continue with the next step.
Note: The option for the Ethernet cable connection that is stated onscreen applies to a cable or fiber Internet connection only (see Set Up Your Modem Router for Cable or Fiber Service on page 26).

Take one of the following actions:

- If you already power-cycled the DSL modem (see Step 1 through Step 7), do the following:
  a. Select the None of the above radio button.
  b. Click the Next button.
- If you did not yet power-cycle the DSL modem, do the following:
  a. Unplug your DSL modem’s power, leaving the DSL modem connected to the wall jack for your Internet service.
  b. If your DSL modem includes a battery backup, remove the battery.
  c. Wait 10 seconds.
  d. If your DSL modem includes a battery backup, reinsert the battery.
  e. Plug in your DSL modem’s power and turn on your DSL modem.
  f. Wait two minutes.
  g. Select the I just power cycled the modem and waited for 2 minutes radio button.
  h. Click the Next button.

18. (Only if the following screen displays) Specify how to manage problems with the detection of the IP address for the Internet connection.

The screen that might display states that a problem occurred while detecting the Internet connection IP address.
Take one of the following actions:

- If your ISP assigned you a fixed (static) IP address, do the following:
  a. Select the Yes radio button.
  b. Click the Next button.
  c. Enter the address information that your ISP gave you for your fixed IP address configuration.
  d. Click the Next button.

- If your ISP did not assign you a fixed IP address or you do not know if your ISP assigned you a fixed IP address, do the following:
  a. Select either the No or the I don't know radio button.
  b. Click the Next button.
c. Enter the MAC address of the computer or router with which you previously were able to connect to the Internet.

You might find the MAC address on the product label of your device. Enter the MAC address in the AABBCDDEEFF format, not in the AA:BB:CC:DD:EE:FF format.

d. Click the Next button.

19. If the Congratulations! screen still does not display and the modem router still does not connect to the Internet, do the following:

a. Review all your settings.

Make sure that you selected the correct options and entered everything correctly.

b. Run the Setup Wizard one more time.

c. Contact your ISP to verify that you are using the correct configuration information.

d. Read Troubleshoot the Internet Connection on page 191.

e. If problems persist, register your NETGEAR product and contact NETGEAR technical support.
Set Up Your Modem Router for Cable or Fiber Service

You can install your modem router for cable or fiber (Ethernet WAN) service or for DSL service. If you use a cable or fiber modem, follow the procedure that is described in this section. If you use a DSL modem, follow the procedure that is described in Cable the Modem Router for DSL Service and Access the Modem Router on page 19.

The following figure shows the cabling of your modem router for cable or fiber service.

![Modem router cabling for cable or fiber service](image)

**To connect your modem router to a cable or fiber service:**

1. Unplug your cable or fiber modem’s power, leaving the modem connected to the wall jack for your Internet service.
2. If your cable or fiber modem includes a battery backup, remove the battery.
3. Use an Ethernet cable to connect the cable or fiber modem to the yellow LAN4 WAN Ethernet port on the modem router.
   The product package contains a yellow Ethernet cable.

**WARNING:**

Do not use another yellow Ethernet port for the connection to the cable or fiber modem. Use the LAN4 WAN port only.

4. If your DSL modem includes a battery backup, reinsert the battery.
5. Plug in your DSL modem’s power and turn on your DSL modem.
6. Connect the power adapter to the modem router and plug it into an electrical outlet. Wait for the Power LED to light solid green, which takes about 80 seconds. (The Power LED lights solid green for about 20 seconds and then blinks for about one minute before it lights solid green again.)

7. Connect a computer to the modem router by one of the following methods:
   - **Ethernet cable.** Use an Ethernet cable to connect your computer to the yellow LAN1, LAN2, or LAN3 Ethernet port on the modem router.
     The product package contains a yellow Ethernet cable.
     Your computer connects to the modem router’s LAN.
   - **WiFi.** Connect to the default WiFi network of the modem router:
     a. On your computer or WiFi device, find and select the WiFi network.
        The WiFi network name (SSID) is on the product label.
     b. Join the WiFi network and enter the WiFi password.
        The password (network key) is on the product label.
        Your computer or WiFi device connects to the modem router’s WiFi network.

8. Launch a web browser.
   The NETGEAR genie Setup Wizard displays.

   ![Configuring the Internet Connection](image)

   If the NETGEAR genie Setup Wizard displays, skip to Step 10. If it does not display, do the following:
   a. In the address field of the web browser, enter www.routerlogin.net.
   b. When prompted, enter admin for the user name and password for the password.

   If the Setup Wizard displays, skip to Step 10. If the NETGEAR genie Setup Wizard still does not display, see Step 9.
9. If the browser cannot display the web page, do the following:
   • Make sure that the computer is connected to the yellow LAN1, LAN2, or LAN3 Ethernet port or over WiFi to the modem router.
   • Make sure that the Power LED of the modem router is lit green.
   • Make sure that your browser does not cache the previous page by closing and reopening the browser.
   • Clear the browser cache.
   • If the computer is set to a static or fixed IP address (this setting is uncommon), either change the computer to obtain an IP address automatically from the modem router through DHCP, or change the IP address of the computer to a static or fixed IP address in the 192.168.1.2–192.168.1.254 range.

10. On the NETGEAR genie Setup Wizard screen, select the No, I want to configure the Internet connection myself radio button.

11. Click the Next button.

12. Confirm your selection.

   The NETGEAR genie BASIC home screen of the web management interface displays.

   ![NETGEAR genie BASIC home screen](image)

   Because you are not yet connected to the Internet, the Internet pane displays Error Not Connected.
13. Change the default WAN connection method:
   a. Select xDSL.

   

   ![Image of xDSL settings](image)

   b. From the Physical WAN Type menu, select Ethernet WAN.

   

   ![Image of Ethernet WAN settings](image)

   c. Click the Apply button.

14. If the computer is disconnected from the modem router, reconnect the computer to the modem router (see Step 7), relaunch the web browser, and access the web management interface again:
   a. In the address field of the web browser, enter www.routerlogin.net.
   b. When prompted, enter admin for the user name and password for the password.

   The NETGEAR genie BASIC home screen of the web management interface displays again.
15. Select **ADVANCED > Setup Wizard**.

16. Select the **Yes** radio button.

17. Click the **Next** button.

   The Setup Wizard starts and searches your Internet connection for servers and protocols to determine your ISP configuration.

   If the Internet connection is set up successfully, the Congratulation screen displays. If this screen does not display, see **Step 18**.

18. (Only if the following screen displays) Specify how to manage problems with the detection of the Internet connection.

   The screen that might display states that a problem occurred while detecting the Internet connection. If this screen does not display, continue with the next step.
Install and Access the Modem Router and Its Network

Note: The option for power-cycling the modem router that is stated onscreen applies to a DSL Internet connection only (see Set Up Your Modem Router for DSL Service on page 18).

Take one of the following actions:

- If the yellow Ethernet cable is fully inserted in the correct places at the cable or fiber modem and at the modem router, do the following:
  a. Select the None of the above radio button.
  b. Click the Next button.
- If the yellow Ethernet cable is not fully inserted or is inserted at a wrong place, do the following:
  a. Fully insert the Ethernet cable in the correct port on the cable or fiber modem and in the red Internet port on the modem router.
  b. Select the I corrected a problem with the Ethernet cable radio button.
  c. Click the Next button.

19. (Only if the following screen displays) Specify how to manage problems with the detection of the IP address for the Internet connection.

The screen that might display states that a problem occurred while detecting the Internet connection IP address.
Take one of the following actions:

- If your ISP assigned you a fixed (static) IP address, do the following:
  a. Select the **Yes** radio button.
  b. Click the **Next** button.
  c. Enter the address information that your ISP gave you for your fixed IP address configuration.
  d. Click the **Next** button.

- If your ISP did not assign you a fixed IP address or you do not know if your ISP assigned you a fixed IP address, do the following:
  a. Select either the **No** or the **I don't know** radio button.
  b. Click the **Next** button.
c. Enter the MAC address of the computer or router with which you previously were able to connect to the Internet.

You might find the MAC address on the product label of your device. Enter the MAC address in the AABBCDDEEFF format, not in the AA:BB:CC:DD:EE:FF format.

d. Click the Next button.

20. If the Congratulations! screen still does not display and the modem router still does not connect to the Internet, do the following:
   a. Review all your settings.
   Make sure that you selected the correct options and entered everything correctly.
   b. Run the Setup Wizard one more time.
   c. Contact your ISP to verify that you are using the correct configuration information.
   d. Read Troubleshoot the Internet Connection on page 191.
   e. If problems persist, register your NETGEAR product and contact NETGEAR technical support.

Log In to the Modem Router After Setup to View or Change Settings

After you set up the modem router for DSL, cable, or fiber service, you can view or change the settings for the modem router by accessing NETGEAR genie.

➢ To log in to the modem router:
   1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
      The nature of the login screen that displays depends on your Internet browser.
3. Enter the modem router user name and password.

The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.

The BASIC Home screen displays a dashboard that lets you see the status of your Internet connection and network at a glance. You can click any of the three sections of the dashboard to view more detailed information. The left column displays the menus, and at the top is an ADVANCED tab that you can use to access more menus and screens.

**Change the Language**

By default, the language is set as Auto, which means that the modem router detects the language automatically based on your browser settings. You can change the language.

➢ **To change the language:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
A login screen displays.

3. Enter the modem router user name and password.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home screen displays.

5. In the upper right corner, select a language from the menu.
6. When prompted, click the **OK** button to confirm this change.
   The screen refreshes with the language that you selected.

**Change the admin Password**

NETGEAR recommends that you change the default password that you use to log in to the modem router to a more secure password. This is the password that you use to log in to the modem router with the user name **admin**.

The ideal password contains no dictionary words from any language and contains uppercase and lowercase letters, numbers, and symbols. It can be up to 30 characters.

**Note:** This admin password is **not** the password that you use for WiFi access. The label on your modem router shows your unique WiFi network name (SSID) and password for WiFi access.

➢ To change the password for the user name **admin**:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

2. Type **http://www.routerlogin.net**.
   A login screen displays.

3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home screen displays.

5. Select **ADVANCED > Administration > Set Password**.
6. Type the old password.
7. Type the new password twice.
8. Click the **Apply** button.
   
   Your settings are saved.

Let the Modem Router Automatically Update Its Firmware

When you set up your modem router and are connected to the Internet, the modem router automatically checks for you to see if newer firmware is available. If it is, a message is displayed at the top of the screen. For information about manually upgrading firmware, see *Manually Upload New Firmware and Update the Modem Router* on page 152.

➢ **To automatically update the firmware:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   
   A login screen displays.
3. Enter the modem router user name and password.
   
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   
   The BASIC Home screen displays.
5. Wait for the modem router to check if newer firmware is available.
This process might take a few minutes. If the modem router detects new firmware, the modem router displays a message at the top of the screen.

6. Click the message.
7. To upgrade the modem router with the latest firmware, click the Yes button.

After the upgrade, the modem router restarts.

**WARNING:**

To avoid the risk of corrupting the firmware, do not interrupt the upload. For example, do not close the browser, click a link, or load a new page. Do not turn off the modem router. Wait until the modem router finishes restarting and the Power LED turns solid green.

**Access the Modem Router with the NETGEAR genie App**

The genie app is the easy dashboard for managing, monitoring, and repairing your home network from a smartphone, tablet, or computer. The genie app can help you with the following:

- Automatically repair common WiFi network problems.
- Easily manage modem router features such as Live Parental Controls, guest access, speed test, and more.
- Share and stream music or videos.

➢ **To use the genie app to access the modem router:**

2. Follow the onscreen instructions to install the app on your smartphone, tablet, or computer.
3. Launch the genie app.

The genie app dashboard screen displays. The following figure shows the genie app dashboard for a PC.
Manage the Internet Settings Manually

This chapter describes how you can manage the Internet settings of the modem router manually. Usually, the quickest way to set up the modem router is to allow the NETGEAR genie Setup Wizard to detect the Internet connection when you first access the modem router with an Internet browser. For a cable or fiber service, you can use the Setup Wizard to detect the Internet connection. These options are described in Chapter 2, Install and Access the Modem Router and Its Network. You can also customize or specify your Internet settings manually.

The chapter contains the following sections:

- Use the Setup Wizard After Initial Setup
- Manually Set Up the Internet Connection
- Manage the MTU Size
Use the Setup Wizard After Initial Setup

Whether you use DSL, cable, or fiber service, you can use the Setup Wizard to detect your Internet settings and automatically set up your modem router. If you use cable or fiber service, the default connection method must be Ethernet WAN for you to be able to use the Setup Wizard successfully. For more information about the default connection method, see Change the Type of Physical WAN Connection on page 133.

➢ To use the Setup Wizard:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the modem router user name and password.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > Setup Wizard.
   The screen that displays depends on whether the type of Internet connection is DSL, cable, or fiber:
   • DSL connection.

For a DSL connection, configure the following settings, which do not display for a cable or fiber connection:

a. From the Country menu, select the country in which the modem router operates.

b. From the ISP menu, select the DSL service provider.

• Go to Step 6.
• **Cable of fiber connection.**

6. Select the **Yes** radio button.
   
   If you select the **No** radio button, you are taken to the Internet Setup screen (see *Manually Set Up the Internet Connection* on page 44).

7. Click the **Next** button.
   
   The Setup Wizard searches your Internet connection for servers and protocols to determine your ISP configuration.

When the modem router is connected to the Internet, the Congratulations! screen displays, and you successfully completed the setup process.

If the Congratulations! screen does not display, other screens might display and you might need to provide more information, in which case you must continue with the next step. The screens that display depend on your type of ISP connection and configuration.
8. (Only if the following screen displays) Specify a full scan to let the Setup Wizard find the PVC protocol.

The screen that might display asks you if you need the Setup Wizard to do a full scan to find the PVC protocol. If this screen does not display, continue with the next step.

Do the following:

a. Select the Yes radio button.

b. Click the Next button.

The Setup Wizard performs a full scan, which might take up to six minutes.

9. (Only if the following screen displays) Specify how to manage problems with the detection of the Internet connection.

The screen that might display states that a problem occurred while detecting the Internet connection. If this screen does not display, continue with the next step.
Take one of the following actions:

- If your setup includes a DSL modem, power-cycle the DSL modem:
  a. Unplug your DSL modem’s power, leaving the DSL modem connected to the wall jack for your Internet service.
  b. If your DSL modem includes a battery backup, remove the battery.
  c. Wait 10 seconds.
  d. If your DSL modem includes a battery backup, reinsert the battery.
  e. Plug in your DSL modem’s power and turn on your DSL modem.
  f. Wait two minutes.
  g. Select the I just power cycled the modem and waited for 2 minutes radio button.
  h. Click the Next button.

- If your setup includes a cable or fiber modem, see if the yellow Ethernet cable is not fully inserted or is inserted at the wrong place. If necessary, do the following:
  a. Fully insert the Ethernet cable in the correct port on the cable or fiber modem and in the red Internet port on the modem router.
  b. Select the I corrected a problem with the Ethernet cable radio button.
  c. Click the Next button.

- If you do not need to power-cycle the DSL modem or the Ethernet cable is already fully inserted in the correct ports, do the following:
  a. Select the None of the above radio button.
  b. Click the Next button.

10. (Only if the following screen displays) Specify how to manage problems with the detection of the IP address for the Internet connection.

The screen that might display states that a problem occurred while detecting the Internet connection IP address.
Take one of the following actions:

• If your ISP assigned you a fixed (static) IP address, do the following:
  a. Select the Yes radio button.
  b. Click the Next button.
  c. Enter the address information that your ISP gave you for your fixed IP address configuration.
  d. Click the Next button.

• If your ISP did not assign you a fixed IP address or you do not know if your ISP assigned you a fixed IP address, do the following:
  a. Select either the No or the I don’t know radio button.
  b. Click the Next button.
  c. Enter the MAC address of the computer or router with which you previously were able to connect to the Internet.
     You might find the MAC address on the product label of your device. Enter the MAC address in the AABBCDDEEFF format, not in the AA:BB:CC:DD:EE:FF format.
  d. Click the Next button.
11. If the Congratulations! screen still does not display and the modem router still does not connect to the Internet, do the following:
   a. Review all your settings.
      Make sure that you selected the correct options and entered everything correctly.
   b. Run the Setup Wizard one more time.
   c. Contact your ISP to verify that you are using the correct configuration information.
   d. Read Troubleshoot the Internet Connection on page 191.
   e. If problems persist, register your NETGEAR product and contact NETGEAR technical support.

Manually Set Up the Internet Connection

You can view or change the modem router’s Internet connection settings manually. The following sections describe the options to manually set up the Internet connection:

- Specify an Internet Connection Without a Login on page 44
- Specify an Internet Connection That Uses a Login and PPPoE Service on page 47
- Specify an Internet Connection That Uses a Login and PPPoA Service on page 50

Specify an Internet Connection Without a Login

If you want to manually configure the Internet connection settings, use the information that your ISP gave you to log in to your Internet service. If you cannot find this information, contact your ISP.

➢ To view or specify the Internet connection settings without a login:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the modem router user name and password.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select Internet.
   The Internet Setup screen displays.
6. In the Does your Internet connection require a login? section, select the No radio button.
7. Enter the settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Name (If Required)</td>
<td>Enter the account name provided by your ISP. This name might also be called the host name. If you do not know the account name, leave this field blank. By default, the Account Name field contains the model number of the modem router.</td>
</tr>
<tr>
<td>Domain Name (If Required)</td>
<td>Enter the domain name provided by your ISP. If you do not know the domain name, leave this field blank.</td>
</tr>
<tr>
<td>Internet IP Address</td>
<td>Get Dynamically from ISP Your ISP uses DHCP to assign your IP address. Your ISP automatically assigns these addresses.</td>
</tr>
<tr>
<td></td>
<td>Get Static IP Address</td>
</tr>
<tr>
<td></td>
<td>Use Static IP Address</td>
</tr>
<tr>
<td></td>
<td>Primary DNS</td>
</tr>
<tr>
<td></td>
<td>Secondary DNS</td>
</tr>
<tr>
<td></td>
<td>Use DNS from ISP MAC Address</td>
</tr>
<tr>
<td></td>
<td>NAT (Network Address Translation)</td>
</tr>
</tbody>
</table>
8. Click the **Apply** button.
   
   Your settings are saved.

9. Click the **Test** button to test your Internet connection.

   If the NETGEAR website does not display within one minute, see *Troubleshoot the Internet Connection* on page 191.
Specify an Internet Connection That Uses a Login and PPPoE Service

If you want to manually configure the Internet connection settings, use the information that your ISP gave you to log in to your Internet service. If you cannot find this information, contact your ISP.

To view or specify the Internet connection settings with a login for PPPoE service:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.
   A login screen displays.
3. Enter the modem router user name and password.
   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select Internet.
   The Internet Setup screen displays.
6. In the Does your Internet connection require a login? section, make sure that the Yes radio button is selected.
   The Yes radio button is selected by default.
7. From the Encapsulation menu, select PPPoE (PPP over Ethernet).
8. Enter the settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>Enter the login name that your ISP gave you. This login name is often an email address.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password that you use to log in to your Internet service.</td>
</tr>
<tr>
<td>Service Name (If Required)</td>
<td>Enter the service name that your ISP gave you. Often, a service name is not required.</td>
</tr>
<tr>
<td>Connection Mode</td>
<td>From the Connection Mode menu, select Always On, Dial on Demand, or Manually Connect.</td>
</tr>
</tbody>
</table>
9. Click the **Apply** button.

Your settings are saved.

10. Click the **Test** button to test your Internet connection.

    If the NETGEAR website does not display within one minute, see *Troubleshoot the Internet Connection* on page 191.
Specify an Internet Connection That Uses a Login and PPPoA Service

If you want to manually configure the Internet connection settings, use the information that your ISP gave you to log in to your Internet service. If you cannot find this information, contact your ISP.

---

**Note:** PPP over ATM (PPPoA) is available only if you connect the modem router to the Internet over a DSL service. PPPoA is not available for cable or fiber service.

---

➢ **To view or specify the Internet connection settings with a login for PPPoA service:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.
   A login screen displays.
3. Enter the modem router user name and password.
   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home screen displays.
5. Select **Internet**.
   The Internet Setup screen displays.
6. In the **Does your Internet connection require a login?** section, make sure that the **Yes** radio button is selected.
   The **Yes** radio button is selected by default.
7. From the Encapsulation menu, select PPPoA (PPP over ATM).
8. Enter the settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>Enter the login name that your ISP gave you. This login name is often an email address.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password that you use to log in to your Internet service.</td>
</tr>
<tr>
<td>Service Name (If Required)</td>
<td>Enter the service name that your ISP gave you. Often, a service name is not required.</td>
</tr>
<tr>
<td>Connection Mode</td>
<td>From the Connection Mode menu, select Always On, Dial on Demand, or Manually Connect.</td>
</tr>
<tr>
<td>Idle Timeout (In Minutes)</td>
<td>To change the number of minutes until the Internet login times out, enter the number of minutes. The idle time-out specifies how long the modem router keeps the Internet connection active when no one on the network is using the Internet connection. A value of 0 (zero) means never log out.</td>
</tr>
</tbody>
</table>
9. Click the **Apply** button.
Your settings are saved.

10. Click the **Test** button to test your Internet connection.
    If the NETGEAR website does not display within one minute, see *Troubleshoot the Internet Connection* on page 191.

### Manage the MTU Size

The maximum transmission unit (MTU) is the largest data packet a network device transmits.

#### MTU Concepts

When one network device communicates across the Internet with another, the data packets travel through many devices along the way. If a device in the data path uses a lower MTU setting than the other devices, the data packets must be split or “fragmented” to accommodate the device with the smallest MTU.

The best MTU setting for NETGEAR equipment is often the default value. In some situations, changing the value fixes one problem but causes another.
Leave the MTU unchanged unless one of these situations occurs:

- You experience problems connecting to your ISP or other Internet service, and the technical support of either the ISP or NETGEAR recommends changing the MTU setting. These web-based applications might require an MTU change:
  - A secure website that does not open or displays only part of a web page
  - Yahoo email
  - MSN portal
  - America Online’s DSL service
- You use VPN and experience severe performance problems.
- You used a program to optimize MTU for performance reasons and now you are experiencing connectivity or performance problems.

If you suspect an MTU problem, a common solution is to change the MTU to 1400. If you are willing to experiment, you can gradually reduce the MTU from the maximum value of 1500 until the problem goes away. The following table describes common MTU sizes and applications.

### Table 2. Common MTU sizes

<table>
<thead>
<tr>
<th>MTU</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>1500</td>
<td>The largest Ethernet packet size. This setting is typical for connections that do not use PPPoE or VPN and is the default value for NETGEAR modem routers, adapters, and switches.</td>
</tr>
<tr>
<td>1492</td>
<td>Used in PPPoE environments.</td>
</tr>
<tr>
<td>1472</td>
<td>Maximum size to use for pinging. (Larger packets are fragmented.)</td>
</tr>
<tr>
<td>1468</td>
<td>Used in some DHCP environments.</td>
</tr>
<tr>
<td>1460</td>
<td>Usable by AOL if you do not send or receive large email attachments, for example.</td>
</tr>
<tr>
<td>1436</td>
<td>Used in PPTP environments or with VPN.</td>
</tr>
<tr>
<td>1400</td>
<td>Maximum size for AOL DSL.</td>
</tr>
<tr>
<td>576</td>
<td>Typical value to connect to dial-up ISPs.</td>
</tr>
</tbody>
</table>

### Change the MTU Size

**WARNING:**

An incorrect MTU setting can cause Internet communication problems. For example, you might not be able to access certain websites, frames within websites, secure login pages, or FTP or POP servers. Change the MTU only if you are sure that it is necessary for your ISP connection.
To change the MTU size:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the modem router user name and password.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > Setup > WAN Setup.
6. In the MTU Size field, enter a value from 616 to 1500.
   The default MTU (maximum transmit unit) value is 1500. The normal MTU value for most Ethernet networks is 1500 bytes, or 1492 bytes for PPPoE connections.
7. Click the Apply button.
   Your settings are saved.
Manage the WiFi Network Settings

This chapter describes how you can manage the WiFi network settings of the modem router.

The chapter includes the following sections:

- Manage the Basic WiFi Settings and WiFi Security of the Main Network
- Use WPS to Add a Device to the WiFi Network
- Manage the WiFi Settings and WiFi Security of the Guest Network
- Control the WiFi Radios
- Manage the WPS Settings
- Manage Advanced WiFi Features
- Manage Wi-Fi Multimedia Quality of Service

For information about setting up a WiFi access list and managing WiFi access, see Set Up a WiFi Access List and Manage WiFi Access on page 97.
Manage the Basic WiFi Settings and WiFi Security of the Main Network

The modem router comes with preset security. This means that the WiFi network name (SSID), network key (password), and security option (encryption protocol) are preset in the factory. The preset SSID and password are uniquely generated for every device to protect and maximize your WiFi security. You can find the preset SSID and password on the product label (see Bottom Panel Product Label on page 13).

**IMPORTANT:**

NETGEAR recommends that you do not change your preset security settings. If you decide to change your preset security settings, make a note of the new settings and store the note in a safe place where you can easily find it.

View or Change the Basic WiFi Settings

You can view or change the basic WiFi settings and WiFi security. The modem router simultaneously supports the 2.4 GHz band for 802.11n, 802.11g, and 802.11b devices and the 5 GHz band for 802.11na and 802.11a devices and, for the AC750 WiFi DSL Modem Router Model D6000, also 802.11ac devices.

**Tip:** If you decide to change the WiFi settings of the modem router’s main network, use a wired connection to avoid being disconnected when the new WiFi settings take effect.

> **To view or change the basic WiFi settings:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
3. Enter the user name and password for the modem router.
   - The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   - The BASIC Home screen displays.
5. Select **Wireless**.
6. View or change the basic WiFi settings and security settings.
The following table describes the fields on the Wireless Settings screen.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region Selection</td>
<td>From the menu, select the region in which the modem router operates.</td>
</tr>
<tr>
<td><strong>Region</strong></td>
<td>Note: It might not be legal to operate the modem router in a region other than the regions listed in the menu. If your country or region is not listed, check with your local government agency.</td>
</tr>
<tr>
<td>Wireless Network (2.4GHz b/g/n)</td>
<td></td>
</tr>
<tr>
<td>Enable SSID Broadcast</td>
<td>By default, the modem router broadcasts its SSID so that WiFi stations can detect the WiFi name (SSID) in their scanned network lists. To turn off the SSID broadcast, clear the Enable SSID Broadcast check box. Turning off the SSID broadcast provides additional WiFi security, but users must know the SSID to be able to join the WiFi network of the modem router.</td>
</tr>
<tr>
<td>Enable Wireless Isolation</td>
<td>By default, WiFi clients that are connected to the 2.4 GHz band of the main WiFi network can access other WiFi devices or Ethernet devices that are connected to the main WiFi network. To prevent access between devices on the 2.4 GHz band of the main WiFi network, select the Enable Wireless Isolation check box.</td>
</tr>
<tr>
<td>Name (SSID)</td>
<td>The SSID is the WiFi network name. If you did not change the SSID, the default SSID displays. The default SSID is also printed on the product label (see Bottom Panel Product Label on page 13). Note: NETGEAR recommends that you do not change the default SSID. If you must change the SSID, enter a 32-character (maximum), case-sensitive name in this field.</td>
</tr>
<tr>
<td>Channel</td>
<td>From the Channel menu, select Auto for automatic channel selection or select an individual channel. The default selection is Auto.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>In some regions, not all channels are available. Do not change the channel unless you experience interference (shown by lost connections or slow data transfers). If this situation occurs, experiment with different channels to see which one is the best.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you use multiple WiFi access points (APs), reduce interference by selecting different channels for adjacent APs. NETGEAR recommends a channel spacing of four channels between adjacent APs (for example, use Channels 1 and 5, or 6 and 10).</td>
</tr>
<tr>
<td>Mode</td>
<td>From the Mode menu, select one of the following modes:</td>
</tr>
<tr>
<td><strong>Up to 54 Mbps</strong></td>
<td>Legacy mode. This mode allows 802.11n, 802.11g, and 802.11b devices to join the network but limits 802.11n devices to function at up to 54 Mbps.</td>
</tr>
<tr>
<td><strong>Up to 145 Mbps</strong></td>
<td>Neighbor-friendly mode for reduced interference with neighboring WiFi networks. This mode allows 802.11n, 802.11g, and 802.11b devices to join the network but limits 802.11n devices to function at up to 145 Mbps. This mode is the default mode.</td>
</tr>
<tr>
<td><strong>Up to 300 Mbps</strong></td>
<td>Performance mode. This mode allows 802.11n, 802.11g, and 802.11b devices to join the network and allows 802.11n devices to function at up to 300 Mbps. Note: WPA-PSK security supports speeds of up to 54 Mbps. Even if your devices are capable of a higher speed, WPA-PSK security limits their speed to 54 Mbps.</td>
</tr>
</tbody>
</table>
Manage the WiFi Network Settings

N600 and AC750 WiFi DSL Modem Routers

Note: NETGEAR recommends that you do not change your preset security settings (WPA2-PSK [AES]). If you must change the WiFi security, select one of the following WiFi security options for the modem router’s WiFi network:

- **None.** An open WiFi network that does not provide any security. Any WiFi device can join the network. NETGEAR recommends that you do not use an open WiFi network.

- **WEP.** Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption mode that is superseded by WPA-PSK and WPA2-PSK. The WEP option displays only if you select **Up to 54 Mbps** from the **Mode** menu.

  WEP limits the WiFi transmission speed to 54 Mbps (the modem router is capable of speeds of up to 300 Mbps in the 2.4 GHz band). For information about configuring WEP, see **Configure WEP Legacy WiFi Security** on page 62.

- **WPA-PSK [TKIP].** WPA security provides a secure connection but is superseded by WPA2. The WPA-PSK [TKIP] option displays only if you select **Up to 54 Mbps** from the **Mode** menu.

  To use WPA security, in the **Passphrase** field, enter a phrase of 8 to 63 characters. To join the 2.4 GHz band of the main WiFi network, a user must enter this passphrase.

- **WPA2-PSK [AES].** WPA2 security is the default setting and enables WiFi devices that support WPA2 to join the 2.4 GHz main WiFi network of the modem router. If you did not change the passphrase, the default passphrase displays. The default passphrase is printed on the product label (see **Bottom Panel Product Label** on page 13).

  WPA2 allow 802.11n devices to connect to the 2.4 GHz band of the main WiFi network at the fastest speed. WPA2 provides a secure connection but some older WiFi devices do not detect WPA2 and support only WPA. If your network includes such older devices, select WPA-PSK [TKIP] + WPA2-PSK [AES] security.

  NETGEAR recommends that you do not change the default passphrase. If you must change the passphrase, in the **Passphrase** field, enter a phrase of 8 to 63 characters. To join the 2.4 GHz band of the main WiFi network, a user must enter this passphrase.

- **WPA-PSK [TKIP] + WPA2-PSK [AES].** This type of security enables WiFi devices that support either WPA or WPA2 to join the 2.4 GHz main WiFi network of the modem router. However, WPA-PSK [TKIP] is less secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.

  To use this type of security, in the **Passphrase** field, enter a phrase of 8 to 63 characters. To join the 2.4 GHz band of the main WiFi network, a user must enter this passphrase.

### Field Description

**Security Options**

This information applies to the 2.4 GHz WiFi network.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Passphrase</strong></td>
<td>The passphrase that provides users access to the WiFi network in the 2.4 GHz band. The passphrase is also referred to as the password or key.</td>
</tr>
</tbody>
</table>

**Wireless Network (5GHz 11a/n)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SSID Broadcast</td>
<td>By default, the modem router broadcasts its SSID so that WiFi stations can detect the WiFi name (SSID) in their scanned network lists. To turn off the SSID broadcast, clear the <strong>Enable SSID Broadcast</strong> check box. Turning off the SSID broadcast provides additional WiFi security, but users must know the SSID to be able to join the WiFi network of the modem router.</td>
</tr>
<tr>
<td>Enable Wireless Isolation</td>
<td>By default, WiFi clients that are connected to the 5 GHz band of the main WiFi network can access other WiFi devices or Ethernet devices that are connected to the main WiFi network. To prevent access between devices on the 5 GHz band of the main WiFi network, select the <strong>Enable Wireless Isolation</strong> check box.</td>
</tr>
</tbody>
</table>
Manage the WiFi Network Settings

N600 and AC750 WiFi DSL Modem Routers

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name (SSID) | The SSID is the WiFi network name. If you did not change the SSID, the default SSID displays. The default SSID is also printed on the product label (see Bottom Panel Product Label on page 13).

**Note:** NETGEAR recommends that you do not change the default SSID. If you must change the SSID, enter a 32-character (maximum), case-sensitive name in this field. |

| Channel     | From the Channel menu, select Auto for automatic channel selection or select an individual channel. The default selection is Auto.

**Note:** In some regions, not all channels are available. Do not change the channel unless you experience interference (shown by lost connections or slow data transfers). If this situation occurs, experiment with different channels to see which one is the best.

**Note:** If you use multiple WiFi access points (APs), reduce interference by selecting different channels for adjacent APs. NETGEAR recommends a channel spacing of four channels between adjacent APs. |

| Mode        | The options from the Mode menu for the 5 GHz band differ for the N600 WiFi DSL Modem Router Model D3600 and the AC750 WiFi DSL Modem Router Model D6000. |

**N600 WiFi DSL Modem Router Model D3600**

From the Mode menu, select one of the following modes:

- **Up to 54 Mbps.** Legacy mode. This mode allows 802.11na and 802.11a devices to join the network but limits 802.11na devices to function at up to 54 Mbps.

- **Up to 150 Mbps.** Neighbor-friendly mode for reduced interference with neighboring WiFi networks. This mode allows 802.11na and 802.11a devices to join the network but limits 802.11na devices to function at up to 150 Mbps.

- **Up to 300 Mbps.** Performance mode. This mode allows 802.11na and 802.11a devices to join the network and allows 802.11na devices to function at up to 300 Mbps. This mode is the default mode.

**Note:** WPA-PSK security supports speeds of up to 54 Mbps. Even if your devices are capable of a higher speed, WPA-PSK security limits their speed to 54 Mbps. |

**AC750 WiFi DSL Modem Router Model D6000**

From the Mode menu, select one of the following modes:

- **Up to 54 Mbps.** Legacy mode. This mode allows 802.11ac, 802.11na, and 802.11a devices to join the network but limits 802.11ac and 802.11na devices to function at up to 54 Mbps.

- **Up to 150 Mbps.** Neighbor-friendly mode for reduced interference with neighboring WiFi networks. This mode allows 802.11ac, 802.11na, and 802.11a devices to join the network but limits 802.11ac and 802.11na devices to function at up to 150 Mbps.

- **Up to 433 Mbps.** Performance mode. This mode allows 802.11ac, 802.11na, and 802.11a devices to join the network and allows 802.11ac and 802.11na devices to function at up to 433 Mbps. This mode is the default mode.

**Note:** WPA-PSK security supports speeds of up to 54 Mbps. Even if your devices are capable of a higher speed, WPA-PSK security limits their speed to 54 Mbps.
7. Click the **Apply** button.

Your settings are saved.

If you connected over WiFi to the network and you changed the SSID, you are disconnected from the network.

8. Make sure that you can reconnect over WiFi to the network with its new settings.

If you cannot connect over WiFi, check the following:

- If your computer or WiFi device is already connected to another WiFi network in your area, disconnect it from that WiFi network and connect it to the WiFi network that the modem router provides. Some WiFi devices automatically connect to the first open network without WiFi security that they discover.
- If your computer or WiFi device is trying to connect to your network with its old settings (before you changed the settings), update the WiFi network selection in your computer or WiFi device to match the current settings for your network.
- Does your WiFi device display as an attached device? (See *View Devices Currently on the Network* on page 169.) If it does, it is connected to the network.
- Are you using the correct network name (SSID) and password?

### Security Options

This information applies to the 5 GHz WiFi network.

**Note:** NETGEAR recommends that you do **not** change your preset security settings (WPA2-PSK [AES]).

If you must change the WiFi security, select one of the following WiFi security options for the modem router’s WiFi network:

- **None.** An open WiFi network that does not provide any security. Any WiFi device can join the network. NETGEAR recommends that you do **not** use an open WiFi network.
- **WPA2-PSK [AES].** WPA2 security is the default setting and enables WiFi devices that support WPA2 to join the 5 GHz main WiFi network of the modem router. If you did not change the passphrase, the default passphrase displays. The default passphrase is printed on the product label (see *Bottom Panel Product Label* on page 13).
  
  WPA2 allow 802.11ac and 802.11na devices to connect to the 5 GHz band of the main WiFi network at the fastest speed. WPA2 provides a secure connection but some older WiFi devices do not detect WPA2 and support only WPA. If your network includes such older devices, select WPA-PSK [TKIP] + WPA2-PSK [AES] security.
  
  NETGEAR recommends that you do not change the default passphrase. If you must change the passphrase, in the **Passphrase** field, enter a phrase of 8 to 63 characters. To join the 5 GHz band of the main WiFi network, a user must enter this passphrase.
- **WPA-PSK [TKIP] + WPA2-PSK [AES].** This type of security enables WiFi devices that support either WPA or WPA2 to join the 5 GHz main WiFi network of the modem router. However, WPA-PSK [TKIP] is less secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.
  
  To use this type of security, in the **Passphrase** field, enter a phrase of 8 to 63 characters. To join the 5 GHz band of the main WiFi network, a user must enter this passphrase.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Passphrase</td>
<td>The passphrase that provides users access to the WiFi network in the 5 GHz band. The passphrase is also referred to as the password or key.</td>
</tr>
</tbody>
</table>
Configure WEP Legacy WiFi Security

Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption mode that is superseded by WPA-PSK and WPA2-PSK. WEP limits the WiFi transmission speed to 54 Mbps (the modem router is capable of speeds of up 300 Mbps in the 2.4 GHz band). WEP is available only for the 2.4 GHz band.

Tip: If you want to change the WiFi settings of the modem router's main network, use a wired connection to avoid being disconnected when the new WiFi settings take effect.

To configure WEP security:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select Wireless.
   The Wireless Settings screen displays.
6. From the Mode menu, select Up to 54 Mbps.
   The screen adjusts to display the WEP radio button.
7. In the Security Options section, select the WEP radio button.
8. From the **Authentication Type** menu, select one of the following types:
   - **Automatic.** Clients can use either Open System or Shared Key authentication.
   - **Shared Key.** Clients can use only Shared Key authentication.

9. From the **Encryption Strength** menu, select the encryption key size:
   - **64-bit.** Standard WEP encryption, using 40/64-bit encryption.
   - **128-bit.** Standard WEP encryption, using 104/128-bit encryption. This selection provides higher encryption security.

10. Specify the active key by selecting the **Key 1**, **Key 2**, **Key 3**, or **Key 4** radio button. Only one key can be the active key.

11. Enter the value for the key:
    - For 64-bit WEP, enter 10 hexadecimal digits (any combination of 0–9, A–F). The key values are not case-sensitive.
    - For 128-bit WEP, enter 26 hexadecimal digits (any combination of 0–9, A–F). The key values are not case-sensitive.

   To join the modem router’s WiFi network, a user must enter the key value for the key that you specified as the active key.

12. Click the **Apply** button.

   Your settings are saved.

13. Make sure that you can reconnect over WiFi to the network with its new security settings.
If you cannot connect over WiFi, check the following:

- If your computer or WiFi device is already connected to another WiFi network in your area, disconnect it from that WiFi network and connect it to the WiFi network that the modem router provides. Some WiFi devices automatically connect to the first open network without WiFi security that they discover.
- If your computer or WiFi device is trying to connect to your network with its old settings (before you changed the settings), update the WiFi network selection in your computer or WiFi device to match the current settings for your network.
- Does your WiFi device display as an attached device? (See View Devices Currently on the Network on page 169.) If it does, it is connected to the network.
- Are you using the correct network name (SSID) and password?

### Use WPS to Add a Device to the WiFi Network

WPS (Wi-Fi Protected Setup) lets you connect a computer or WiFi device to the modem router’s network without entering the WiFi network passphrase or key. Instead, you use a WPS button or enter a PIN to connect.

If you use the push button method, the WiFi device that you are trying to connect must provide either a physical button or a software button. If you use the PIN method, you must know the PIN of the WiFi device that you are trying to connect.

WPS supports WPA and WPA2 WiFi security. If your modem router network is open (no WiFi security is set, which is not the default setting for the modem router), connecting with WPS automatically sets WPA + WPA2 WiFi security on the modem router network and generates a random passphrase. You can view this passphrase (see Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 56).

### Use WPS with the Push Button Method

For you to use the push button method to connect a WiFi device to the modem router’s WiFi network, the WiFi device that you are trying to connect must provide either a physical button or a software button. You can use the physical button and software button to let a WiFi device join only the main WiFi network, not the guest WiFi network.

➢ To let a WiFi device join the modem router’s main WiFi network using WPS with the push button method:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`. A login screen displays.
3. Enter the user name and password for the modem router.
   - The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home screen displays.

5. Select **ADVANCED > WPS Wizard**.
   The screen displays a description of the WPS method.

6. Click the **Next** button.

![Advanced Settings Screen]

By default, the **Push Button (recommended)** radio button is selected.

7. Either click the **button onscreen** or press the **WPS** button on the back panel of the modem router for 1–5 seconds.
   
   **Note:** The button is labeled **Reset WPS**.

![Warning]

**WARNING:**
If you press the WPS button on the back panel but do not release it quickly, the modem router resets to factory default settings.

For two minutes, the modem router attempts to find the WiFi device (that is, the client) that you want to join the modem router’s main WiFi network.

During this time, the WPS LED on the top panel of the modem router blinks green.

8. Within two minutes, go to the WiFi device and press its **WPS** button to join the modem router’s main WiFi network without entering a password.
   After the modem router establishes a WPS connection, the WPS LED lights solid green again and the Add WPS Client screen displays a confirmation message.

9. To verify that the WiFi device is connected to the modem router’s main WiFi network, select **BASIC > Attached Device**.
   The WiFi device displays onscreen.
Use WPS with the PIN Method

To use the PIN method to connect a WiFi device to the modem router’s WiFi network, you must know the PIN of the WiFi device that you are trying to connect.

To let a WiFi device join the modem router’s WiFi network using WPS with the PIN method:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > WPS Wizard.
   The screen displays a description of the WPS method.
6. Click the Next button.
   The Add WPS Client screen adjusts.
   The Push Button (recommended) radio button is selected by default.
7. Select the PIN Number radio button.
8. In the Enter Client’s PIN field, enter the PIN number of the WiFi device.
9. Click the Next button.
   For four minutes, the modem router attempts to find the WiFi device (that is, the client) that you want to join the modem router’s main WiFi network.
   During this time, the WPS LED on the top panel of the modem router blinks green.
10. Within four minutes, go to the WiFi device and use its WPS software to join the network without entering a password.

When the modem router establishes a WPS connection, the WPS LED lights solid green again and the Add WPS Client screen displays a confirmation message.

11. To verify that the WiFi device is connected to the modem router’s main WiFi network, select BASIC > Attached Device.

The WiFi device displays onscreen.

Manage the WiFi Settings and WiFi Security of the Guest Network

A guest network allows visitors to use the Internet without using your WiFi security key. By default, the guest WiFi network is disabled. You can enable and configure the guest WiFi network for each WiFi band. The modem router simultaneously supports the 2.4 GHz band for 802.11n, 802.11g, and 802.11b devices and the 5 GHz band for 802.11na and 802.11a devices and, for the AC750 WiFi DSL Modem Router Model D6000, also 802.11ac devices.

The WiFi mode of the guest WiFi network depends on the WiFi mode of the main WiFi network. For example, if you configure the WiFi mode for the main WiFi network as Up to 54 Mbps in the 2.4 GHz band, the guest WiFi network also functions in the Up to 54 Mbps mode in the 2.4 GHz band. For information about configuring the WiFi mode, see Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 56.

Set Up and Enable a Guest Network

The modem router provides the following default guest networks:

- 2.4 GHz band:
  - NETGEAR-Guest
  - NETGEAR-Guest2
  - NETGEAR-Guest3

- 5 GHz band:
  - NETGEAR-5G-Guest
  - NETGEAR-5G-Guest2
  - NETGEAR-5G-Guest3

By default, all of these networks are configured as open networks without security but are disabled. You can enable one, several, or all networks. You can also change the names (SSIDs) for these networks.
To set up and enable a guest network:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the modem router user name and password.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
   The BASIC Home screen displays.
4. Select Guest Network.

These options display only if the 2.4 GHz band of the main WiFi network is set to Up to 54 Mbps.
5. In one of the Network Profiles tables, select the radio button for the guest network (either in the 2.4 GHz band or in the 5 GHz band) that you want to enable and set up.
6. Enable the guest network and configure its WiFi settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Wireless Settings - Profile (2.4GHz b/g/n)</strong></td>
<td></td>
</tr>
<tr>
<td>Enable Guest Network</td>
<td>By default, the guest WiFi network is disabled. To enable the guest WiFi network for the 2.4 GHz band, select the <strong>Enable Guest Network</strong> check box.</td>
</tr>
<tr>
<td>Enable SSID Broadcast</td>
<td>By default, the modem router broadcasts its SSID of the 2.4 GHz band so that WiFi stations can detect the WiFi name (SSID) in their scanned network lists. To turn off the SSID broadcast for the 2.4 GHz band of the guest WiFi network, clear the <strong>Enable SSID Broadcast</strong> check box.</td>
</tr>
<tr>
<td>Allow guest to access My Local Network</td>
<td>By default, WiFi clients that are connected to the 2.4 GHz band of the guest WiFi network cannot access WiFi devices or Ethernet devices that are connected to the main WiFi network. To allow access to the main WiFi network, select the <strong>Allow guest to access My Local Network</strong> check box.</td>
</tr>
<tr>
<td>Enable Wireless Isolation</td>
<td>By default, WiFi clients that are connected to the 2.4 GHz band of the guest WiFi network can access other WiFi devices on the guest WiFi network. To prevent WiFi clients that are connected to the 2.4 GHz band of the guest WiFi network from accessing other WiFi devices on the guest WiFi network, select the <strong>Enable Wireless Isolation</strong> check box.</td>
</tr>
<tr>
<td>Guest Wireless Network Name (SSID)</td>
<td>The SSID is the 2.4 GHz WiFi band name. The default SSID displays, which is NETGEAR_Guest1, NETGEAR_Guest2, or NETGEAR_Guest3. If you want to change the SSID in the 2.4 GHz band for the guest WiFi network, enter a 32-character (maximum), case-sensitive name in this field.</td>
</tr>
</tbody>
</table>

**Security Options**

If you want to change the WiFi security, select one of the following WiFi security options for the 2.4 GHz band of the guest WiFi network:

- **None.** An open WiFi network that does not provide any security. Any WiFi device can join the 2.4 GHz band of the guest WiFi network. This is the default setting for the guest WiFi network.
- **WEP.** Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption mode that is superseded by WPA-PSK and WPA2-PSK. The WEP option displays only if you configure the WiFi mode for the main WiFi network as Up to 54 Mbps in the 2.4 GHz band (see Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 56.). For information about configuring WEP, see Configure WEP Legacy WiFi Security on page 62.
- **WPA-PSK [TKIP].** WPA provides a secure connection but is superseded by WPA2. The WPA-PSK [TKIP] option displays only if you configure the WiFi mode for the main WiFi network as Up to 54 Mbps in the 2.4 GHz band (see Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 56.). To use WPA security, in the **Passphrase** field, enter a phrase of 8 to 63 characters. To join the 2.4 GHz band of the guest WiFi network, a user must enter this passphrase.
Manage the WiFi Network Settings

N600 and AC750 WiFi DSL Modem Routers

- **WPA2-PSK [AES]**. WPA2 provides a secure and fast connection but some older WiFi devices do not detect WPA2 and support only WPA. Select WPA2 to allow 802.11n devices to connect to the 2.4 GHz band of the guest WiFi network at the fastest speed. If your network includes older devices that do not support WPA2, select WPA-PSK [TKIP] + WPA2-PSK [AES] security.
  To use WPA2 security, in the **Passphrase** field, enter a phrase of 8 to 63 characters. To join the 2.4 GHz band of the guest WiFi network, a user must enter this passphrase.

- **WPA-PSK [TKIP] + WPA2-PSK [AES]**. This type of security enables WiFi devices that support either WPA or WPA2 to join the 2.4 GHz band of the guest WiFi network. However, WPA-PSK [TKIP] is less secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.
  To use WPA + WPA2 security, in the **Passphrase** field, enter a phrase of 8 to 63 characters. To join the 2.4 GHz band of the guest WiFi network, a user must enter this passphrase.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Passphrase</strong></td>
<td>The passphrase that provides users access to the guest WiFi network in the 2.4 GHz band. The passphrase is also referred to as the password or key.</td>
</tr>
</tbody>
</table>

### Wireless Settings - Profile (5GHz a/n)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable Guest Network</strong></td>
<td>By default, the guest WiFi network is disabled. To enable the guest WiFi network for the 5 GHz band, select the <strong>Enable Guest Network</strong> check box.</td>
</tr>
<tr>
<td><strong>Enable SSID Broadcast</strong></td>
<td>By default, the modem router broadcasts its SSID of the 5 GHz band so that WiFi stations can detect the WiFi name (SSID) in their scanned network lists. To turn off the SSID broadcast for the 5 GHz band of the guest WiFi network, clear the <strong>Enable SSID Broadcast</strong> check box.</td>
</tr>
<tr>
<td><strong>Allow guest to access My Local Network</strong></td>
<td>By default, WiFi clients that are connected to the 5 GHz band of the guest WiFi network cannot access WiFi devices or Ethernet devices that are connected to the main WiFi network. To allow access to the main WiFi network, select the <strong>Allow guest to access My Local Network</strong> check box.</td>
</tr>
<tr>
<td><strong>Enable Wireless Isolation</strong></td>
<td>By default, WiFi clients that are connected to the 5 GHz band of the guest WiFi network can access other WiFi devices on the guest WiFi network. To prevent WiFi clients that are connected to the 5 GHz band of the guest WiFi network from accessing other WiFi devices on the guest WiFi network, select the <strong>Enable Wireless Isolation</strong> check box.</td>
</tr>
<tr>
<td><strong>Guest Wireless Network Name (SSID)</strong></td>
<td>The SSID is the 5 GHz WiFi band name. If you did not change the SSID, the default SSID displays, which is NETGEAR-5G_Guest1, NETGEAR-5G_Guest2, or NETGEAR-5G_Guest3. If you want to change the SSID in the 5 GHz band for the guest WiFi network, enter a 32-character (maximum), case-sensitive name in this field.</td>
</tr>
</tbody>
</table>
Manage the WiFi Network Settings

N600 and AC750 WiFi DSL Modem Routers

7. Click the **Apply** button.
   Your settings are saved.

8. Make sure that you can reconnect over WiFi to the guest network.
   If you cannot connect over WiFi, check the following:
   
   • If your computer or WiFi device is already connected to another WiFi network in your area, disconnect it from that WiFi network and connect it to the WiFi network that the modem router provides. Some WiFi devices automatically connect to the first open network without WiFi security that they discover.
   
   • Does your WiFi device display as an attached device? (See *View Devices Currently on the Network* on page 169.) If it does, it is connected to the network.
   
   • Are you using the correct network name (SSID) and password?

### Configure WEP Legacy WiFi Security for the Guest WiFi Network

Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption mode that is superseded by WPA-PSK and WPA2-PSK. WEP supports speeds of up to 54 Mbps (the modem router is capable of speeds of up to 300 Mbps in the 2.4 GHz band).
IMPORTANT:
The WiFi mode of the guest WiFi network depends on the WiFi mode of the main WiFi network. For you to be able to configure WEP in the guest WiFi network, first configure the mode for the main WiFi network as Up to 54 Mbps. For information about configuring the WiFi mode, see View or Change the Basic WiFi Settings on page 56.

➢ To configure WEP security for the guest WiFi network:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

2. In the address field of your browser, enter http://routerlogin.net.
   The login screen displays.

3. Type admin for the user name and type your password.
   If you did not yet personalize your password, type password for the password.

4. Click the OK button.
   The BASIC Home screen displays.

5. Select BASIC > Guest Network.
   The Guest Network Settings screen displays.

6. In the Security Options section, select the WEP radio button.

7. From the Authentication Type menu in the Security Encryption (WEP) section, select one of the following types:
   • Shared Key. Clients can use only Shared Key authentication.
   • Automatic. Clients can use either Open System or Shared Key authentication.
8. From the **Encryption Strength** menu in the Security Encryption (WEP) section, select the encryption key size:
   - **64-bit**: Standard WEP encryption, using 40/64-bit encryption.
   - **128-bit**: Standard WEP encryption, using 104/128-bit encryption. This selection provides stronger encryption security.

9. In the Security Encryption (WEP) Key section, generate the key automatically:
   a. In the **Passphrase** field, enter a passphrase:
   b. Click the **Generate** button.
      
      For 64-bit WEP, four different WEP keys are generated and the four key fields are populated with different WEP keys. For 128-bit WEP, only one WEP key is generated and the four key fields are populated with the same WEP key.
   c. Specify the active key by selecting the **Key 1**, **Key 2**, **Key 3**, or **Key 4** radio button.
      
      Only one key can be the active key.
      
      To join the guest WiFi network, a user must enter the key value for the key that you specified as the active key.

10. Click the **Apply** button.
    
    Your settings are saved.

### Control the WiFi Radios

The modem router provides internal WiFi radios that broadcast signals in the 2.4 GHz and 5 GHz ranges. By default, they are on so that you can connect over WiFi to the modem router. When the WiFi radios are off, you can still use an Ethernet cable for a LAN connection to the modem router.

You can turn the WiFi radios on and off with the **WiFi On/Off** button on the modem router, or you can log in to the modem router and enable or disable the WiFi radios through the web management interface. If you are close to the modem router, it might be easier to press the **WiFi On/Off** button. If you are away from the modem router or already logged in, it might be easier to enable or disable the radios through the web management interface.

### Use the WiFi On/Off Button

- **To turn the WiFi radios off and on with the WiFi On/Off button:**
  
  Press the **WiFi On/Off** button on the back panel of the modem router for two seconds.
  
  If you turned off the WiFi radios, the WiFi LED turns off. If you turned on the WiFi radios, the WiFi LED lights solid green.

  **Tip:** If you want to disable the WiFi radio or radios of the modem router, use a wired connection to avoid being disconnected when WiFi radio or radios turn off.
Enable or Disable the WiFi Radios

If you used the **WiFi On/Off** button to turn off the WiFi radios, you cannot log in to the modem router to turn them back on. You must press the **WiFi On/Off** button again for two seconds to turn the WiFi radios back on.

➢ **To enable or disable the WiFi radios:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.
   
   A login screen displays.
3. Enter the user name and password for the modem router.
   
   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the **OK** button.
   
   The BASIC Home screen displays.
5. Select **ADVANCED > Advanced Setup > Wireless Settings**.
6. Do one of the following in the Advanced Wireless Settings (2.4GHz b/g/n) section, Advanced Wireless Settings (5GHz a/n) section, or both sections:
   • **Turn off the radio.** Clear the **Enable Wireless Router Radio** check box.
     If both radios are disabled, the WiFi LED turns off (see *Top Panel with LEDs* on page 10).
   • **Turn on the radio.** Select the **Enable Wireless Router Radio** check box.
     If at least one radio is enabled, the WiFi LED lights solid green.

7. Click the **Apply** button.
   Your settings are saved.

**Manage the WPS Settings**

Wi-Fi Protected Setup (WPS) lets you join the WiFi network without typing the WiFi password. You can change the WPS default settings.

➢ **To manage WPS Settings:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

2. Type **http://www.routerlogin.net.**
   A login screen displays.

3. Enter the modem router user name and password.
   The user name is **admin.** The default password is **password.** The user name and password are case-sensitive.
   The BASIC Home screen displays.

4. Select **ADVANCED > Advanced Setup > Wireless Settings.**
   The Advanced Wireless Settings screen displays.

5. Scroll down to the bottom of the screen.

   ![WPS Settings](image)

   The **Router's PIN** field displays the fixed PIN that you use to configure the modem router's WiFi settings from another platform through WPS.

6. To disable the PIN, clear the **Enable Router's PIN** check box.
By default, the **Enable Router’s PIN** check box is selected and the modem router’s PIN is enabled. For enhanced security, you can disable the modem router’s PIN by clearing the **Enable Router’s PIN** check box. However, when you disable the modem router’s PIN, WPS is not disabled because you can still use the physical **WPS** button.

**Note:** The PIN function might temporarily be disabled automatically if the modem router detects suspicious attempts to break into the modem router’s WiFi settings by using the router’s PIN through WPS.

7. To allow the wireless settings for the 2.4 GHz radio to be changed automatically when you use WPS, clear the **Keep Existing Wireless Settings (2.4GHz b/g/n)** check box.

8. To allow the wireless settings for the 5 GHz radio to be changed automatically when you use WPS, clear the **Keep Existing Wireless Settings (5GHz a/n)** check box.

   By default, both **Keep Existing Wireless Settings** check boxes are selected. NETGEAR recommends that you leave these check box selected. If you clear these check box, the next time a new WiFi client uses WPS to connect to the modem router, the modem router WiFi settings change to an automatically generated random SSID and passphrase. For information about viewing this SSID and passphrase, see [Manage the Basic WiFi Settings and WiFi Security of the Main Network](#) on page 56. Clear the **Keep Existing Wireless Settings** check box for a radio only if you want to allow the WPS process to change the SSID and passphrase for WiFi access for that radio.

   **WARNING:**

   If you clear the Keep Existing Wireless Settings check box for a radio and use WPS to add a computer or WiFi device to the modem router’s WiFi network, the SSID and passphrase are automatically generated and other WiFi devices that are already connected to the modem router’s WiFi network might be disconnected.

9. Click the **Apply** button.

   Your settings are saved.

### Manage Advanced WiFi Features

For most WiFi networks, the advanced WiFi features work fine and you do not need to change the settings.

**Tip:** If you want to change the WiFi settings of the modem router’s main network, use a wired connection to avoid being disconnected when the new WiFi settings take effect.
To manage advanced WiFi features:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > Advanced Setup > Wireless Settings.

6. Enter the settings as described in the following table.
Except for the description of 20/40 MHz coexistence, the descriptions in the table (not the settings onscreen) apply to both the Advanced Wireless Settings (2.4GHz b/g/n) section and the Advanced Wireless Settings (5GHz a/n) section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable 20/40 MHz Coexistence       | By default, 20/40 MHz coexistence is enabled to prevent interference between WiFi networks in your environment at the expense of the WiFi speed. If no other WiFi networks are present in your environment, you can clear the Enable 20/40 MHz Coexistence check box to increase the WiFi speed to the maximum supported speed.  

**Note:** 20/40 MHz coexistence applies to the 2.4 GHz band only.   |
| Fragmentation Length (256-2346)    | The fragmentation length (the default is 2346), CTS/RTS threshold (the default is 2347), and the preamble mode (the default is Automatic) are reserved for WiFi testing and advanced configuration only. Do not change these settings unless directed by NETGEAR support or unless you are sure what the consequences are. Incorrect settings might disable the WiFi function of the modem router unexpectedly. |
| CTS/RTS Threshold (1-2347)         |                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    |
| Preamble Mode                      | You can lower the WiFi transmit power by selecting a value lower than 100% from the Transmit Power Control menu. The setting of 100% allows the modem router to use the maximum WiFi transmit power to transmit WiFi packets. Reducing the transmit power can save the power consumption for the modem router but also reduces the WiFi coverage. If you want to ensure maximum WiFi coverage, NETGEAR recommends that you leave the setting on the Transmit Power Control menu at 100%. |

7. Click the **Apply** button.  
Your settings are saved.

**Manage Wi-Fi Multimedia Quality of Service**

Wi-Fi Multimedia Quality of Service (WMM QoS) prioritizes WiFi voice and video traffic over the WiFi link.

WMM QoS prioritizes WiFi data packets from different applications based on four access categories: voice, video, best effort, and background. For an application to receive the benefits of WMM QoS, WMM must be enabled on both the application and the client running that application. Legacy applications that do not support WMM and applications that do not require QoS are assigned to the best effort category, which receives a lower priority than voice and video.

WMM QoS is automatically enabled for the modem router. However, you can disable WMM QoS if the wireless mode is set to **Up to 54 Mbps**. For more information about how to change the wireless mode, see **View or Change the Basic WiFi Settings** on page 56.
To disable WMM QoS:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net. A login screen displays.
3. Enter the user name and password for the modem router. The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button. The BASIC Home screen displays.
6. Clear the Enable WMM (Wi-Fi multimedia) settings (2.4 GHz b/g/n) check box.
7. Clear the Enable WMM (Wi-Fi multimedia) settings (5 GHz a/n) check box.
8. Click the Apply button. Your settings are saved.
Control Access to the Internet

The modem router comes with a built-in firewall that helps protect your home network from unwanted intrusions from the Internet.

This chapter includes the following sections:

- Set Up Parental Controls
- Use Keywords to Block Internet Sites
- Manage Simple Outbound Firewall Rules for Services and Applications
- Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules
- Set Up a WiFi Access List and Manage WiFi Access
- Set Up Security Event Email Notifications

For information about more advanced ways to configure Internet security, see Chapter 11, Manage Port Forwarding and Port Triggering.
Set Up Parental Controls

The first time that you select Parental Controls from the BASIC Home screen, your browser goes to the Parental Controls website, where you can learn more about Parental Controls. To set up Parental Controls, you must download the genie app.

![Parental Controls website](image)

Figure 9. Parental Controls website

To set up Parental Controls:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type [http://www.routerlogin.net](http://www.routerlogin.net).
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is *admin*. The default password is *password*. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select Parental Controls.
   The Parental Controls website opens.
6. Click the button for the genie app or version that you want to download and use.
7. Follow the onscreen instructions to download and install the genie app.
8. Open the genie app and select Parental Controls.

Live Parental Controls automatically starts.

9. Click the Next button, read the note, and click the Next button again.

Because Live Parental Controls uses free OpenDNS accounts, you are prompted to log in or create a free account.

10. Select a radio button as follows:
    • If you already own an OpenDNS account, leave the Yes radio button selected.
    • If you did not yet create an OpenDNS account, select the No radio button.

    If you are creating an account, the following screen displays.
a. Complete the fields.

b. Click the Next button.

After you log on or create your account, the filtering level screen displays.

11. Select a radio button for a filtering level and click the Next button.
12. Click the **Take me to the status screen** button.

Parental Controls are now set up for the modem router.

13. To enable Parental Controls, click the **Enable Live Parental Controls** button.
Use Keywords to Block Internet Sites

You can block keywords and domains (websites) to prevent certain types of HTTP traffic from accessing your network. By default, keyword blocking is disabled and no domains are blocked.

Set Up Blocking

You can set up blocking of specific keywords and domains to occur continuously or according to a schedule.

➢ To set up keyword and domain blocking:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > Security > Block Sites.
6. In the Keyword Blocking section, specify how the modem router applies keyword blocking:
   • **Per Schedule.** The modem router applies keyword blocking according to a schedule that you set.
     For more information, see *Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules* on page 95.
   • **Always.** The modem router applies keyword blocking continuously.

7. In the **Type keyword or domain name here** field, enter a keyword or domain.
   Here are some sample entries:
   • Specify XXX to block http://www.badstuff.com/xxx.html.
   • Specify .com if you want to allow only sites with domain suffixes such as .edu or .gov.
   • Enter a period (.) to block all Internet browsing access.

8. Click the **Add Keyword** button.
   The keyword or domain is added to the **Block sites containing these keywords or domain names** field (which is also referred to as the blocked list).

9. To add more keywords or domains, repeat Step 7 and Step 8.
   The keyword list supports up to 32 entries.

10. Click the **Apply** button.
    Your settings are saved.

### Remove a Keyword or Domain from the Blocked List

If you no longer need a keyword or domain on the blocked list, you can remove the keyword or domain.

➢ **To remove a keyword or domain from the blocked list:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home screen displays.
5. Select **ADVANCED > Security > Block Sites**.
   The Block Sites screen displays.
6. In the **Block sites containing these keywords or domain names** field, select the keyword or domain that you want to remove.

7. Click the **Delete Keyword** button.
   The keyword or domain is removed from the blocked list.

8. Click the **Apply** button.
   Your settings are saved.

### Remove All Keywords and Domains from the Blocked List

You can simultaneously remove all keywords and domains from the blocked list.

- **To remove all keywords and domains from the blocked list:**
  1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
  2. Type **http://www.routerlogin.net**.
     A login screen displays.
  3. Enter the user name and password for the modem router.
     The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
  4. Click the **OK** button.
     The BASIC Home screen displays.
  5. Select **ADVANCED > Security > Block Sites**.
     The Block Sites screen displays.
  6. Click the **Clear List** button.
     All keywords and domains are removed from the blocked list.
  7. Click the **Apply** button.
     Your settings are saved.

### Specify a Trusted Computer

You can exempt one trusted device from blocking and logging. The device that you exempt must be assigned a fixed (static) IP address.

- **To specify a trusted device:**
  1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
  2. Type **http://www.routerlogin.net**.
     A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.

4. Click the OK button.
   The BASIC Home screen displays.

5. Select ADVANCED > Security > Block Sites.

6. Scroll down and select the Allow trusted IP address to visit blocked sites check box.

7. In the Trusted IP Address field, enter the IP address of the trusted device.
   The first three octets of the IP address are automatically populated and depend on the IP address that is assigned to the modem router on the LAN Setup screen.

8. Click the Apply button.
   Your settings are saved.
Manage Simple Outbound Firewall Rules for Services and Applications

A firewall protects one network (the trusted network, such as your LAN) from another (the untrusted network, such as the Internet), while allowing communication between the two.

The modem router provides one default outbound firewall rule: It allows all access to the Internet (that is, the WAN). You can add simple rules to prevent access to specific services and applications on the Internet. In addition, you can specify if a rule applies to one user, a range of users, or all users on your LAN.

The modem router lists many default services and applications that you can use in outbound rules. You can also add an outbound firewall rule for a custom service or application.

For information about blocking specific keywords, URLs, or sites, see Use Keywords to Block Internet Sites on page 85. This type of blocking is another aspect of the outbound firewall.

For information about inbound firewall rules, see Manage Port Forwarding and Port Triggering on page 172.

---

**Note:** Service blocking means the same as applying outbound firewall rules.

Add an Outbound Firewall Rule

You can add an outbound firewall rule to prevent access to a specific service or application on the Internet.

➢ **To add an outbound firewall rule:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
6. In the Service Blocking section, specify how the modem router applies outbound rules:
   • **Per Schedule.** The modem router applies outbound rules according to a schedule that you set.
     For more information, see *Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules* on page 95.
   • **Always.** The modem router applies outbound rules continuously.

7. Below the Service Table, click the **Add** button.

8. From the **Service Type** menu, select service or application to be covered by this rule.
   If the service or application does not display in the list, you can add it (see *Add an Outbound Firewall Rule for a Custom Service or Application* on page 91).
9. Specify which devices on your LAN (or LAN users) are affected by the rule, based on their IP address:
   • **Only This IP Address.** Enter the required address in the **Start** field to apply the rule to a single device on your LAN.
   • **IP Address Range.** Enter the required addresses in the **Start** and **End** fields to apply the rule to a range of devices.
   • **All IP Addresses.** All computers and devices on your LAN are covered by this rule.
     By default, the **All IP Addresses** radio button is selected.

10. Click the **Add** button.
    The new rule is added to the Service Table on the Block Services screen.

### Add an Outbound Firewall Rule for a Custom Service or Application

The modem router lists many default services and applications that you can use in outbound rules. If the service or application is not predefined, you specify a custom service or application in an outbound rule.

➤ **To add an outbound firewall custom for a custom service or application:**

1. Find out which protocol and port number or range of numbers the service or application uses.
   You can usually find this information by contacting the publisher of the service or application or through online user or news groups.

2. Launch an Internet browser from a computer or WiFi device that is connected to the network.

3. Type **http://www.routerlogin.net**.
   A login screen displays.

4. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

5. Click the **OK** button.
   The BASIC Home screen displays.

6. Select **ADVANCED > Security > Block Services**.
7. If this is the first time that you add an outbound firewall rule, in the Service Blocking section, specify how the modem router applies outbound rules:
   - **Per Schedule.** The modem router applies outbound rules according to a schedule that you set.
     For more information, see *Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules* on page 95.
   - **Always.** The modem router applies outbound rules continuously.

8. Below the Service Table, click the **Add** button.

9. From the **Service Type** menu, select **User Defined.**
10. Specify a new outbound rule as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>Select the protocol (TCP or UDP) that is associated with the service or</td>
</tr>
<tr>
<td></td>
<td>application. If you are unsure, select TCP/UDP.</td>
</tr>
<tr>
<td>Starting Port</td>
<td>Enter the start port for the service or application.</td>
</tr>
<tr>
<td>Ending Port</td>
<td>If the service or application uses a range of ports, enter the end port</td>
</tr>
<tr>
<td></td>
<td>for the range. If the service or application uses a single port, repeat</td>
</tr>
<tr>
<td></td>
<td>the port number that you entered in the Starting Port field.</td>
</tr>
<tr>
<td>Service Type/User Defined</td>
<td>Enter the name of the custom service or application.</td>
</tr>
</tbody>
</table>

11. Specify which devices on your LAN (or LAN users) are affected by the rule, based on their IP address:

- **Only This IP Address.** Enter the required address in the Start field to apply the rule to a single device on your LAN.
- **IP Address Range.** Enter the required addresses in the Start and End fields to apply the rule to a range of devices.
- **All IP Addresses.** All computers and devices on your LAN are covered by this rule. By default, the All IP Addresses radio button is selected.

12. Click the Add button.

The new rule is added to the Service Table on the Block Services screen.

### Change an Outbound Firewall Rule

You can change an existing outbound firewall rule.

**To change an outbound firewall rule:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   
   A login screen displays.
3. Enter the user name and password for the modem router.
   
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   
   The BASIC Home screen displays.
   
   The following figure shows two rules in the Service Table.
Control Access to the Internet

In the Service Table, select the radio button for the rule.

Click the Edit button.
The Block Services Setup screen displays.

Change the settings.
For more information about the settings, see Add an Outbound Firewall Rule for a Custom Service or Application on page 91.

Click the Accept button.
Your settings are saved. The changed rule displays in the Service Table on the Block Services screen.

Remove an Outbound Firewall Rule
You can remove an outbound firewall rule that you no longer need.

To remove an outbound firewall rule:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select **ADVANCED > Security > Block Services**.  
The following figure shows two rules in the Service Table.

![Service Table](image)

6. In the Service Table, select the radio button for the rule.
7. Click the **Delete** button.
   
The rule is removed from the Service Table.

### Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules

You can set up a schedule that you can apply to keyword blocking (see *Use Keywords to Block Internet Sites* on page 85) and outbound firewall rules (see *Manage Simple Outbound Firewall Rules for Services and Applications* on page 89).

If applied, the schedule specifies the days and time that keyword blocking, outbound firewall rules, or both are active.

By default, no schedule is set and you can either enable or disable these features.

- **To set up a schedule for blocking:**
  1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
  2. Type **http://www.routerlogin.net**.
     
     A login screen displays.
  3. Enter the user name and password for the modem router.
     
     The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.  
The BASIC Home screen displays.

5. Select **ADVANCED > Security > Schedule**.

![Schedule](image)

6. Set up the schedule for blocking:
   - **Days to Block**. Select the check box for each day that you want to block access or specify that blocking occurs on every day by selecting the **Every Day** check box.
     
     By default, the **Every Day** check box is selected.
   
   - **Time of Day to Block**. Select a start and end time for blocking in 24-hour format or select the **All Day** check box for 24-hour blocking.
     
     By default, the **All Day** check box is selected.

7. From the **Time Zone** menu, select your time zone.

8. If you live in an area that observes daylight saving time, select the **Automatically adjust for daylight savings time** check box.

   **Note:** If the modem router synchronized its internal clock with a time server on the Internet and you selected the correct time zone, the **Current Time** field displays the correct date and time.

9. Click the **Apply** button.  
Your settings are saved.
Set Up a WiFi Access List and Manage WiFi Access

By default, any WiFi device that is configured with the correct SSID is allowed access to your WiFi network. For increased security, you can restrict access to the WiFi network to allow only specific WiFi devices based on their MAC addresses.

Set Up and Enable a WiFi Access List

A WiFi access control list (ACL) consists of MAC addresses of WiFi devices that are blocked from accessing your WiFi network.

Each network device owns a MAC address, which is a unique 12-character physical address, containing the hexadecimal characters 0–9, a–f, or A–F (uppercase or lowercase) only, and separated by colons (for example, 00:09:AB:CD:EF:01). Typically, the MAC address is on the label of the WiFi card or network interface device. If you cannot see the label, you can display the MAC address using the network configuration utilities of the computer. You might also find the MAC addresses through the web management interface of the modem router (see View Devices Currently on the Network on page 169).

WARNING:

If you use a WiFi device to set up a WiFi access list that, add your WiFi device to the access list; otherwise, you are disconnected when you click the Apply button. To avoid this situation, use a computer with a wired connection to access the modem router.

➢ To restrict WiFi access based on MAC addresses:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > Advanced Setup > Wireless Settings.
   The Advanced Wireless Settings screen displays.
6. Scroll down to the bottom and click the Set Up Access List button.
   The Wireless Card Access List screen displays.
7. Click the Add button.
8. In the **Device Name** field, enter a name for the WiFi device.
9. In the **MAC Address** field, enter the MAC address of the WiFi device.

   **Tip:** You can also select a device from the Available Wireless Cards table by selecting the corresponding radio button.

10. Click the **Add** button.

    The WiFi device is added to the table on the Wireless Card Access List screen.

11. To add another WiFi device, repeat **Step 7** through **Step 10**.
12. Select the **Turn Access Control On** check box.
13. Click the **Apply** button.

    Your settings are saved and the modem router restarts. After the restart, only WiFi devices that are in the table on the Wireless Card Access List screen can access the modem router.

### Change the Settings for a Device on the WiFi Access List

You can change the device name or MAC address for a device on the WiFi access list.

- **To change the settings for a device on the WiFi access list:**
  1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
  2. Type **http://www.routerlogin.net**.

    A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.

4. Click the OK button.
   The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > Wireless Settings.
   The Advanced Wireless Settings screen displays.

6. Scroll down to the bottom and click the Set Up Access List button.

7. In the table, select the radio button next to the WiFi device for which you want to make a change.

8. Click the Edit button.
   The Edit Wireless Card screen displays.

9. Change the device name or MAC address.

10. Click the Accept button.
    The settings are saved and display in the table on the Wireless Card Access List screen. However, if you restart the modem router, the changes are lost. You also must apply the changes on the Wireless Card Access List screen.

11. On the Wireless Card Access List screen, click the Apply button.
    Your settings are saved.

**Remove a Device From the WiFi Access List**

If you no longer need a block a device, you can remove it from the WiFi access list.

**To remove a device from the WiFi access list:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

2. Type http://www.routerlogin.net.
   A login screen displays.

3. Enter the user name and password for the modem router.
The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home screen displays.

5. Select **ADVANCED > Advanced Setup > Wireless Settings**.
   The Advanced Wireless Settings screen displays.

6. Scroll down to the bottom and click the **Set Up Access List** button.

7. In the table, select the radio button next to the WiFi device that you want to remove.

8. Click the **Delete** button.
   The device is removed from the table on the Wireless Card Access List screen.

9. Click the **Apply** button.
   Your settings are saved.

**Set Up Security Event Email Notifications**

The modem router can email you its logs of its activity. The log records router activity and security events such as attempts to access blocked sites or services.

➢ **To set up email notifications:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

2. Type **http://www.routerlogin.net**.
   A login screen displays.

3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home screen displays.

5. Select **ADVANCED > Security > E-mail**.
6. Select the **Turn Email Notification On** check box.
7. Enter the settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send alerts and logs through e-mail</td>
<td>Send to This E-mail Address Enter the email address to which logs and alerts must be sent.</td>
</tr>
<tr>
<td></td>
<td>Your Outgoing Mail Server Enter the name of your ISP’s outgoing (SMTP) mail server (such as mail.myISP.com). You might be able to find this information in the configuration screen of your email program. If you leave this field blank, log and alert messages are not sent.</td>
</tr>
<tr>
<td></td>
<td>Secure connection (use SSL) Select this check box to send messages over a secure connection.</td>
</tr>
</tbody>
</table>
|                                            | My mail server requires authentication If your outgoing email server requires authentication, select this check box and specify the following settings:  
- In the **User Name** field, enter the user name for the outgoing email server.  
- In the **Password** field, enter the password for the outgoing email server. |

| Send logs according to this schedule       | To send logs based on a schedule, select one of the following options from the menu:  
- **When log is full.** This is the default selection.  
- **Hourly.** Logs are sent every hour.  
- **Daily.** Logs are sent every day. From the **Time** menu, specify the time of day, and select the **am** or **pm** radio button.  
- **Weekly.** Logs are sent every week. From the **Day** menu, select the day. From the **Time** menu, specify the time of day, and select the **am** or **pm** radio button. |
|                                            | If you do not want logs to be sent at all, select the **None** option from the menu. |
8. Click the **Apply** button.

Your settings are saved.

Logs are sent automatically. If the log fills before the specified time, it is sent. After the log is sent, it is cleared from the modem router memory. If the modem router cannot email the log and the log buffer fills, the modem router overwrites the log.
Share a Storage Device

This chapter describes how to access and manage a storage device attached to your modem router. ReadySHARE lets you access and share a USB storage device connected to the modem router. (If your storage device uses special drivers, it is not compatible.)

---

Note: You can use the USB port on the modem router only to connect a USB storage device such as a flash drive or hard drive or a printer. Do not connect a computer, USB modem, CD drive, or DVD drive to the modem router USB port.

---

The chapter includes the following sections:

- **USB Device Requirements**
- **Connect a USB Device to the Modem Router**
- **Access a Storage Device Connected to the Modem Router**
- **Back Up Windows Computers with ReadySHARE Vault**
- **Back Up Mac Computers with Time Machine**
- **Control Access to a Storage Device**
- **Use FTP Within Your Network**
- **View Network Folders on a Device**
- **Add a Network Folder on a Storage Device**
- **Change a Network Folder, Including Read and Write Access, on a USB Drive**
- **Safely Remove a USB Device**

---

Note: For more information about ReadySHARE features, visit www.netgear.com/readyshare.
USB Device Requirements

The modem router works with most USB-compliant external flash and hard drives. For the most up-to-date list of USB devices that the modem router supports, visit http://kbserver.netgear.com/readyshare.

Some USB external hard drives and flash drives require you to load the drivers onto the computer before the computer can access the USB device. Such USB devices do not work with the modem router.

The modem router supports the following file system types for full read/write access:

- FAT16
- FAT32
- NTFS
- NTFS with compression format enabled
- Ext2
- Ext3
- Ext4

The modem router supports the following file system types with read-only access:

- HFS
- HFS+

Connect a USB Device to the Modem Router

ReadySHARE lets you access and share a USB device connected to the USB port on the modem router. (If your USB device uses special drivers, it is not compatible.) The USB port is on the back panel of the modem router.

To connect a USB device:

1. Connect your USB storage device to the USB port on the modem router.
2. If your USB device requires a power supply, connect it.
You must use the power supply when you connect the USB device to the modem router. When you connect the USB device to the USB port of the modem router, it might take up to two minutes before the USB device is ready for sharing. By default, the USB device is available to all computers on your local area network (LAN).

Access a Storage Device Connected to the Modem Router

From a computer or device on the network, you can access a storage device that is connected to the modem router.

➢ To access the device from a Mac:

1. Connect a USB storage device to the USB port on the modem router.
   
   If your storage device uses a power supply, you must use it when you connect the device to the modem router.
   
   When you connect the storage device to the modem router’s port, it might take up to two minutes before the storage device is ready for sharing. By default, the device is available to all computers on your local area network (LAN).

2. On a Mac that is connected to the network, select Go > Connect to Server.
3. In the Server Address field, enter smb://readyshare.
4. When prompted, select the Guest radio button.
5. Click the Connect button.
   
   A window automatically opens and displays the files and folders on the device.

➢ To access the device from a Windows computer:

1. Connect a USB storage device to the USB port on the modem router.
   
   If your storage device uses a power supply, you must use it when you connect the device to the modem router.
   
   When you connect the storage device to the modem router’s port, it might take up to two minutes before the storage device is ready for sharing. By default, the device is available to all computers on your local area network (LAN).

2. Launch a web browser from a computer that is connected to the network.
3. In the address field of the browser, enter \eadyshare.
   
   Windows file manager automatically opens and displays the files and folders on the device.
Back Up Windows Computers with ReadySHARE Vault

The modem router comes with free backup software for all the Windows computers in your home. Connect a USB hard disk drive (HDD) to the modem router for centralized, continuous, and automatic backup.

The following operating systems support ReadySHARE Vault:

• Windows 7
• Windows 8
• Windows 8.1

➢ To back up your Windows computer:

1. Connect a USB HDD to one of the USB ports on the modem router.
3. Scroll down to the A Happy Home Is Filled With Love And Safely Stored Data section.
4. Click the Download the installer and get started link.
5. Follow the onscreen instructions to download the utility file.
6. Launch the ReadySHAREVault-install.exe file and install the utility.
   The Dashboard screen displays.
7. Use the dashboard or the Backup tab to set up and run your backup.

Back Up Mac Computers with Time Machine

You can use Time Machine to back up your Mac computers onto a USB hard drive that is connected to the USB port on the modem router. You can access the connected storage device from your Mac with a wired or wireless connection to your modem router.

Set Up a USB Hard Drive on a Mac

NETGEAR recommends that you use a new USB HDD or format your old USB disk to do the Time Machine backup for the first time. Use a blank partition to prevent some issues during backup using Time Machine. The modem router supports GUID or MBR partitions.

➢ To format your USB hard disk drive and specify partitions:

1. Physically connect the USB hard drive to your Mac.
2. On your Mac, go to Spotlight (or the magnifying glass) at the top right of the screen and search for Disk Utility.
3. To format your USB device, open the Disk Utility, click the Erase tab, and click the Erase button.
4. Click the Partition tab.
5. Click **Partition Layout** and set the number of partitions that you want to use.
6. Click the **Options** button.
   The Partition options display.
7. Select the **GUID Partition Table** or **Master Boot Record** radio button.
8. For the format, select **Mac OS Extended (Journaled)**.
9. Click the **OK** button.
10. Click the **Apply** button.
    Your settings are saved.

**Prepare to Back Up a Large Amount of Data**

Before you back up a large amount of data with Time Machine, NETGEAR recommends that you follow this procedure.

➢ **To prepare to back up a large amount of data:**

1. Upgrade the operating system of the Mac computer.
2. Verify and repair the backup disk and the local disk.
3. Verify and repair the permissions on the local disk.
4. Set Energy Saver:
   a. From the **Apple** menu, select **System Preferences**.
   b. From the **View** menu, select **Energy Saver**.
   c. Click the **Power Adapter** tab.
   d. Select the **Wake for Wi-Fi network access** check box.
   e. Click the **Back arrow** to save the changes and exit the screen.
5. Modify your security settings:
   a. From the **Apple** menu, select **System Preferences**.
   b. From the **View** menu, select **Security**.
   c. Click the **Advanced** button at the bottom of the screen.
   d. Leave the **Log out after minutes of inactivity** check box cleared.

**Use Time Machine to Back Up onto a Storage Device**

You can use Time Machine to back up your Mac computers onto a USB hard disk drive that is connected to the USB port on the modem router.

➢ **To back up your Mac onto a USB hard drive:**

1. Prepare your USB device with a compatible format and partitions.
   See **Set Up a USB Hard Drive on a Mac** on page 106.
If you plan to back up a large amount of data, see *Prepare to Back Up a Large Amount of Data* on page 107.

2. Insert your USB storage drive into the USB port on the modem router.

   **Note:** If your USB device uses a power supply, you must use it when you connect the USB device to the modem router.

   When you connect the USB device to the USB port on the modem router, it might take up to two minutes before the USB device is ready for sharing. By default, the USB device is available to all computers on your local area network (LAN).

3. On your Mac computer, select **Go > Connect to Server**.
4. Type `afp://routerlogin.net`.
5. When prompted to enter your name and password, select the **Guest** radio button.
6. Click the **Connect** button.

   A list of connected devices displays. This list includes the name *admin* when you log in as *admin*.

7. From the **Apple** menu, select **System Preferences**.
8. Open Time Machine.
9. Click the **Select Backup Disk** button and select your USB device from the list.
10. Click the **Use for Backup** button.

   **Note:** If you do not see the USB partition that you want in the Time Machine disk list, go to Mac finder and click that USB partition. It displays in the Time Machine list.

11. When prompted to enter your name and password, select the **Guest** radio button and click the **Connect** button.

When the setup is complete, the Mac automatically schedules a full backup. You can back up immediately if you want.

### Control Access to a Storage Device

You can specify the device name, workgroups, and network folders for a storage device connected to the USB port on the modem router.

➢ **To specify the storage device access settings:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.

   A login screen displays.

3. Enter the user name and password for the modem router.
The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.

The **BASIC** Home screen displays.

5. Select **ADVANCED > USB Storage > Advanced Settings**.

6. Specify access to the storage device:
   - **Network Device Name**. This is the name used to access the USB device that is connected to the modem router.
   - **Workgroup**. This is the name of the workgroup that the USB device is a member of. By default, the name is Workgroup. The name works only in an operating system that supports NetBIOS, such as Microsoft Windows.
   - **Access Method**. Select the check boxes for the access methods that you want to allow:
     - **Network Connection**. Enabled by default. You can type `\readyshare` to access the storage device within your network. If you change the name in the **Network Device Name** field from readyshare to another name, the link changes accordingly.
     - **FTP**. Disabled by default. If you enable this feature, you can type `ftp://readyshare.routerlogin.net/shares` to access the storage device within your network and download or upload files. The default port is number 21.
     - **FTP (via Internet)**. Disabled by default. If you enable this feature, remote users can type `ftp://<public IP address/shares>` (for example, `ftp://1.1.10.102/shares`) to access the device over the Internet and download or upload files. If you set up Dynamic DNS (see **Set Up and Manage Dynamic DNS** on page 125), you can also type a URL domain name (for example, `ftp://MyName.mynetgear.com/shares`). The default port is number 21, which you can change.
7. Click the **Apply** button.
   Your settings are saved.

**Use FTP Within Your Network**

File Transfer Protocol (FTP) lets you download (receive) and upload (send) large files faster.

---

**Note:** For information about using FTP to access a storage device over the Internet, see *Chapter 8, Access Storage Devices Through the Internet.*

---

➢ **To set up FTP access:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home screen displays.
5. Select **ADVANCED > USB Storage > Advanced Settings**.

![FTP Settings](image)

6. Select the **FTP** check box.
7. Click the Apply button.
Your settings are saved.

View Network Folders on a Device

You can view or change the network folders on a USB storage device connected to the modem router.

➢ To view network folders:
1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > USB Storage > Advanced Settings.

6. The Available Networks Folder section of the screen shows the following settings:
   • Share Name. The default share name is USB_Storage.
   • Read Access and Write Access. The permissions and access controls on the network folder. All—no password (the default) allows all users to access the network folder. The password for admin is the same one that you use to log in to the modem router.
Add a Network Folder on a Storage Device

You can add network folders on a storage device connected to the USB port on the modem router.

➢ To add a network folder:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > USB Storage > Advanced Settings.

   ![USB Storage (Advanced Settings) Screen]

6. In the Available Network Folders table, select a device.
7. Click the Create Network Folder button.
If this screen does not display, your web browser might be blocking pop-ups. If it is, change the browser settings to allow pop-ups.

8. From the **USB Device** menu, select the USB drive.

   **Note:** Best practise is not to attach more than one drive to the USB port (for example, through a USB hub).

9. Click the **Browse** button and in the **Folder** field, select the folder.

10. In the **Share Name** field, type the name of the share.

11. From the **Read Access** menu and the **Write Access** menu, select the settings that you want.

   All–no password (the default) allows all users to access the network folder. The other option is that only the admin user is allowed access to the network folder. The password for admin is the same one that you use to log in to the modem router.

12. Click the **Apply** button.

   The folder is added on the storage device.

---

**Change a Network Folder, Including Read and Write Access, on a USB Drive**

You can change network folders on storage devices connected to the USB port on the modem router.

➢ **To change a network folder:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

2. Type `http://www.routerlogin.net`.

   A login screen displays.

3. Enter the user name and password for the modem router.
The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.

The BASIC Home screen displays.

5. Select **ADVANCED > USB Storage > Advanced Settings**.

![ADVANCED > USB Storage > Advanced Settings](image)

6. Click the **Edit** button.

![Edit Network Folder](image)

7. Change the settings in the fields as needed.

For more information about the settings, see *Add a Network Folder on a Storage Device* on page 112.

8. Click the **Apply** button.

Your settings are saved.
Safely Remove a USB Device

Before you physically disconnect a USB device from the USB port on the modem router, log in to the modem router, and take the drive offline.

➢ **To remove a USB device safely:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

2. Type `http://www.routerlogin.net`.
   A login screen displays.

3. Enter the user name and password for the modem router.
   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home screen displays.

5. Select **READYSHARE**.
   The USB Settings (Basic Settings) screen displays.

6. Click the **Safely Remove USB Device** button.
   The device goes offline.

7. Physically disconnect the USB device.
Share a USB Printer

The ReadySHARE Printer utility lets you share a USB printer that is connected to the USB port on your modem router. You can share this USB printer among the Windows and Mac computers on your network.

The chapter includes the following sections:

- Install the Printer Driver and Cable the Printer
- Download the ReadySHARE Printer Utility
- Install the ReadySHARE Printer Utility
- Use the Shared Printer
- View or Change the Status of a Printer
- Use the Scan Feature of a Multifunction USB Printer
- Change NETGEAR USB Control Center Settings
Install the Printer Driver and Cable the Printer

Some USB printer manufacturers (for example, HP and Lexmark) request that you do not connect the USB cable until the installation software prompts you to do so.

➢ To install the driver and cable the printer:

1. On each computer on your network that shares the USB printer, install the driver software for the USB printer.
   
   If the printer driver is not installed, contact the printer manufacturer.

2. Use a USB printer cable to connect the USB printer to a modem router USB port.

Download the ReadySHARE Printer Utility

The utility works on Windows computers, Mac computers, smart phones, and tablets.

➢ To download the ReadySHARE Printer utility:


2. Scroll down to the Print From the Comfort of Your Home Network section at the bottom of the screen.

3. Click one of the following links.
   
   • Download PC installer and get started. This is the utility for Windows computers.
   
   • Download Mac installer and get started. This is the utility for MAC computers.
   
   • Download the genie App and get started. This is the utility for smart phones and tablets.

4. Follow the onscreen instructions to download the ReadySHARE Printer utility setup file.
Install the ReadySHARE Printer Utility

You must install the ReadySHARE Printer utility on each computer that will share the printer. After you install it, the utility displays as NETGEAR USB Control Center on your computer.

➢ To install the utility:

1. If necessary, unzip the ReadySHARE Printer utility setup file.
2. Double-click the ReadySHARE Printer utility setup file that you downloaded.

   The InstallShield wizard displays.

3. Follow the wizard instructions to install NETGEAR USB Control Center.

   After the InstallShield Wizard completes the installation, the NETGEAR USB Control Center prompts you to select a language.

4. Select a language from the list and click the OK button.

   The NETGEAR USB Control Center displays the main screen.
Some firewall software, such as Comodo, blocks NETGEAR USB Control Center from accessing the USB printer. If you do not see the USB printer displayed in the screen, you can disable the firewall temporarily to allow the utility to work.

5. Select the printer and click the **Connect** button.
   The printer status changes to Manually connected by *Mycomputer*. Now, only your computer can use the printer.

6. Click the **Disconnect** button.
   The status changes to Available. Now all computers on the network can use the printer.

7. To exit the utility, select **System > Exit**.

**Use the Shared Printer**

For each computer, after you click the **Connect** and **Disconnect** buttons once, the utility automatically manages the printing queue. By default, the utility starts automatically whenever you log on to Windows and runs in the background.

➢ **To manually connect and print:**

1. Click the **NETGEAR USB Control Center** icon.
   The main screen displays.

2. Click the **Connect** button.
   The printer status changes to Manually connected by *Mycomputer*. Now only the computer you are using can use this printer.

3. Use the print feature in your application to print your document.

4. To release the printer so that all computers on the network can use it, click the **Disconnect** button.
To print and release the printer to any computer on the network:

1. To print your document, use the print feature in your application.
   The NETGEAR USB Control Center automatically connects your computer to the USB printer and prints the document. If another computer is already connected to the printer, your print job goes into a queue to wait to be printed.

2. If your document does not print, use the NETGEAR USB Control Center to check the status.
   See View or Change the Status of a Printer on page 120.

View or Change the Status of a Printer

To view or change the status:

1. Click the NETGEAR USB Control Center icon.
   The main screen displays.

   ![](image)

   The Status column shows the status for each device:

   - **Available.** No print jobs are in progress. You can use the USB printer from any computer in the network.
   - **Connected.** Your computer is connected to the printer and will be released when your print job is done.
   - **Manually Connected by.** Only the connected computer can use the printer.
   - **Waiting to Connect.** Your computer is not connected to the shared printer yet.

2. To print from your computer when the status shows Manually connected by another computer, click the Disconnect button.
   The printer is released from the connection and the status changes to Available.

3. To print from your computer when the status shows Waiting to Connect, do the following:
   a. Click the Connect button.
      The printer status changes to Manually connected by Mycomputer. Now only your computer can use the printer.
   b. To allow the printer to be shared, click the Disconnect button.
      The printer is released from the connection and the status changes to Available.
Use the Scan Feature of a Multifunction USB Printer

If your USB printer supports scanning, you can also use the USB printer for scanning. For example, the USB printer displayed in the Windows Printers and Faxes window is ready for print jobs.

To use the scan feature of a multifunction USB printer:

1. Click the NETGEAR USB Control Center icon.
   The main screen displays.

2. Make sure that the printer status shows as Available.
3. Click the Network Scanner button.

The scanner screen displays so that you can use the USB printer for scanning.
Change NETGEAR USB Control Center Settings

You can stop the NETGEAR USB Control Center from starting automatically when you log in to Windows. You can also change the language and specify the time-out to release the printer connection.

➢ To turn off automatic NETGEAR USB Control Center startup:

1. Click the **NETGEAR USB Control Center** icon.

The main screen displays.

2. Select **Tools > Configuration**.

3. Clear the **Automatically execute when logging on Windows** check box.

4. Click the **OK** button.

Your settings are saved.
Change the NETGEAR USB Control Center Language

To change the language:

1. Click the NETGEAR USB Control Center icon. The main screen displays.
2. Select Tools > Configuration. The Control Center - Configuration screen displays.
3. From the Language menu, select a language.
4. Click the OK button. The next time NETGEAR USB Control Center starts, the language changes.

Specify the Time-out

To specify the time-out:

1. Click the NETGEAR USB Control Center icon. The main screen displays.
2. Select Tools > Configuration. The Control Center - Configuration screen displays.
3. In the Timeout field, type the number of minutes. The time-out is the number of minutes that a computer holds its connection to the printer when the connection is not being used.
4. Click the OK button. Your settings are saved.
Access Storage Devices Through the Internet

With Dynamic DNS, you can use the Internet and a personal domain name to access a USB storage device that is attached to the USB port of the modem router when you are not home. If you know the IP address of the modem router (and the IP address did not change), you can also access the USB storage device by using the IP address.

This chapter includes the following sections:

- Set Up and Manage Dynamic DNS
- Access Storage Devices Through the Internet

Note: For information about how to connect the device and specify its settings, see Chapter 6, Share a Storage Device.
Set Up and Manage Dynamic DNS

Internet service providers (ISPs) assign numbers called IP addresses to identify each Internet account. Most ISPs use dynamically assigned IP addresses. This means that the IP address can change at any time. You can use the IP address to access your network remotely, but most people do not know what their IP addresses are or when this number changes.

To make it easier to connect, you can get a free account with a Dynamic DNS service that lets you use a domain name to access your home network. To use this account, you must set up the modem router to use Dynamic DNS. Then the modem router notifies the Dynamic DNS service provider whenever its IP address changes. When you access your Dynamic DNS account, the service finds the current IP address of your home network and automatically connects you.

If your ISP assigns a private WAN IP address (such as 192.168.x.x or 10.x.x.x), the Dynamic DNS service does not work because private addresses are not routed on the Internet.

Your Personal FTP Server

With a dynamic DNS account, you can use FTP to access your network when you are not home through Dynamic DNS.

➢ To set up your personal account and use FTP:

1. Register for an account with a supported Dynamic DNS service provider.
   For more information, see Set Up Dynamic DNS on page 126.

2. Make sure that your Internet connection is working.
   Your modem router must use a direct Internet connection. It cannot connect to a different router to access the Internet.

3. Connect a USB storage device to the USB port of the modem router.

4. Set up FTP access in the modem router.
   For more information, see Set Up FTP Access Through the Internet on page 127.

5. On a remote computer with Internet access, you can use FTP to access your modem router using ftp://yourname.mynetgear.com.
   For more information, see Access Storage Devices Through the Internet with FTP on page 129.
Set Up Dynamic DNS

For you to be able to set up Dynamic DNS on the modem router, you need an account with a Dynamic DNS provider.

To set up Dynamic DNS:

1. Register for an account with one of the Dynamic DNS service providers whose URLs are in the Service Provider menu on the Dynamic DNS screen.
2. Launch an Internet browser from a computer or WiFi device that is connected to the network.
3. Type http://www.routerlogin.net. A login screen displays.
4. Enter the user name and password for the modem router. The user name is admin. The default password is password. The user name and password are case-sensitive.
5. Click the OK button. The BASIC Home screen displays.
6. Select ADVANCED > Advanced Setup > Dynamic DNS.

7. Select the Use a Dynamic DNS Service check box.
8. From the Service Provider menu, select the URL of your Dynamic DNS service provider. For example, for DynDNS.org, select www.DynDNS.org. The DNS service providers that you can select from the menu depend on the region and country in which you use the modem router.
9. In the **Host Name** field, type the host or domain name that your Dynamic DNS service provider gave you.

10. In the **User Name** field, type the user name for your Dynamic DNS account.
    This is the name that you use to log in to your account, not your host name.

11. In the **Password** field, type the password or key for your Dynamic DNS account.

12. Click the **Apply** button.
    Your settings are saved.

**Access Storage Devices Through the Internet**

If you connect a USB storage device to the modem router, you can access the USB device through the Internet when you are not home. After you gained access, you can use FTP to share files on the USB device.

➢ **To access devices from a remote computer:**

1. Launch a web browser on a computer that is not on your home network.

2. Connect to your modem router on your home network:
   - To connect with Dynamic DNS, type the DNS name.
   - To use a Dynamic DNS account, you must enter the account information in the Dynamic DNS screen (see *Set Up and Manage Dynamic DNS* on page 125).
   - To connect without Dynamic DNS, type the modem router’s Internet port IP address.
     You can view the modem router’s Internet IP address on the BASIC Home screen.

**Set Up FTP Access Through the Internet**

If you attach a storage device to the modem router, you can access the storage device from your network (see *Use FTP Within Your Network* on page 110). You can also set up FTP access through the Internet so you can access the storage device from outside your local network, for example, when you are not at home.

➢ **To set up FTP access through the Internet**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

2. Type **http://www.routerlogin.net**.
   A login screen displays.

3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
The BASIC Home screen displays.

5. Select **ADVANCED > USB Storage > Advanced Settings**.

![Advanced Settings Screen]

6. Select the **FTP (via Internet)** check box.

7. Click the **Apply** button.

   Your settings are saved.

8. To limit access to the admin user, do the following:
   a. Click the **Edit** button.
   
   ![Edit Network Folder]
   
   b. In the **Read Access** list, select **admin**.
   c. In the **Write Access** list, select **admin**.
   d. Click the **Apply** button.

   Your settings are saved.

   e. Click the **Close Window** button.
Access Storage Devices Through the Internet with FTP

If you attached a storage device to the modem router, before you can access the storage device through the Internet with FTP, you must first set it up (see Set Up FTP Access Through the Internet on page 127).

➢ To access a USB device with FTP from a remote computer to download or upload a file:

1. Take one of the following actions:
   • To download a file from a storage device connected to the modem router, launch a web browser.
   • To upload a file to a storage device connected to the modem router, launch an FTP client such as Filezilla.

2. Type `ftp://` and the Internet port IP address in the address field of the browser.
   For example, type `ftp://10.1.65.4`.
   If you are using Dynamic DNS, type the DNS name.
   For example, type `ftp://MyName.mynetgear.com`.

3. When prompted, log in:
   • To log in as admin, in the **user name** field, enter **admin** and in the **password** field, enter the same password that you use to log in to the modem router.
   • To log in as guest, in the **user name** field, enter **guest**.
     The guest user name does not need a password. To restrict access to the USB device, you can specify that only the admin user can access it. See Control Access to a Storage Device on page 108.

   The files and folders that your account can access on the USB device display. For example, you might see `share/partition1/directory1`.

4. Navigate to a location on the USB device.

5. Download or upload the file.
Manage the WAN and LAN Network Settings

This chapter describes how you can manage the WAN and LAN network settings of the modem router.

The chapter includes the following sections:

- Manage the ADSL Settings
- Change the Type of Physical WAN Connection
- Manage the WAN Security Settings
- Set Up a Default DMZ Server
- Manage IGMP Proxying and VPN Pass-Through
- Manage NAT Filtering
- Manage the SIP Application-Level Gateway
- Manage the Modem Router’s LAN IP Address Settings
- Manage Reserved LAN IP Addresses
- Change the Modem Router’s Device Name
- Manage the DHCP Server Address Pool
- Disable the Built-In DHCP Server
- Set Up and Manage Custom Static Routes
- Improve Network Connections with Universal Plug and Play

For information about the MTU size, see Manage the MTU Size on page 52.

For information about Dynamic DNS, see Set Up and Manage Dynamic DNS on page 125.
Manage the ADSL Settings

NETGEAR recommends that you use the NETGEAR genie Setup Wizard to detect the DSL connection and automatically set up the modem router (see Set Up Your Modem Router for DSL Service on page 18).

If you are technically experienced and are sure of the correct DSL mode, multiplexing method, virtual circuit number for the virtual path identifier (VPI), virtual channel identifier (VCI), and ATM traffic class parameters, you can change those settings.

**CAUTION:**
Change the DSL mode, multiplexing method, VPI, VCI, and ATM traffic class parameters only if your ISP gave you this information. If you enter incorrect settings, the modem router might no longer be able to connect to your ISP network.

➢ To view or change the ADSL setup:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select xDSL.
6. From the **DSL Mode** menu, select the DSL mode that your ISP provided you:
   - **Auto.** The modem router detects the DSL mode automatically. This is the default setting.
   - **ADSL (G.dmt).** Legacy version of ADSL.
   - **ADSL2.** Legacy version of ADSL2.
   - **ADSL2+.** ADSL2+ provides the fastest downstream rates and can interoperate with ADSL2 and ADSL (g.dmt).

7. Click the upper **Apply** button.
   The DSL mode changes are saved.

8. If your ISP provided you PVC settings, specify some or all of the following settings, depending on the information that your ISP gave you:
   a. Unless your ISP instructs you otherwise, keep the **Enable This Interface** check box selected.
      By default, the check box is selected and the interface is enabled.
   b. From the **Multiplexing Method** menu, select **LLC-BASED** or **VC-BASED**, as indicated by your ISP.
   c. For the VPI, enter a number between 0 and 255, as indicated by your ISP.
      The default setting is 0.
d. For the VCI, enter a number between 32 and 65535, as indicated by your ISP. The default setting is 38.

9. If your ISP provided you ATM traffic class parameters, specify some or all of the following settings, depending on the information that your ISP gave you:
   a. From the ATM Traffic Class menu, select UBR, CBR, NRT-VBR, or RT-VBR, as indicated by your ISP.
   b. In the PRC field, enter the Peak Cell Rate in number of cells per second.
   c. In the SRC field, enter the Sustainable Cell Rate in number of cells per second.
   d. In the MBS field, enter the Maximum Burst Size (MBS) in number of cells.

10. Click the *lower Apply* button.
    The PVC settings, ATM traffic class parameters, or both are saved.

### Change the Type of Physical WAN Connection

When you set up the modem router for cable or fiber (Ethernet WAN) service, you must change the default type of WAN connection (see *Set Up Your Modem Router for Cable or Fiber Service* on page 26). If you want to change the type of WAN connection, use the information in this section.

The default type of WAN connection is the ADSL port for an Internet connection over DSL service. With this option, the LAN 4 Ethernet port is available for a LAN connection. The other type of WAN connection is the WAN Ethernet port for an Internet connection over cable or fiber service. With this option, the LAN 4 Ethernet port is not available for a LAN connection because the port serves as the WAN port.

➢ **To change the type of WAN connection:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type *http://www.routerlogin.net*.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is *admin*. The default password is *password*. The user name and password are case-sensitive.
4. Click the *OK* button.
   The BASIC Home screen displays.
5. Select *xDSL*.
   The ADLS Settings screen displays.
6. From the **Physical WAN Type** menu, select one of the following options:
   - **Ethernet WAN.** The modem router uses the WAN Ethernet port for a cable or fiber connection. The ADSL port is shut down. The LAN 4 Ethernet port is not available for a LAN connection because the port serves as the WAN port.
   - **ADSL2+.** The modem router uses the ADSL port for a DSL WAN connection. The LAN 4 Ethernet port is available for a LAN connection.

7. Click the **Apply** button.
   Your settings are saved.

### Manage the WAN Security Settings

The WAN security settings include port scan protection and denial of service (DoS) protection, which can protect your LAN against attacks such as Syn flood, Smurf Attack, Ping of Death, and many others. By default, DoS protection is disabled and a port scan is rejected.

You can also enable the modem router to respond to a ping to its WAN (Internet) port. This feature allows your modem router to be discovered. Enable this feature only as a diagnostic tool or if a specific reason exists.

➢ **To change the default WAN security settings:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

2. Type `http://www.routerlogin.net`.
   A login screen displays.

3. Enter the user name and password for the modem router.
   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home screen displays.

5. Select **ADVANCED > Setup > WAN Setup**.
   The WAN Setup screen displays.

6. To enable port scan and DoS protection, clear the **Disable Port Scan and DoS Protection** check box.

   **Note:** Enabling port scan and DoS protection might affect the performance of the modem router.

7. To enable modem router to respond to a ping, select the **Respond to Ping on Internet Port** check box.

8. Click the **Apply** button.
   Your settings are saved.
Set Up a Default DMZ Server

The default DMZ server feature is helpful when you are using some online games and videoconferencing applications that are incompatible with Network Address Translation (NAT). The modem router is programmed to recognize some of these applications and to work correctly with them, but other applications might not function well. In some cases, one local computer can run the application correctly if the IP address for that computer is entered as the default DMZ server.

**WARNING:**

DMZ servers pose a security risk. A computer designated as the default DMZ server loses much of the protection of the firewall and is exposed to exploits from the Internet. If compromised, the DMZ server computer can be used to attack other computers on your network.

The modem router usually detects and discards incoming traffic from the Internet that is not a response to one of your local computers or a service or application for which you set up a port forwarding or port triggering rule. Instead of discarding this traffic, you can direct the modem router to forward the traffic to one computer on your network. This computer is called the default DMZ server.

➢ **To set up a default DMZ server:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
3. Enter the modem router user name and password.
   - The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
   - The BASIC Home screen displays.
4. Select **ADVANCED > Setup > WAN Setup**.
   - The WAN Setup screen displays.
5. Select the **Default DMZ Server** check box.
6. Enter the IP address of the server.
7. Click the **Apply** button.
   - Your settings are saved.
IGMP proxying allows a computer on the local area network (LAN) to receive the multicast traffic it is interested in from the Internet. If you do not need this feature, leave it disabled, which is the default setting.

When Network Address Translation (NAT) is enabled in the modem router (see Manually Set Up the Internet Connection on page 44), it filters encrypted tunnel packets through NAT, causing these packets to become invalid. VPN pass-through allows encrypted tunnel packets to go through without being filtered and is enabled by default for IPSec, PPTP, and L2TP packets. Do not disable VPN pass-through for IPSec, PPTP, or L2TP unless a specific reason exists.

➢ To change the default IGMP proxying and VPN pass-through settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > Setup > WAN Setup.
   The WAN Setup screen displays.
6. To enable IGMP proxying, clear the Disable IGMP Proxying check box.
   By default, the Disable IGMP Proxying check box is selected and IGMP proxying is disabled.
7. To disable VPN pass-through for one or more protocols, select the corresponding Disable radio buttons in the VPN Passthrough section.
   By default, the VPN pass-through is enabled for all protocols for which the modem router supports pass-through (IPSec, PPT, and L2TP).
8. Click the Apply button.
   Your settings are saved.
Manage NAT Filtering

Network Address Translation (NAT) determines how the modem router processes inbound traffic. Secured NAT protects computers on the LAN from attacks from the Internet but might prevent some Internet games, point-to-point applications, or multimedia applications from working. Open NAT provides a much less secured firewall but allows almost all Internet applications to work. Secured NAT is the default setting.

➢ To change the default NAT filtering settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net. A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button. The BASIC Home screen displays.
5. Select ADVANCED > Setup > WAN Setup. The WAN Setup screen displays.
6. Select a NAT Filtering radio button:
   • Secured. Provides a secured firewall to protect the computers on the LAN from attacks from the Internet but might prevent some Internet games, point-to-point applications, or multimedia applications from functioning.
   • Open. Provides a less secured firewall but allows almost all Internet applications to function. By default, the Open radio button is selected.
7. Click the Apply button. Your settings are saved.

Manage the SIP Application-Level Gateway

The application-level gateway (ALG) for the Session Initiation Protocol (SIP) is enabled by default for enhanced address and port translation. However, some types of VoIP and video traffic might not work well when the SIP ALG is enabled. For this reason, the modem router provides the option to disable the SIP ALG.

➢ To change the default SIP ALG setting:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
A login screen displays.

3. Enter the user name and password for the modem router.
   The user name is \texttt{admin}. The default password is \texttt{password}. The user name and password are case-sensitive.

4. Click the \texttt{OK} button.
   The BASIC Home screen displays.

5. Select \texttt{ADVANCED > Setup > WAN Setup}.
   The WAN Setup screen displays.

6. To disable the SIP ALG, select the \texttt{Disable SIP ALG} check box.
   The SIP ALG is enabled by default.

7. Click the \texttt{Apply} button.
   Your settings are saved.

\section*{Manage the Modem Router’s LAN IP Address Settings}

The modem router is preconfigured to use private IP addresses on the LAN side and to act as a DHCP server. The modem router’s default LAN IP configuration is as follows:

- **LAN IP address.** 192.168.1.1 (This is the same as www.routerlogin.net and www.routerlogin.com.)
- **Subnet mask.** 255.255.255.0

These addresses are part of the designated private address range for use in private networks and are suitable for most applications. The IP address and subnet mask identify which addresses are local to a specific device and which must be reached through a gateway or modem router. You might want to change these settings if you need a specific IP subnet that one or more devices on the network use, or if competing subnets use the same IP scheme.

\begin{itemize}
  \item To change the LAN IP address settings:
    \begin{itemize}
      \item 1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
      \item 2. Type \texttt{http://www.routerlogin.net}.
        A login screen displays.
      \item 3. Enter the user name and password for the modem router.
        The user name is \texttt{admin}. The default password is \texttt{password}. The user name and password are case-sensitive.
      \item 4. Click the \texttt{OK} button.
        The BASIC Home screen displays.
      \item 5. Select \texttt{ADVANCED > Setup > LAN Setup}.
    \end{itemize}
\end{itemize}
6. In the **IP Address** field, enter the LAN IP address for the modem router.

7. In the **IP Subnet Mask**, enter the LAN subnet mask for the modem router.

8. Click the **Apply** button.

    Your settings are saved.

    If you changed the LAN IP address of the modem router, you are disconnected when the changes take effect.

    To reconnect, close your browser, relaunch it, and log in to the modem router at its new LAN IP address.

**Manage Reserved LAN IP Addresses**

When you specify a reserved IP address for a computer on the LAN, that computer always receives the same IP address each time it accesses the modem router's DHCP server.

**Reserve a LAN IP address**

You can assign a reserved IP address to a computer or server that requires permanent IP settings.

➤ To reserve an IP address:

   1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

   2. Type [http://www.routerlogin.net](http://www.routerlogin.net).

      A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home screen displays.

5. Select **ADVANCED > Setup > LAN Setup**.
   The LAN Setup screen displays.

6. In the Address Reservation section, click the **Add** button.

7. Either select a detected device from the Address Reservation Table table by selecting the corresponding radio button or specify the reserved IP address information:
   - In the **IP Address** field, enter the IP address to assign to the computer or device. Choose an IP address from the modem router’s LAN subnet, such as 192.168.1.x.
   - In the **MAC Address** field, enter the MAC address of the computer or device.
   - In the **Device Name** field, enter the name of the computer or device.

8. Click the **Add** button.
   The reserved address is entered into the table on the LAN Setup screen.

   The reserved address is not assigned until the next time the computer or device contacts the modem router’s DHCP server. Reboot the computer or device, or access its IP configuration and force a DHCP release and renew.

### Change a Reserved IP Address

You can change a reserved IP address entry.

➢ **To change a reserved IP address entry:**
1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home screen displays.
5. Select **ADVANCED > Setup > LAN Setup**.
   The LAN Setup screen displays.
6. In the Address Reservation section, select the radio button next to the reserved address.
7. Click the **Edit** button.  The Edit screen displays.

8. Change the settings.

9. Click the **Apply** button.  Your settings are saved.

### Remove a Reserved IP Address Entry

You can remove a reserved IP address entry.

- **To remove a reserved IP address entry:**
  1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
  2. Type `http://www.routerlogin.net`.
     A login screen displays.
  3. Enter the user name and password for the modem router.  The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
  4. Click the **OK** button.  The BASIC Home screen displays.
  5. Select **ADVANCED > Setup > LAN Setup**.  The LAN Setup screen displays.
  6. In the Address Reservation section, select the radio button next to the reserved address.
  7. Click the **Delete** button.  The address entry is removed.

### Change the Modem Router’s Device Name

The modem router’s default device name is D3600 or D6000, depending on the model. This device name displays in a file manager when you browse your network.

- **To change the modem router’s device name:**
  1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
  2. Type `http://www.routerlogin.net`.
     A login screen displays.
  3. Enter the user name and password for the modem router.
Manage the WAN and LAN Network Settings

The user name is admin. The default password is password. The user name and password are case-sensitive.

4. Click the OK button.
   The BASIC Home screen displays.

5. Select ADVANCED > Setup > LAN Setup.
   The LAN Setup screen displays.

6. In the Device Name field, enter a new name.
7. Click the Apply button.
   Your settings are saved.

Manage the DHCP Server Address Pool

By default, the modem router acts as a Dynamic Host Configuration Protocol (DHCP) server. The modem router assigns IP, DNS server, and default gateway addresses to all computers that are connected to its LAN and WiFi network. The assigned default gateway address is the LAN address of the modem router.

These addresses must be part of the same IP address subnet as the modem router’s LAN IP address. The default DHCP address pool is 192.168.1.2–192.168.1.254.

The modem router delivers the following parameters to any LAN device that requests DHCP:

- An IP address from the range that you define
- Subnet mask
- Gateway IP address (the modem router’s LAN IP address)
- DNS server IP address (the modem router’s LAN IP address)

To specify the pool of IP addresses that the modem router assigns:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > Setup > LAN Setup.
6. Make sure that the **Use Router as DHCP Server** check box is selected.

   This check box is selected by default.

7. Specify the range of IP addresses that the modem router assigns:
   - In the **Starting IP Address** field, enter the lowest number in the range.
     
     This IP address must be in the same subnet as the modem router. By default, the starting IP address is 192.168.1.2.
   
   - In the **Ending IP Address** field, enter the number at the end of the range of IP addresses.
     
     This IP address must be in the same subnet as the modem router. By default, the ending IP address is 192.168.1.254.

8. Click the **Apply** button.

   Your settings are saved.

---

**Disable the Built-In DHCP Server**

By default, the modem router functions as a DHCP server. The modem router assigns IP, DNS server, and default gateway addresses to all devices connected to the LAN. The assigned default gateway address is the LAN address of the modem router.

You can use another device on your network as the DHCP server or specify the network settings of all your computers.
Manage the WAN and LAN Network Settings

Note: If you disable the DHCP server and no other DHCP server is available on your network, you must set your computer IP addresses manually so that they can access the modem router.

➢ To disable the built-in DHCP server:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > Setup > LAN Setup.
   The LAN Setup screen displays.
6. Clear the Use Router as DHCP Server check box.
7. Click the Apply button.
   Your settings are saved.

Set Up and Manage Custom Static Routes

Static routes provide detailed routing information to your modem router. Typically, you do not need to add static routes. You must configure static routes only for unusual cases such as when you use multiple routers or multiple IP subnets on your network.

As an example of when a static route is needed, consider the following case:

• Your primary Internet access is through an ADSL modem to an ISP.
• You use an ISDN router on your home network for connecting to the company where you are employed. This router’s address on your LAN is 192.168.1.100.
• Your company’s network address is 134.177.0.0.

When you first configured your modem router, two implicit static routes were created. A default route was created with your ISP as the gateway and a second static route was created to your local network for all 192.168.1.x addresses. With this configuration, if you attempt to access a device on the 134.177.0.0 network, your modem router forwards your request to the ISP. The ISP forwards your request to the company where you are employed, and the request is likely to be denied by the company’s firewall.
In this case, you must define a static route, instructing your modem router that 134.177.0.0 is accessed through the ISDN modem router at 192.168.1.100. Here is an example:

- Through the destination IP address and IP subnet mask, specify that this static route applies to all 134.177.x.x addresses.
- Through the gateway IP address, specify that all traffic for these addresses is forwarded to the ISDN modem router at 192.168.1.100.
- A metric value of 1 works fine because the ISDN modem router is on the LAN.

**Set Up a Static Route**

You can add a static route to a destination IP address and specify the subnet mask, gateway IP address, and metric.

➢ **To set up a static route:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`. A login screen displays.
3. Enter the user name and password for the modem router.
   - The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the **OK** button.
   - The BASIC Home screen displays.
5. Select **ADVANCED > Advanced Setup > Static Routes**.
   - The Static Routes screen displays.
6. Click the **Add** button.
7. To make the route private, select the **Private** check box.
   A private static route is not reported through the Routing Information Protocol (RIP).

8. To prevent the route from becoming active after you click the **Apply** button, clear the **Active** check box.
   In some situations, you might want to set up a static route but keep it disabled until a later time. By default, the **Active** check box is selected and a route becomes active after you click the **Apply** button.

9. Enter the settings as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination IP Address</td>
<td>Enter the IP address for the final destination of the route.</td>
</tr>
<tr>
<td>IP Subnet Mask</td>
<td>Enter the IP subnet mask for the final destination of the route.</td>
</tr>
<tr>
<td></td>
<td>If the destination is a single host, enter <strong>255.255.255.255</strong>.</td>
</tr>
<tr>
<td>Gateway IP Address</td>
<td>Enter the IP address of the gateway. The IP address of the gateway must be on the same LAN segment as the modem router.</td>
</tr>
<tr>
<td>Metric</td>
<td>Enter a number from 1 through 15. This value represents the number of routers between your network and the destination. Usually, a setting of 2 or 3 works, but if this is a direct connection, set it to 1.</td>
</tr>
</tbody>
</table>

10. Click the **Apply** button.
    Your settings are saved. The static route is added to the table on the Static Routes screen.
**Change a Static Route**

You can change an existing static route.

- **To change a static route:**
  1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
  2. Type `http://www.routerlogin.net`.
      A login screen displays.
  3. Enter the user name and password for the modem router.
      The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
  4. Click the OK button.
      The BASIC Home screen displays.
  5. Select **ADVANCED > Advanced Setup > Static Routes**.
      The Static Routes screen displays.
  6. In the Static Routes table, select the radio button to the left of the route that you want to change.
  7. Click the Edit button.
      The screen adjusts.
  8. Change the settings for the route.
      For more information about the settings, see *Set Up a Static Route* on page 145.
  9. Click the Apply button.
      The route is updated in the table on the Static Routes screen.

**Remove a Static Route**

You can remove an existing static route that you no longer need.

- **To remove a static route:**
  1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
  2. Type `http://www.routerlogin.net`.
      A login screen displays.
  3. Enter the user name and password for the modem router.
      The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
  4. Click the OK button.
The BASIC Home screen displays.

5. Select **ADVANCED > Advanced Setup > Static Routes.**
   
The Static Routes screen displays.

6. In the Static Routes table, select the radio button to the left of the route that you want to remove.

7. Click the **Delete** button.
   
The route is removed from the table on the Static Routes screen.

---

**Improve Network Connections with Universal Plug and Play**

Universal Plug and Play (UPnP) helps devices such as Internet appliances and computers access the network and connect to other devices as needed. UPnP devices can automatically discover the services from other registered UPnP devices on the network.

If you use applications such as multiplayer gaming, peer-to-peer connections, or real-time communications such as instant messaging or remote assistance, keep UPnP enabled, which it is by default.

➢ **To manage Universal Plug and Play:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

2. Type **http://www.routerlogin.net**.
   
   A login screen displays.

3. Enter the user name and password for the modem router.
   
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   
   The BASIC Home screen displays.

5. Select **ADVANCED > Advanced Setup > UPnP.**
   
   The UPnP screen displays.

6. Select the **Turn UPnP On** check box.

   By default, this check box is selected. UPnP for automatic device configuration can be enabled or disabled. If the **Turn UPnP On** check box is cleared, the modem router does not allow any device to automatically control router resources, such as port forwarding.
7. Enter the advertisement period in minutes.
   The advertisement period specifies how often the modem router broadcasts its UPnP
   information. This value can range from 1 to 1440 minutes. The default period is
   30 minutes. Shorter durations ensure that control points detect current device status at
   the expense of more network traffic. Longer durations can compromise the freshness of
   the device status but can significantly reduce network traffic.

8. Enter the advertisement time to live in hops.
   The time to live for the advertisement is measured in hops (steps) for each UPnP packet
   sent. Hops are the steps a packet takes between routers. The number of hops can range
   from 1 to 255. The default value for the advertisement time to live is 4 hops, which should
   be fine for most home networks. If you notice that some devices are not being updated or
   reached correctly, it might be necessary to increase this value.

9. Click the **Apply** button.
   The UPnP Portmap Table displays the IP address of each UPnP device that is accessing
   the modem router and which ports (internal and external) that device opened. The UPnP
   Portmap Table also displays what type of port is open and whether that port is still active
   for each IP address.

   To refresh the information in the UPnP Portmap table, click the **Refresh** button.
Manage the Modem Router and Monitor the Traffic

This chapter describes how you can manage the settings for administering and maintaining your modem router and monitor the network.

The chapter includes the following sections:

- Update the Firmware of the Modem Router
- Manage the Configuration File of the Modem Router
- Return the Modem Router to Its Factory Default Settings
- View the Status and Statistics of the Modem Router
- Manage the Activity Log
- View Devices Currently on the Network
- Manage the Modem Router Remotely

For information about changing the admin password, see Change the admin Password on page 35.
Update the Firmware of the Modem Router

The modem router firmware is stored in flash memory.
You can check to see if new firmware is available and update the modem router to the new firmware. You can also visit the NETGEAR support website, download the firmware manually, and update the modem router to the new firmware.

Check for New Firmware and Update the Modem Router

For you to check for new firmware, the modem router must be connected to the Internet.

➢ To check for new firmware and update your modem router:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > Administration > Firmware Update.
   The Firmware Update screen displays.
6. Click the Check button.
   The modem router detects new firmware if any is available and displays a message asking if you want to download and install it.
7. To download and install the new firmware, click Yes.
   The modem router locates the firmware, downloads it, and begins the update.

**WARNING:**

To avoid the risk of corrupting the firmware, do not interrupt the upload. For example, do not close the browser, click a link, or load a new page. Do not turn off the modem router. Wait until the modem router finishes restarting and the Power LED turns solid green.

A progress bar shows the progress of the firmware upload process. The firmware upload process takes several minutes. When the upload is complete, your modem router restarts.
8. Verify that the modem router runs the new firmware version:
   a. Launch an Internet browser from a computer or WiFi device that is connected to the network.
   b. Type http://www.routerlogin.net.
      A login screen displays.
   c. Enter the user name and password for the modem router.
      The user name is admin. The default password is password. The user name and password are case-sensitive.
   d. Click the OK button.
      The BASIC Home screen displays.
      The firmware version is stated in the top right, under the Logout button.

9. To determine whether you must reconfigure the modem router after updating (which is unlikely but possible), visit downloadcenter.netgear.com, go to the support page for your product, and locate and read the new firmware release notes.

**Manually Upload New Firmware and Update the Modem Router**

Downloading firmware and updating the modem router are two separate tasks that are combined in the following procedure.

➢ To download new firmware manually and update your modem router:

1. Visit downloadcenter.netgear.com, locate the support page for your product, and download the new firmware.
2. Read the new firmware release notes to determine whether you must reconfigure the modem router after updating (which is unlikely but possible).
3. Launch an Internet browser from a computer or WiFi device that is connected to the network.
4. Type http://www.routerlogin.net.
   A login screen displays.
5. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
6. Click the OK button.
   The BASIC Home screen displays.
7. Select ADVANCED > Administration > Firmware Update.
   The Firmware Update screen displays.
8. Locate and select the firmware file on your computer:
   a. Click the Browse button.
b. Navigate to the firmware file.

The file ends in `.bin`. An example of a firmware file name is `D6000-V1.0.0.23_1.0.1.bin`.

c. Select the firmware file.

9. Click the **Upload** button.

**WARNING:**

To avoid the risk of corrupting the firmware, do not interrupt the upload. For example, do not close the browser, click a link, or load a new page. Do not turn off the modem router. Wait until the modem router finishes restarting and the Power LED turns solid green.

A progress bar shows the progress of the firmware upload process. The firmware upload process takes several minutes. When the upload is complete, your modem router restarts.

10. Verify that the modem router runs the new firmware version:

   a. Launch an Internet browser from a computer or WiFi device that is connected to the network.
   
   b. Type **http://www.routerlogin.net**.

A login screen displays.

   c. Enter the user name and password for the modem router.

   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

   d. Click the **OK** button.

The BASIC Home screen displays.

The version firmware is stated in the top right, under the **Logout** button.

---

**Manage the Configuration File of the Modem Router**

The configuration settings of the modem router are stored within the modem router in a configuration file. You can back up (save) this file to your computer or restore it.

**Back Up the Settings**

You can save a copy of the current configuration settings.

➢ To back up the modem router's configuration settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

2. Type **http://www.routerlogin.net**.
A login screen displays.

3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home screen displays.

5. Select **ADVANCED > Administration > Backup Settings**.
   The Backup Settings screen displays.

6. Click the **Back Up** button.

7. Choose a location to store the file on your computer.
   The name of the backup file is **NETGEAR_D3600.cfg** or **NETGEAR_D6000.cfg**.

8. Follow the directions of your browser to save the file.

**Restore the Settings**

If you backed up the configuration file, you can restore the configuration from this file.

➢ **To restore configuration settings that you backed up:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

2. Type **http://www.routerlogin.net**.
   A login screen displays.

3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home screen displays.

5. Select **ADVANCED > Administration > Backup Settings**.
   The Backup Settings screen displays.

6. Click the **Browse** button and navigate to and select the saved configuration file.
   The name of the backup file from which you can restore the configuration is **NETGEAR_D3600.cfg** or **NETGEAR_D6000.cfg**.
   Follow the directions of your browser to locate and select the file.
7. Click the Restore button.

The configuration is uploaded to the modem router. When the restoration is complete, the modem router reboots. This process takes about one minute.

**WARNING:**

To avoid the risk of corrupting the firmware, do not interrupt the restoration. For example, do not close the browser, click a link, or load a new page. Do not turn off the modem router. Wait until the modem router finishes restarting and the Power LED turns solid green.

**Return the Modem Router to Its Factory Default Settings**

Under some circumstances (for example, if you lost track of the changes that you made to the modem router settings or you move the modem router to a different network), you might want to erase the configuration and reset it to factory default settings.

If you do not know the current IP address of the modem router, first try to use an IP scanner application to detect the IP address before you reset the modem router to factory default settings.

To reset the modem router to factory default settings, you can use either the Reset button on the back panel of the modem router or the Erase function. However, if you cannot find the IP address or lost the password to access the modem router, you must use the Reset button.

After you reset the modem router to factory default settings, the user name is admin, the password is password, the LAN IP address is 192.168.1.1 (which is the same as www.routerlogin.net and www.routerlogin.com), and the DHCP server is enabled. For a list of factory default settings, see Factory Settings on page 199.

**Use the Reset Button**

**CAUTION:**

This process erases all settings that you configured in the modem router.

- **To reset the modem router to factory default settings:**
  1. On the back panel of the modem router, locate the Reset button.

  **Note:** The button is labeled Reset WPS.
2. Using a straightened paper clip, press and hold the **Reset** button for 6–15 seconds until the Power LED blinks.

   **Note:** If you release the button too quickly, you activate WPS (Wi-Fi Protected Setup) rather than reset the modem router to factory default settings.

3. Release the **Reset** button.

   The configuration is reset to factory default settings. When the reset is complete, the modem router reboots. This process takes about one minute.

   **WARNING:**

   To avoid the risk of corrupting the firmware, do not interrupt the reset. For example, if you are connected to the web management interface, do not close the browser, click a link, or load a new page. Do not turn off the modem router. Wait until the modem router finishes restarting and the Power LED turns solid green.

### Erase the Settings

   **CAUTION:**

   This process erases all settings that you configured in the modem router.

   ➢ **To erase the settings:**

   1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

   2. Type `http://www.routerlogin.net`.

      A login screen displays.

   3. Enter the user name and password for the modem router.

      The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home screen displays.

5. Select **ADVANCED > Administration > Backup Settings**.
   The Backup Settings screen displays.

6. Click the **Erase** button.
7. To confirm the action, click the **Yes** button.
   The configuration is reset to factory default settings. When the reset is complete, the modem router reboots. This process takes about one minute.

**WARNING:**
To avoid the risk of corrupting the firmware, do not interrupt the reset. For example, do not close the browser, click a link, or load a new page. Do not turn off the modem router. Wait until the modem router finishes restarting and the Power LED turns solid green.

**View the Status and Statistics of the Modem Router**
You can view information about the modem router, its broadband modem, and ports, and the status of the Internet connection and WiFi network. In addition, you can view traffic statistics for the various ports.

**View Information About the Modem Router and the Internet, Modem, and WiFi Settings**
You can view modem router information, the Internet port status, and WiFi settings.

➢ **To view information about the modem router and the Internet, modem, and WiFi settings:**
1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home screen displays.
5. Select **ADVANCED > ADVANCED Home**.
The information onscreen uses the following color coding:

- A green flag \(\checkmark\) indicates that a link is up.
- A red X \(\times\) indicates that a link is down.
- An amber exclamation mark \(\!\) indicates that a WiFi network is disabled. The following table describes the fields of the six panes on the ADVANCED Home screen.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Router Information</strong></td>
<td></td>
</tr>
<tr>
<td>Hardware Version</td>
<td>The modem router model.</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>The version of the modem router firmware. If you upgrade the firmware on the</td>
</tr>
<tr>
<td></td>
<td>modem router, the version changes.</td>
</tr>
<tr>
<td><strong>Internet Port</strong></td>
<td></td>
</tr>
<tr>
<td>MAC Address</td>
<td>C0:FF:D4:BE:42:B4</td>
</tr>
<tr>
<td>IP Address</td>
<td>192.168.18.11</td>
</tr>
<tr>
<td>DHCP Server</td>
<td>On</td>
</tr>
</tbody>
</table>

Manage the Modem Router and Monitor the Traffic

158
### Manage the Modem Router and Monitor the Traffic

#### N600 and AC750 WiFi DSL Modem Routers

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GUI Language Version</td>
<td>The version of the modem router firmware. If you upgrade the firmware on modem router, the version changes.</td>
</tr>
<tr>
<td>LAN Port</td>
<td>The version of the modem router firmware. If you upgrade the firmware on modem router, the version changes.</td>
</tr>
</tbody>
</table>

**LAN Port**
The settings of the LAN port. For information about how to configure the LAN settings, see Manage the Modem Router’s LAN IP Address Settings on page 138 and Disable the Built-In DHCP Server on page 143.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAC Address</td>
<td>The Media Access Control (MAC) address. This address is the unique physical address that is assigned to the Ethernet LAN port.</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address that the Ethernet LAN port uses. The default IP address is 192.168.1.1.</td>
</tr>
<tr>
<td>DHCP</td>
<td>Displays whether the DHCP server of the modem router is enabled for devices that are attached to the LAN.</td>
</tr>
</tbody>
</table>

**Internet Port**
The settings of Internet port. The Internet connection can run through the ADSL port with DSL service or through the WAN Ethernet port with cable or fiber service. For information about how to configure the Internet settings, see one of the following sections:

- Set Up Your Modem Router for DSL Service on page 18
- Set Up Your Modem Router for Cable or Fiber Service on page 26
- Manually Set Up the Internet Connection on page 44.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAC Address</td>
<td>The Media Access Control (MAC) address. This address is the unique physical address that is assigned to the Internet port.</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address that the Internet port uses. If this field does not display an address or displays 0.0.0.0 as the address, the modem router is not connected to the Internet.</td>
</tr>
<tr>
<td>Connection</td>
<td>The type of Internet connection, which can be a PPPoE connection, PPPoA connection, fixed IP address connection, or DHCP connection.</td>
</tr>
<tr>
<td>IP Subnet Mask</td>
<td>The IP subnet mask that the Internet port uses.</td>
</tr>
<tr>
<td>Gateway IP Address</td>
<td>The IP address of the gateway that the Internet port uses.</td>
</tr>
<tr>
<td>Domain Name Server</td>
<td>The IP address of the Domain Name System (DNS) server that the Internet uses.</td>
</tr>
</tbody>
</table>

**Wireless Settings (2.4GHz)**
The settings of the WiFi port for the 2.4 GHz band of the main network. For information about how to configure the settings of the main network, see Manage the Basic WiFi Settings and WiFi Security of the Main Network on page 56, Control the WiFi Radios on page 73, and Manage Advanced WiFi Features on page 76.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (SSID)</td>
<td>The WiFi network name for the 2.4 GHz band of the main network.</td>
</tr>
<tr>
<td>Region</td>
<td>The location (country).</td>
</tr>
<tr>
<td>Channel</td>
<td>The channel that the 2.4 GHz band of the main network uses.</td>
</tr>
<tr>
<td>Mode</td>
<td>The WiFi mode in which the 2.4 GHz band operates for both the main network and the guest network.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Wireless AP</th>
<th>Displays whether the 2.4 GHz band of the main network is enabled. If the 2.4 GHz band is disabled but the 5 GHz band is enabled, the WiFi LED on the front of the modem router lights green. If both radios are off, the WiFi LED is off too.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Broadcast Name</td>
<td>Displays whether the 2.4 GHz band of the main network broadcasts its SSID.</td>
</tr>
<tr>
<td>Wireless Isolation</td>
<td>Displays whether wireless isolation is enabled for the 2.4 GHz band of the main network.</td>
</tr>
</tbody>
</table>
| Wi-Fi Protected Setup | Displays whether the modem router keeps its existing WiFi settings when you use WPS to connect a device to the 2.4 GHz band of the main network:  
  • **Configured.** The modem router keeps its existing WiFi settings. This is the default setting.  
  • **Not configured.** The modem router generates a random SSID and passphrase and changes the security mode to WPA/WPA2-PSK mixed mode. |
| BSSID | The basic set service identification (BSSID) of the 2.4 GHz band for both the main network and guest network. The BSSID is the MAC address of the 2.4 GHz radio. |
| **Wireless Settings (5.0GHz)** | The settings of the WiFi port for the 5 GHz band of the main network. For information about how to configure the settings of the main network, see [Manage the Basic WiFi Settings and WiFi Security of the Main Network](#) on page 56, [Control the WiFi Radios](#) on page 73, and [Manage Advanced WiFi Features](#) on page 76. |
| Name (SSID) | The WiFi network name for the 5 GHz band of the main network. |
| Region | The location (country). |
| Channel | The channel that the 5 GHz band of the main network uses. |
| Mode | The WiFi mode in which the 5 GHz band operates for both the main network and the guest network. |
| Wireless AP | Displays whether the 5 GHz band of the main network is enabled. If the 5 GHz band is disabled but the 2.4 GHz band is enabled, the WiFi LED on the front of the modem router lights green. If both radios are off, the WiFi LED is off too. |
| Broadcast Name | Displays whether the 5 GHz band of the main network broadcasts its SSID. |
| Wireless Isolation | Displays whether wireless isolation is enabled for the 5 GHz band of the main network. |
| Wi-Fi Protected Setup | Displays whether the modem router keeps its existing WiFi settings when you use WPS to connect a device to the 5 GHz band of the main network:  
  • **Configured.** The modem router keeps its existing WiFi settings. This is the default setting.  
  • **Not configured.** The modem router generates a random SSID and passphrase and changes the security mode to WPA/WPA2-PSK mixed mode. |
View the Traffic Statistics

You can view the traffic statistics for the ports of the modem router, change the polling frequency, and stop traffic polling.

➢ To view the traffic statistics for the ports of the modem router:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.
   The BASIC Home screen displays.

5. Select **ADVANCED > ADVANCED Home**.
   The ADVANCED Home screen displays.

6. In the Internet Port pane, click the **Show Statistics** button.

![Image of Show Statistics](image)

The following table describes the fields and columns of the Show Statistics pop-up screen.

<table>
<thead>
<tr>
<th>Field or Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Up Time</td>
<td>The time elapsed since the modem router was last restarted.</td>
</tr>
<tr>
<td>Port</td>
<td>The statistics for the WAN (Internet link over Ethernet) port, LAN (Ethernet) ports, and WLAN (WiFi) ports. For each port, the screen displays the information that is described in this table.</td>
</tr>
<tr>
<td>Status</td>
<td>The link status of the port.</td>
</tr>
<tr>
<td>TxPkts</td>
<td>The number of packets transmitted on this port since reset or manual clear.</td>
</tr>
<tr>
<td>RxPkts</td>
<td>The number of packets received on this port since reset or manual clear.</td>
</tr>
<tr>
<td>Collisions</td>
<td>The number of signal collisions that occurred on the port. A collision occurs when the port attempts to send data at the same time as the device that is connected to the port.</td>
</tr>
<tr>
<td>Tx B/S</td>
<td>The number of bytes transmitted per second on the port.</td>
</tr>
<tr>
<td>Rx B/S</td>
<td>The number of bytes received per second on the port.</td>
</tr>
<tr>
<td>Up Time</td>
<td>The time elapsed since this port acquired the link.</td>
</tr>
</tbody>
</table>
To change the traffic statistics polling frequency or stop polling:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > ADVANCED Home.
   The ADVANCED Home screen displays.
6. In the Internet Port pane, click the Show Statistics button.
   A pop-up screen displays.
7. Change the polling frequency or stop polling:
   • To change the polling frequency:
     a. In the Poll Interval field, enter a time in seconds.
     b. Click the Set Interval button.
   • To stop polling, click the Stop button.
View or Change a PPPoE or PPPoA Internet Connection

You can view information about a PPPoE or PPPoA Internet connection of the modem router and establish or terminate such a connection. This information displays only if the modem router connects to the ISP network over a PPPoE connection (see Specify an Internet Connection That Uses a Login and PPPoE Service on page 47) or PPPoA connection (see Specify an Internet Connection That Uses a Login and PPPoA Service on page 50).

➢ To view or change the PPPoE or PPPoA Internet connection status:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > ADVANCED Home.
   The ADVANCED Home screen displays.
6. In the Internet Port pane, click the Connection Status button.
   The fields that display depend on the type of Internet connection.
   The following screen shows an established PPPoE connection.
The following table describes the fields of the Connection Status pop-up screen.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Time</td>
<td>The time elapsed since the connection was established.</td>
</tr>
<tr>
<td>Connection Status</td>
<td>The status can be Connected or Disconnected.</td>
</tr>
<tr>
<td>Negotiation</td>
<td>The negotiation can be a series of dashes, which indicates that the connection is not established, or successful (Success).</td>
</tr>
<tr>
<td>Authentication</td>
<td>The authentication can be a series of dashes, which indicates that the connection is not established, or successful (Success).</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address that is assigned by the ISP to the modem router.</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>The subnet mask that is assigned by the ISP to the modem router.</td>
</tr>
</tbody>
</table>

7. To establish the Internet connection when the connection is down, click the **Connect** button.
8. To terminate the Internet connection when the connection is active, click the **Disconnect** button.
9. Click the **Close Window** button.
   The pop-up screen closes.

**View or Change a TCP/IP Internet Connection**

You can view information about a TCP/IP Internet connection of the modem router and renew or release such a connection. This information displays only if the modem router connects to the ISP network over a TCP/IP connection (see *Specify an Internet Connection Without a Login* on page 44).

➢ **To view or change the TCP/IP Internet connection status:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home screen displays.
5. Select **ADVANCED > ADVANCED Home**.
   The ADVANCED Home screen displays.
6. In the Internet Port pane, click the **Connection Status** button.
   The fields that display depend on the type of Internet connection.
The following screen shows the fields for an established TCP/IP connection with DHCP.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>The IP address that is assigned by the ISP to the modem router.</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>The subnet mask that is assigned by the ISP to the modem router.</td>
</tr>
<tr>
<td>Default Gateway</td>
<td>The IP address of the default gateway of the ISP that the modem router communicates with.</td>
</tr>
<tr>
<td>DHCP Server</td>
<td>The IP address of the DHCP server of the ISP that issues the IP address to the modem router.</td>
</tr>
<tr>
<td>DNS Server</td>
<td>The IP address of the Domain Name System (DNS) server of the ISP that provides translation of network names to IP addresses.</td>
</tr>
<tr>
<td>Lease Obtained</td>
<td>The time at which the modem router obtained the DHCP lease. (The type of DHCP connection determines whether this field displays onscreen.)</td>
</tr>
<tr>
<td>Lease Expires</td>
<td>The time at which the DHCP lease expires. (The type of DHCP connection determines whether this field displays onscreen.)</td>
</tr>
</tbody>
</table>

7. To renew the Internet connection when the connection is active, click the **Renew** button.
8. To terminate the Internet connection when the connection is active, click the **Release** button.
9. Click the **Close Window** button.

The pop-up screen closes.
Manage the Activity Log

The log is a detailed record of the websites users on your network accessed or attempted to access and many other modem router actions. Up to 256 entries are stored in the log. You can also manage which activities are logged.

View the Logs

➢ To manage which activities are logged and view the log:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the modem router user name and password.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
   The BASIC Home screen displays.
4. Select ADVANCED > Administration > Logs.
The Logs screen shows the following information:

- **Action.** The action that occurred, such as whether Internet access was blocked or allowed.
- **Source.** The name, IP address, or MAC address of the target device, application, or website for this log entry.
- **Target.** The name, IP address, or MAC address of the target device, application, or website for this log entry.
- **Date and time.** The date and time at which the action occurred.

5. To refresh the log screen, click the **Refresh** button.
6. To clear the log entries, click the **Clear Log** button.
7. To email the log immediately, click the **Send Log** button.
   The modem router emails the logs to the address that you specified (see *Set Up Security Event Email Notifications* on page 100).

### Specify Which Activities Are Logged

You can specify which activities are logged. These activities display in the log.

➢ **To manage which activities are logged:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home screen displays.
5. Select **ADVANCED > Administration > Logs**.
   The Logs screen displays.
6. Scroll down and select the check boxes that correspond to the activities that you want to be logged.
   By default, all check boxes are selected.
7. Clear the check boxes that correspond to the activities that do not want to be logged.
8. Click the **Apply** button.
   You settings are saved.
View Devices Currently on the Network

You can view the active wired devices, 2.4 GHz WiFi devices, and 5 GHz WiFi devices in the network. If you do not recognize a WiFi device, it might be an intruder. If it is an intruder, make sure that your WiFi security is set up correctly (see Manage the WiFi Settings and WiFi Security of the Guest Network) or set up a WiFi access list to secure your WiFi network (see Set Up a WiFi Access List and Manage WiFi Access).

➢ To display the wired and WiFi devices:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select Attached Devices.
   The Attached Devices screen displays.
   Wired devices are connected to the modem router with Ethernet cables. WiFi devices are connected to the modem router through the WiFi network, either in the 2.4 GHz band or the 5 GHz band.
   The following table describes the fields on the Attached Devices screen.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>The order in which the device joined the network.</td>
</tr>
<tr>
<td>SSID</td>
<td>The SSID to which the WiFi device is connected. (This field does not apply to wired devices.)</td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address that the modem router assigned to the device when it joined the network. This number can change when a device is disconnected and rejoins the network.</td>
</tr>
<tr>
<td>MAC Address</td>
<td>The unique MAC address. The MAC address does not change and is usually shown on the product label.</td>
</tr>
<tr>
<td>Device Name</td>
<td>The device name, if detected.</td>
</tr>
</tbody>
</table>

6. To refresh the information onscreen, click the Refresh button.
   The information onscreen is updated.
Manage the Modem Router Remotely

The remote management feature lets you access your modem router securely over the Internet to view or change its settings. You need to know the modem router’s WAN IP address to use this feature. For information about remote access using Dynamic DNS, see Set Up and Manage Dynamic DNS on page 125.

**Note:** Be sure to change the password for the user name admin to a secure password. The ideal password contains no dictionary words from any language and contains uppercase and lowercase letters, numbers, and symbols. It can be up to 30 characters. See Change the admin Password on page 35.

➢ **To set up remote management:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`. A login screen displays.
3. Enter the user name and password for the modem router. The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the **OK** button. The BASIC Home screen displays.
5. Select **ADVANCED > Advanced Setup > Remote Management**.

![Remote Management Configuration](image-url)
6. Select the **Turn Remote Management On** check box.

7. In the Allow Remote Access By section, specify the external IP addresses to be allowed to access the modem router’s remote management:

   **Note:** For enhanced security, restrict access to as few external IP addresses as practical.

   Select one of the following radio buttons and configure the options accordingly:

   - To allow access from a single IP address on the Internet, select the **Only This Computer** radio button. Enter the IP address to be allowed access.
   - To allow access from a range of IP addresses on the Internet, select the **IP Address Range** radio button. Enter a beginning and ending IP address to define the allowed range.
   - To allow access from any IP address on the Internet, select the **Everyone** radio button. This radio button is selected by default.

8. Specify the port number for accessing the web management interface.

   The default is 8443, which is a common alternate for HTTPS. For greater security, enter a custom port number for the remote web management interface. Choose a number from 1024 to 65535, but do not use the number of any common service port.

9. Click the **Apply** button.

   Your settings are saved.

➢ **To use remote access:**

   1. Launch an Internet browser on a computer that is not on your home network.
   2. Enter your modem router’s WAN IP address into your browser’s address or location field followed by a colon (:) and the custom port number.

      For example, if your external address is 100.168.110.147 and you use port number 8443, enter **https://100.168.110.147:8443** in your browser.
You can use outbound firewall rules, port forwarding, and port triggering to set up rules for Internet traffic for services and applications. You need networking knowledge to set up these features.

This chapter includes the following sections:

- Manage Port Forwarding to a Local Server for Services and Applications
- Manage Port Triggering for Services and Applications
Manage Port Forwarding to a Local Server for Services and Applications

If a server is part of your network, you can allow certain types of incoming traffic to reach the server. For example, you might want to make a local web server, FTP server, or game server visible and available to the Internet.

The modem router can forward incoming traffic with specific protocols to computers on your local network. You can specify the servers for applications and you can also specify a default DMZ server to which the modem router forwards all other incoming protocols (see Set Up a Default DMZ Server on page 135).

Forward Incoming Traffic for a Default Service or Application

You can forward traffic for a default service or application to a computer on your network.

To forward incoming traffic for a default service or application:

1. Decide which type of service, application, or game you want to provide.
2. Find the local IP address of the computer on your network that will provide the service.
   The server computer must always receive the same IP address. To specify this setting, use the reserved IP address feature. See Manage Reserved LAN IP Addresses on page 139.
3. Launch an Internet browser from a computer or WiFi device that is connected to the network.
4. Type http://www.routerlogin.net.
   A login screen displays.
5. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
6. Click the OK button.
   The BASIC Home screen displays.
7. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
8. Make sure that the **Port Forwarding** radio button is selected.

9. From the **Service Name** menu, select the service or application.

   If the service or application that you want to add is not in the list, create a port forwarding rule with a custom service or application (see *Add a Port Forwarding Rule with a Custom Service or Application* on page 174).

10. In the **Server IP Address** field, enter the IP address of the computer that must provide the service or that runs the application.

11. Click the **Add** button.

   Your settings are saved and the rule is added to the table.

---

**Add a Port Forwarding Rule with a Custom Service or Application**

The modem router lists default services and applications that you can use in port forwarding rules. If the service or application is not predefined, you can add a port forwarding rule with a custom service or application.

➢ **To add a port forwarding rule with a custom service or application:**

1. Find out which port number or range of numbers the service or application uses.
   
   You can usually find this information by contacting the publisher of the service or application or through user groups or news groups.

2. Launch an Internet browser from a computer or WiFi device that is connected to the network.

3. Type **http://www.routerlogin.net**.
   
   A login screen displays.
4. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.

5. Click the OK button.
   The BASIC Home screen displays.

6. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
   The Port Forwarding / Port Triggering screen displays.

7. Make sure that the Port Forwarding radio button is selected.

8. Click the Add Custom Service button.

9. Specify a new port forwarding rule with a custom service or application as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Name</td>
<td>Enter the name of the custom service or application.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Select the protocol (TCP or UDP) that is associated with the service or application. If you are unsure, select TCP/UDP.</td>
</tr>
<tr>
<td>External Start Port</td>
<td>Enter the external start port number that the service or application uses.</td>
</tr>
<tr>
<td>External End Port</td>
<td>Enter the external end port number that the service or application uses.</td>
</tr>
<tr>
<td>Internal Start Port</td>
<td>Specify the internal start port by one of these methods:</td>
</tr>
<tr>
<td></td>
<td>• Leave the Use the same port range for Internal port check box selected.</td>
</tr>
<tr>
<td></td>
<td>• Clear the Use the same port range for Internal port check box and enter the internal start port number that the service or application uses.</td>
</tr>
</tbody>
</table>
10. Click the **Apply** button.

Your settings are saved. The rule is added to the table on the Port Forwarding / Port Triggering screen.

### Change a Port Forwarding Rule

You can change an existing port forwarding rule.

➢ **To change a port forwarding rule:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

2. Type `http://www.routerlogin.net`.

   A login screen displays.

3. Enter the user name and password for the modem router.

   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.

4. Click the **OK** button.

   The BASIC Home screen displays.

5. Select **ADVANCED > Advanced Setup > Port Forwarding / Port Triggering**.

   The following figure shows two port forwarding rules.
6. Make sure that the **Port Forwarding** radio button is selected.
7. In the table, select the radio button next to the service or application name.
8. Click the **Edit Service** button.
   The Ports - Custom Services screen displays.
9. Change the settings.
   For more information about the settings, see *Add a Port Forwarding Rule with a Custom Service or Application* on page 174.
10. Click the **Apply** button.
    Your settings are saved. The changed rule displays in the table on the Port Forwarding / Port Triggering screen.

### Remove a Port Forwarding Rule

You can remove a port forwarding rule that you no longer need.

- **To remove a port forwarding rule:**
  1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
  2. Type **http://www.routerlogin.net**.
     A login screen displays.
  3. Enter the user name and password for the modem router.
     The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
  4. Click the **OK** button.
The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.

The following figure shows two port forwarding rules.

![Port Forwarding / Port Triggering Screen]

6. Make sure that the Port Forwarding radio button is selected.
7. In the table, select the radio button next to the service or application name.
8. Click the Delete Service button.

The rule is removed from the table.

**Application Example: Make a Local Web Server Public**

If you host a web server on your local network, you can use port forwarding to allow web requests from anyone on the Internet to reach your web server.

➢ **To make a local web server public:**

1. Assign your web server either a fixed IP address or a dynamic IP address using DHCP address reservation.

   In this example, your modem router always gives your web server an IP address of 192.168.1.55.

2. On the Port Forwarding / Port Triggering screen, configure the modem router to forward the HTTP service to the local address of your web server at **192.168.1.55**.

   HTTP (port 80) is the standard protocol for web servers.

3. *(Optional)* Register a host name with a Dynamic DNS service, and specify that name on the Dynamic DNS screen of the modem router.
Dynamic DNS makes it much easier to access a server from the Internet because you can enter the name in the Internet browser. Otherwise, you must know the IP address that the ISP assigned, which typically changes.

**How the Modem Router Implements the Port Forwarding Rule**

The following sequence shows the effects of a port forwarding rule:

1. When you enter the URL www.example.com in your browser, the browser sends a web page request message with the following destination information:
   - **Destination address**. The IP address of www.example.com, which is the address of your modem router.
   - **Destination port number**. 80, which is the standard port number for a web server process.

2. The modem router receives the message and finds your port forwarding rule for incoming port 80 traffic.

3. The modem router changes the destination in the message to IP address 192.168.1.123 and sends the message to that computer.

4. Your web server at IP address 192.168.1.123 receives the request and sends a reply message to your modem router.

5. Your modem router performs Network Address Translation (NAT) on the source IP address and sends the reply through the Internet to the computer or WiFi device that sent the web page request.

**Manage Port Triggering for Services and Applications**

Port triggering is a dynamic extension of port forwarding that is useful in these cases:

- An application must use port forwarding to more than one local computer (but not simultaneously).
- An application must open incoming ports that are different from the outgoing port.

With port triggering, the modem router monitors traffic to the Internet from an outbound “trigger” port that you specify. For outbound traffic from that port, the modem router saves the IP address of the computer that sent the traffic. The modem router temporarily opens the incoming port or ports that you specify in your rule and forwards that incoming traffic to that destination.

Port forwarding creates a static mapping of a port number or range of ports to a single local computer. Port triggering can dynamically open ports to any computer when needed and close the ports when they are no longer needed.
Manage Port Forwarding and Port Triggering

180

Note: If you use applications such as multiplayer gaming, peer-to-peer connections, real-time communications such as instant messaging, or remote assistance, enable Universal Plug and Play (UPnP). See Improve Network Connections with Universal Plug and Play on page 148.

Add a Port Triggering Rule

The modem router does not provide default services and applications for port triggering rules. You must define a custom service or application for each port triggering rule.

➢ To add a port triggering rule:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
   The Port Forwarding / Port Triggering screen displays.
6. Select the Port Triggering radio button.
7. Click the **Add Service** button.

![Port Triggering - Services](image)

8. Specify a new port triggering rule with a custom service or application as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Name</td>
<td>Enter the name of the custom service or application.</td>
</tr>
</tbody>
</table>
| Service User        | From the **Service User** menu, select **Any**, or select **Single address** and enter the IP address of one computer:  
  • **Any**. This is the default setting and allows any computer on the Internet to use this service.  
  • **Single address**. Restricts the service to a particular computer. |
| Service Type        | Select the protocol (**TCP** or **UDP**) that is associated with the service or application. |
| Triggering Port     | Enter the number of the outbound traffic port that must open the inbound ports. |

**Inbound Connection**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Connection Type     | Select the protocol (**TCP** or **UDP**) that is associated with the inbound connection.  
  If you are unsure, select **TCP/UDP**. |
| Starting Port       | Enter the start port number for the inbound connection. |
| Ending Port         | Enter the end port number for the inbound connection. |

9. Click the **Apply** button.

Your settings are saved and the rule is added to the Port Triggering Portmap Table on the Port Forwarding / Port Triggering screen.
Change a Port Triggering Rule

You can change an existing port triggering rule.

➢ To change a port triggering rule:
  1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
  2. Type http://www.routerlogin.net.
     A login screen displays.
  3. Enter the user name and password for the modem router.
     The user name is admin. The default password is password. The user name and password are case-sensitive.
  4. Click the OK button.
     The BASIC Home screen displays.
  5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
     The Port Forwarding / Port Triggering screen displays.
  6. Select the Port Triggering radio button.
     The following figure shows two port triggering rules.

    ![Port Forwarding / Port Triggering Screen]

  7. In the Port Triggering Portmap Table, select the radio button next to the service or application name.
  8. Click the Edit Service button.
     The Port Triggering - Services screen displays.
  9. Change the settings.
For more information about the settings, see *Add a Port Triggering Rule* on page 180.

10. Click the **Apply** button.

Your settings are saved. The changed rule displays in the Port Triggering Portmap Table on the Port Forwarding / Port Triggering screen.

**Remove a Port Triggering Rule**

You can remove a port triggering rule that you no longer need.

➢ **To remove a port triggering rule:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type **http://www.routerlogin.net**.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is **admin**. The default password is **password**. The user name and password are case-sensitive.
4. Click the **OK** button.
   The BASIC Home screen displays.
5. Select **ADVANCED > Advanced Setup > Port Forwarding / Port Triggering**.
   The Port Forwarding / Port Triggering screen displays.
6. Select the **Port Triggering** radio button.
   The following figure shows two port triggering rules.
7. In the Port Triggering Portmap Table, select the radio button next to the service or application name.

8. Click the Delete Service button.

   The rule is removed from the Port Triggering Portmap Table.

Specify the Time-Out Period for Port Triggering

The time-out period for port triggering controls how long the inbound ports stay open when the modem router detects no activity. A time-out period is required because the modem router cannot detect when the service or application terminates.

To specify the time-out for port triggering:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.

2. Type http://www.routerlogin.net.

   A login screen displays.

3. Enter the user name and password for the modem router.

   The user name is admin. The default password is password. The user name and password are case-sensitive.

4. Click the OK button.

   The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.

   The Port Forwarding / Port Triggering screen displays.

6. Select the Port Triggering radio button.

   The port triggering settings display.

7. In the Port Triggering Time-out field, enter a value up to 9999 minutes.

   The default setting is 20 minutes.

8. Click the Apply button.

   Your settings are saved.
Disable Port Triggering

By default, port triggering is enabled. You can disable port triggering temporarily without removing any port triggering rules.

➢ To disable port triggering:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
   The Port Forwarding / Port Triggering screen displays.
6. Select the Port Triggering radio button.
   The port triggering settings display.
7. Clear the Disable Port Triggering check box.
   If this check box is selected, the modem router does not apply port triggering rules even if you specified them.
8. Click the Apply button.
   Your settings are saved.

Application Example: Port Triggering for Internet Relay Chat

Some application servers, such as FTP and IRC servers, send replies to multiple port numbers. Using port triggering, you can tell the modem router to open more incoming ports when a particular outgoing port starts a session.

An example is Internet Relay Chat (IRC). Your computer connects to an IRC server at destination port 6667. The IRC server not only responds to your originating source port but also sends an “identify” message to your computer on port 113. Using port triggering, you can tell the modem router, “When you initiate a session with destination port 6667, you must also allow incoming traffic on port 113 to reach the originating computer.”
The following sequence shows the effects of this port triggering rule:

1. You open an IRC client program to start a chat session on your computer.
2. Your IRC client composes a request message to an IRC server using a destination port number of 6667, the standard port number for an IRC server process. Your computer then sends this request message to your modem router.
3. Your modem router creates an entry in its internal session table describing this communication session between your computer and the IRC server. Your modem router stores the original information, performs Network Address Translation (NAT) on the source address and port, and sends this request message through the Internet to the IRC server.
4. Noting your port triggering rule and observing the destination port number of 6667, your modem router creates another session entry to send any incoming port 113 traffic to your computer.
5. The IRC server sends a return message to your modem router using the NAT-assigned source port (for example, port 33333) as the destination port and the IRC server also sends an “identify” message to your modem router with destination port 113.
6. When your modem router receives the incoming message to destination port 33333, it checks its session table to see if a session is active for port number 33333. Finding an active session, the modem router restores the original address information replaced by NAT and sends this reply message to your computer.
7. When your modem router receives the incoming message to destination port 113, it checks its session table and finds an active session for port 113 associated with your computer. The modem router replaces the message’s destination IP address with your computer’s IP address and forwards the message to your computer.
8. When you finish your chat session, your modem router eventually senses a period of inactivity in the communications. The modem router then removes the session information from its session table, and incoming traffic is no longer accepted on port numbers 33333 or 113.
This chapter provides information to help you diagnose and solve problems you might experience with your modem router. If you do not find the solution here, check the NETGEAR support site at http://support.netgear.com for product and contact information.

This chapter contains the following sections:

- Quick Tips for Troubleshooting
- Troubleshoot with the LEDs
- You Cannot Log In to the Modem Router
- Troubleshoot the Internet Connection
- Changes Are Not Saved
- Troubleshoot the WiFi Connectivity
- Troubleshoot Your Network Using the Ping Utility
Quick Tips for Troubleshooting

The following table includes tips for troubleshooting some common problems.

Table 3. Quick tips for troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
</table>
| Your network is unresponsive or does not function normally.            | **Restart your network:**  
1. Turn off and unplug the DSL, cable, or fiber modem.  
2. Turn off the modem router.  
3. Plug in the DSL, cable, or fiber modem and turn it on. Wait two minutes.  
4. Turn on the modem router and wait two minutes.  
If network problems still occur, make sure that your ISP does not require you to use the MAC address of the computer that was used to initially register the ISP account. If your ISP does require that you do this, you must change the router MAC address that the modem router uses. For more information, see *Manually Set Up the Internet Connection* on page 44. |
| Your cannot connect over an Ethernet cable to the modem router.       | • Make sure that the Ethernet cables are securely plugged in.  
• Make sure that your computer or device does not use a static IP address but is configured to receive an IP address automatically with DHCP. (For most devices, DHCP is the default setting.) |
| You cannot connect over WiFi to the modem router.                     | • Make sure that the WiFi settings in your WiFi device and modem router match exactly.  
For a device that is connected over WiFi, the WiFi network name (SSID) and WiFi security settings of the modem router and WiFi computer must match exactly. The default SSID and password are on the product label (see *Bottom Panel Product Label* on page 13).  
• Make sure that your WiFi device supports the security that you are using for your WiFi network (WEP, WPA, or WPA2). For information about WiFi security settings, see *Manage the Basic WiFi Settings and WiFi Security of the Main Network* on page 56.  
• Make sure that the modem router is not too far from your WiFi device or too close:  
  - Move your WiFi device near the modem router but at least 6 feet (2 meters) away and see if the signal strength improves.  
  - Make sure that the WiFi signal is not blocked by objects between the modem router and your WiFi device.  
• Make sure that the WiFi LED on the modem router is not off.  
If this LED is off, both WiFi radios might be disabled. For more information about the WiFi radios, see *Control the WiFi Radios* on page 73.  
• Make sure that the modem router's SSID broadcast is not disabled.  
If the modem router's SSID broadcast is disabled, the WiFi network name is hidden and does not display in your WiFi device’s scanning list. To connect to a hidden network, you must type the network name and the WiFi password. For more information about the SSID broadcast, see *Manage the Basic WiFi Settings and WiFi Security of the Main Network* on page 56.  
• Make sure that your WiFi device does not use a static IP address but is configured to receive an IP address automatically with DHCP. (For most devices, DHCP is the default setting.) |
Troubleshoot with the LEDs

When you turn on the power, the LEDs light as described here.

1. When power is first applied, the Internet LED \[\text{\ding{115}}\] lights solid green for about 20 seconds and then starts blinking.

2. After approximately 25 seconds after turning on the power, the following occurs:
   - The WiFi LED \[\text{\ding{116}}\] lights green.
   - The WPS LED \[\text{\ding{117}}\] lights green.
   - If the modem router is connected to an active ADSL service, the DSL LED \[\text{\ding{119}}\] blinks green to indicate that the modem router is negotiating the best possible speed on the DSL line. If the negotiation completes and a DSL link is established, the LED turns solid green. If you do not use a DSL modem but a cable or fiber modem, the DSL LED remains off.

3. After approximately 40 seconds after turning on the power, the Ethernet LED \[\text{\ding{112}}\] lights green for any Ethernet devices that are connected.

4. After approximately 80 seconds after turning on the power, the Power LED \[\text{\ding{110}}\] lights solid green, indicating that the startup procedure is complete.

5. When an Internet connection is established, the Internet LED \[\text{\ding{115}}\] lights solid green.

Power LED Is Off

If the Power LED \[\text{\ding{110}}\] and other LEDs are off when your modem router is turned on, do the following:

- Check that the power cord is correctly connected to your modem router and that the power supply adapter is correctly connected to a functioning power outlet.
- Check that you are using the 12 VDC 1.2A power adapter that NETGEAR supplied for this product.

If the error persists, a hardware problem might exist. For recovery instructions or help with a hardware problem, contact technical support at [www.netgear.com/support](http://www.netgear.com/support).

WiFi LED Is Off

If the WiFi LED \[\text{\ding{116}}\] remains off, check to see if the radios on the modem router are turned off (see [Control the WiFi Radios](#) on page 73). By default, the radios are turned on and the WiFi LED lights solid green.
**Ethernet LED Is Off**

If the Ethernet LED does not light when you connect a device, check the following:

- The Ethernet cable connections are secure at the modem router and at the hub or device.
- The power is turned on to the connected hub or device.
- You are using the correct cable.

**You Cannot Log In to the Modem Router**

If you are unable to log in to the modem router from a computer on your local network and use the web management interface, check the following:

- If you are using an Ethernet-connected computer, check the Ethernet connection between the computer and the modem router.
- If the computer is set to a static or fixed IP address (this setting is uncommon), either change the computer to obtain an IP address automatically from the modem router through DHCP, or change the IP address of the computer to a static or fixed IP address in the 192.168.1.2–192.168.1.254 range.
- Make sure that your computer can reach the modem router’s DHCP server. Recent versions of Windows and Mac OS generate and assign an IP address if the computer cannot reach a DHCP server. These autogenerated addresses are in the range of 169.254.x.x. If your IP address is in this range, check the connection from the computer to the modem router and reboot your computer.
- If your modem router’s IP address was changed and you do not know the current IP address, use an IP scanner application to detect the IP address. If you still cannot find the IP address, clear the modem router’s configuration to factory defaults. This sets the modem router’s IP address to 192.168.1.1. For more information, see Return the Modem Router to Its Factory Default Settings on page 155 and Factory Settings on page 199.
- Make sure that Java, JavaScript, or ActiveX is enabled in your browser. If you are using Internet Explorer, click the Refresh button to be sure that the Java applet is loaded.
- Try quitting the browser and launching it again.
- Make sure that you are using the correct login information. The user name is admin, and the default password is password. Make sure that Caps Lock is off when you enter this information.
- If you are attempting to set up your modem router as a replacement for an ADSL gateway in your network, the modem router cannot perform many gateway services. For example, the modem router cannot convert ADSL or cable data into Ethernet networking information. NETGEAR does not support such a configuration.
Troubleshoot the Internet Connection

If your modem router cannot access the Internet, check the DSL connection, then the WAN TCP/IP connection.

Troubleshoot the DSL Link

If your modem router is unable to access the Internet, first determine whether the DSL link with the service provider is working. The DSL LED [green] indicates the state of this connection.

DSL LED Is Green

If the DSL link LED is green, the ADSL connection is good. You can be confident that the service provider connected your line correctly and that your wiring is correct.

DSL LED Is Blinking Green

If the DSL LED is blinking green, your modem router is attempting to make an ADSL connection with the service provider. The DSL LED turns green within several minutes.

If the DSL LED does not turn green, disconnect all telephones on the line. If this solves the problem, reconnect the telephones one at a time, being sure to use a microfilter on each telephone. If the microfilters are connected correctly, you can connect all your telephones.

If disconnecting telephones does not result in a green DSL LED, a problem with your wiring might exist. If the telephone company tested the ADSL signal at your network interface device (NID), then wiring in your house might be of poor quality.

DSL LED Is Off or Internet LED Is Off

If the modem router is connected to an active ADSL service but the DSL LED [green] is off, the Internet LED [green] is off, or both are off, disconnect all telephones on the line. If this solves the problem, reconnect the telephones one at a time, being sure to use a microfilter on each telephone. If the microfilters are connected correctly, you can connect all your telephones.

If disconnecting telephones does not result in a green DSL LED, check the following:

• Check that the telephone company made the connection to your line and tested it.
• Verify that you are connected to the correct telephone line. If more than one phone line is installed, be sure that you are connected to the line with the ADSL service. It might be necessary to use a swapper if your ADSL signal is on pins 1 and 4 or the RJ-11 jack. The modem router uses pins 2 and 3.
Internet LED Is Off

If the Internet LED 🟢 is off, the modem router cannot connect to the Internet. Verify the following:

- Check that your login credentials are correct or that the information you entered for the ISP connection is correct (see Manually Set Up the Internet Connection on page 44).
- Check if your ISP is experiencing a problem—it might not be that the modem router cannot connect to the Internet, but rather that your ISP cannot provide an Internet connection.

Obtain an Internet IP Address

If the modem router cannot access the Internet but the Internet LED 🟢 lights green, see if the modem router can obtain an Internet IP address from the ISP. Unless the modem router is assigned a static IP address, the modem router requests an IP address from the ISP. You can determine whether the request was successful using the web management interface.

➢ To check the Internet IP address:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type http://www.routerlogin.net.
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is admin. The default password is password. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select ADVANCED > ADVANCED Home.
   The ADVANCED Home screen displays.
6. In the Internet Port pane, check that the IP Address field shows a valid IP address.
   If the field shows 0.0.0.0, your modem router did not obtain an IP address from your ISP.

If your modem router cannot obtain an IP address from the ISP, the problem might be one of the following:

- Your Internet service provider (ISP) might require a login program.
  Ask your ISP whether they require PPP over Ethernet (PPPoE) or some other type of login.
- If you selected a login program, the service name, user name, or password might be incorrectly set.
  For more information, see Troubleshoot PPPoE or PPPoA on page 193.
Troubleshooting N600 and AC750 WiFi DSL Modem Routers

- Your ISP might check for your computer’s host name. Assign the computer host name of your ISP account as the account name. For more information, see *Manually Set Up the Internet Connection* on page 44.
- If your ISP allows only one Ethernet MAC address to connect to Internet and checks for your computer’s MAC address, do one of the following:
  - Inform your ISP that you bought a new network device and ask them to use the modem router’s MAC address.
  - Configure your modem router to clone your computer’s MAC address. For more information, see *Manually Set Up the Internet Connection* on page 44.

**Troubleshoot PPPoE or PPPoA**

If you use a PPPoE or PPPoA connection to your ISP, make sure that the connection works.

➢ **To verify that your PPPoE or PPPoA connection is working:**

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
3. Enter the user name and password for the modem router.
   - The user name is *admin*. The default password is *password*. The user name and password are case-sensitive.
4. Click the **OK** button.
   - The BASIC Home screen displays.
5. Select **ADVANCED > ADVANCED Home**.
   - The ADVANCED Home screen displays.
6. In the Internet Port pane, check that the IP Address field shows a valid IP address and that the Connection field shows PPPoE or PPPoA.
7. In the Internet Port pane, click the **Connection Status** button.
   - The Connection Status screen displays.
8. Check the following:
   - The Connection Status field shows Connected.
   - The Connection Time field does not show 00:00:00.

If all of the information is correct, your PPPoE or PPPoA connection is working.
To reconnect if your PPPoE or PPPoA connection does not function:

1. Launch an Internet browser from a computer or WiFi device that is connected to the network.
2. Type `http://www.routerlogin.net`
   A login screen displays.
3. Enter the user name and password for the modem router.
   The user name is `admin`. The default password is `password`. The user name and password are case-sensitive.
4. Click the OK button.
   The BASIC Home screen displays.
5. Select **ADVANCED > ADVANCED Home**.
   The ADVANCED Home screen displays.
6. In the Internet Port pane, click the **Connection Status** button.
   The Connection Status screen displays.
7. Click the **Connect** button.
   The modem router attempts to reconnect.

If you cannot connect after several minutes, you might be using an incorrect service name, user name, or password. Or your ISP might not be able to provide an Internet connection. Unless you connect manually, the modem router does not authenticate using PPPoE or PPPoA until data is transmitted to the network.

**Troubleshoot Internet Browsing**

If your modem router can obtain an IP address but your computer is unable to load any web pages from the Internet, it might be for one of the following reasons:

- Your computer might not recognize any DNS server addresses.
  A DNS server is a host on the Internet that translates Internet names (such as www addresses) to numeric IP addresses. Typically your ISP provides the addresses of one or two DNS servers for your use. If you entered a DNS address when you set up the modem router, reboot your computer and verify the DNS address. Alternatively, you can configure your computer manually with DNS addresses, as explained in your operating system documentation.

- The modem router might not be configured as the TCP/IP router on your computer.
  For information about TCP/IP problems, see **Troubleshoot Your Network Using the Ping Utility** on page 196.

If your computer obtains its information from the modem router by DHCP, reboot the computer and verify the modem router address.
Changes Are Not Saved

If the modem router does not save the changes that you make in the web management interface, do the following:

- When entering configuration settings, always click the **Apply** button before moving to another screen or tab or your changes are lost.
- Click the **Refresh** or **Reload** button in the web browser. It is possible that the changes occurred but that the old settings remain in the web browser's cache.

Troubleshoot the WiFi Connectivity

If you are experiencing trouble connecting over WiFi to the modem router, try to isolate the problem:

- Does the WiFi device that you are using find your WiFi network?
  
  If not, check that the modem router's WiFi LED lights green. If this LED is off, the WiFi radios might be disabled. For more information about the WiFi radios, see *Control the WiFi Radios* on page 73.

- Make sure that the WiFi settings in your WiFi device and modem router match exactly.
  
  For a device that is connected over WiFi, the WiFi network name (SSID) and WiFi security settings of the modem router and WiFi computer must match exactly. The default SSID and password are on the product label (see *Bottom Panel Product Label* on page 13).

- If you disabled the modem router’s SSID broadcast, your WiFi network is hidden and does not display in your WiFi client’s scanning list. (By default, SSID broadcast is enabled.) For more information, see *Manage the Basic WiFi Settings and WiFi Security of the Main Network* on page 56.

- Does your WiFi device support the security that you are using for your WiFi network (WEP, WPA, or WPA2)? For information about changing the WiFi security, see *Manage the Basic WiFi Settings and WiFi Security of the Main Network* on page 56.

**Note:** If you want to change the WiFi settings for the modem router, use an Ethernet cable to connect a computer to a LAN port on the modem router and then log in to the modem router.

If your WiFi device finds your network but the signal strength is weak, check these conditions:

- Is your modem router too far from your WiFi device or too close? Place your WiFi device near the modem router but at least 6 feet (1.8 meters) away and see whether the signal strength improves.
- Are objects between the modem router and your WiFi device blocking the WiFi signal?
Troubleshoot Your Network Using the Ping Utility

Most network devices and routers contain a ping utility that sends an echo request packet to the designated device. The device then responds with an echo reply. You can easily troubleshoot a network using the ping utility in your computer or workstation.

Test the LAN Path to Your Modem Router

You can ping the modem router from your computer to verify that the LAN path to your modem router is set up correctly.

➢ To ping the modem router from a Windows computer:

1. From the Windows taskbar, click the Start button and select Run.
2. In the field provided, type ping followed by the IP address of the modem router, as in this example:
   ping 192.168.1.1
3. Click the OK button.
   A message such as the following one displays:
   Pinging <IP address> with 32 bytes of data
   If the path is working, you see this message:
   Reply from < IP address >: bytes=32 time=NN ms TTL=xxx
   If the path is not working, you see this message:
   Request timed out

If the path is not functioning correctly, one of the following problems might be occurring:

• Wrong physical connections
  For a wired connection, make sure that the numbered LAN port LED is lit for the port to which you are connected.
  Check that the appropriate LEDs are on for your network devices. If your modem router and computer are connected to a separate Ethernet switch, make sure that the link LEDs are lit for the switch ports that are connected to your computer and modem router.

• Wrong network configuration
  Verify that the Ethernet card driver software and TCP/IP software are both installed and configured on your computer.
  Verify that the IP address for your modem router and your computer are correct and that the addresses are on the same subnet.
Test the Path from Your Computer to a Remote Device

After you verify that the LAN path works correctly, test the path from your computer to a remote device:

1. From the Windows toolbar, click the Start button and select Run.
2. In the field provided, type
   
   `ping -n 10 IP address`

   where `IP address` is the IP address of a remote device such as your ISP’s DNS server.

If the path is functioning correctly, replies as described in Test the LAN Path to Your Modem Router on page 196 display. If you do not receive replies, do the following:

- Check that the IP address of your modem router is listed as the default router in your computer. If the IP configuration of your computer is assigned by DHCP, this information is not visible in your computer’s Network Control Panel. Verify that the IP address of the modem router is listed as the default router.
- Check that the network address of your computer (the portion of the IP address specified by the netmask) is different from the network address of the remote device.
- If your ISP assigned a host name to your computer, enter that host name as the account name (see Manually Set Up the Internet Connection on page 44).
- Your ISP might be rejecting the Ethernet MAC addresses of all but one of your computers.

Many broadband ISPs restrict access by allowing traffic only from the MAC address of your modem, but some additionally restrict access to the MAC address of a single computer connected to that modem. In this case, configure your modem router to clone or spoof the MAC address from the authorized computer (see Manually Set Up the Internet Connection on page 44).
Supplemental Information

This appendix covers the following topics:

- Factory Settings
- Technical and Environmental Specifications
Factory Settings

You can return the modem router to its factory default settings (see Return the Modem Router to Its Factory Default Settings on page 155). The following table shows the factory default settings.

Table 4. Factory default settings

<table>
<thead>
<tr>
<th>Feature</th>
<th>Default Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Router Login</strong></td>
<td></td>
</tr>
<tr>
<td>User login URL</td>
<td><a href="http://www.routerlogin.com">www.routerlogin.com</a> or <a href="http://www.routerlogin.net">www.routerlogin.net</a></td>
</tr>
<tr>
<td>User name (case-sensitive)</td>
<td>admin</td>
</tr>
<tr>
<td>Login password (case-sensitive)</td>
<td>password</td>
</tr>
<tr>
<td>Remote management</td>
<td>Disabled</td>
</tr>
<tr>
<td><strong>Internet connection</strong></td>
<td></td>
</tr>
<tr>
<td>Physical WAN type of connection</td>
<td>ADSL2+</td>
</tr>
<tr>
<td>Use of Ethernet port LAN4 WAN</td>
<td>LAN</td>
</tr>
<tr>
<td>Network Address Translation (NAT)</td>
<td>Enabled</td>
</tr>
<tr>
<td>WAN MAC address</td>
<td>Use default hardware address</td>
</tr>
<tr>
<td><strong>Local area network (LAN)</strong></td>
<td></td>
</tr>
<tr>
<td>LAN IP address</td>
<td>192.168.1.1</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>DHCP server</td>
<td>Enabled</td>
</tr>
<tr>
<td>DHCP range</td>
<td>192.168.1.2 to 192.168.1.254</td>
</tr>
<tr>
<td>DHCP start IP address</td>
<td>192.168.1.2</td>
</tr>
<tr>
<td>DHCP end IP address</td>
<td>192.168.1.254</td>
</tr>
<tr>
<td>UPnP</td>
<td>Disabled</td>
</tr>
<tr>
<td><strong>Wide area network (WAN)</strong></td>
<td></td>
</tr>
<tr>
<td>WAN MTU size</td>
<td>1500</td>
</tr>
<tr>
<td>Port scan and DoS protection</td>
<td>Enabled</td>
</tr>
<tr>
<td>Respond to ping on Internet port</td>
<td>Disabled</td>
</tr>
<tr>
<td>IGMP proxying</td>
<td>Disabled</td>
</tr>
<tr>
<td>NAT filtering</td>
<td>Open</td>
</tr>
<tr>
<td>SIP ALG</td>
<td>Enabled</td>
</tr>
</tbody>
</table>
### Main WiFi network

<table>
<thead>
<tr>
<th>Feature</th>
<th>Default Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country/region</td>
<td>Varies by region</td>
</tr>
<tr>
<td>WiFi radios</td>
<td>Enabled</td>
</tr>
<tr>
<td>SSID name</td>
<td>See product label</td>
</tr>
<tr>
<td>Broadcast SSID</td>
<td>Enabled (both radios)</td>
</tr>
<tr>
<td>Wireless isolation</td>
<td>Disabled (both radios)</td>
</tr>
<tr>
<td>Security</td>
<td>WPA2-PSK (AES)</td>
</tr>
<tr>
<td>WiFi network key (passphrase)</td>
<td>See product label</td>
</tr>
<tr>
<td>RF channel</td>
<td></td>
</tr>
<tr>
<td>2.4 GHz band: Auto</td>
<td></td>
</tr>
<tr>
<td>5 GHz band: Auto</td>
<td></td>
</tr>
<tr>
<td>Operating mode(^1)</td>
<td></td>
</tr>
<tr>
<td>N600 WiFi DSL Modem Router, Model D3600:</td>
<td></td>
</tr>
<tr>
<td>2.4 GHz band: Up to 145 Mbps</td>
<td></td>
</tr>
<tr>
<td>5 GHz band: Up to 300 Mbps</td>
<td></td>
</tr>
<tr>
<td>AC750 WiFi DSL Modem Router, Model D6000:</td>
<td></td>
</tr>
<tr>
<td>2.4 GHz band: Up to 145 Mbps</td>
<td></td>
</tr>
<tr>
<td>5 GHz band: Up to 433 Mbps</td>
<td></td>
</tr>
</tbody>
</table>

### Guest WiFi network

<table>
<thead>
<tr>
<th>Feature</th>
<th>Default Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>WiFi communication</td>
<td>Disabled (both radios)</td>
</tr>
<tr>
<td>SSID name</td>
<td></td>
</tr>
<tr>
<td>2.4 GHz band:</td>
<td></td>
</tr>
<tr>
<td>NETGEAR-Guest</td>
<td></td>
</tr>
<tr>
<td>NETGEAR-Guest2</td>
<td></td>
</tr>
<tr>
<td>NETGEAR-Guest3</td>
<td></td>
</tr>
<tr>
<td>5 GHz band:</td>
<td></td>
</tr>
<tr>
<td>NETGEAR-5G-Guest</td>
<td></td>
</tr>
<tr>
<td>NETGEAR-5G-Guest2</td>
<td></td>
</tr>
<tr>
<td>NETGEAR-5G-Guest3</td>
<td></td>
</tr>
<tr>
<td>Broadcast SSID</td>
<td>Enabled (both radios)</td>
</tr>
<tr>
<td>Allow guests to access main network</td>
<td>Disabled (both radios)</td>
</tr>
<tr>
<td>Wireless isolation</td>
<td>Disabled (both radios)</td>
</tr>
<tr>
<td>Security</td>
<td>None (open network)</td>
</tr>
</tbody>
</table>
Table 4. Factory default settings (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Default Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>General WiFi settings</td>
<td></td>
</tr>
<tr>
<td>Radio transmission power</td>
<td>100 percent</td>
</tr>
<tr>
<td>20/40 MHz coexistence</td>
<td>Enabled</td>
</tr>
<tr>
<td>Fragmentation length</td>
<td>2346</td>
</tr>
<tr>
<td>CTS/RTS threshold</td>
<td>2347</td>
</tr>
<tr>
<td>Preamble mode</td>
<td>• 2.4 GHz band: Long Preamble</td>
</tr>
<tr>
<td></td>
<td>• 5 GHz band: Automatics</td>
</tr>
<tr>
<td>WPS settings</td>
<td></td>
</tr>
<tr>
<td>Router’s PIN</td>
<td>Enabled</td>
</tr>
<tr>
<td>PIN auto-disable</td>
<td>After three failed PIN connection attempts</td>
</tr>
<tr>
<td>Keep existing wireless</td>
<td>• 2.4 GHz band: Enabled</td>
</tr>
<tr>
<td></td>
<td>• 5 GHz band: Enabled</td>
</tr>
</tbody>
</table>

1. Maximum WiFi signal rate derived from IEEE Standard 802.11 specifications. Actual throughput can vary. Network conditions and environmental factors, including volume of network traffic, building materials and construction, and network overhead, lower actual data throughput rate.

Table 5. Modem router specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data and routing protocols</td>
<td>TCP/IP, DHCP, PPPoE, PPTP, IPoA, DNS, and UPnP</td>
</tr>
<tr>
<td>Power adapter</td>
<td>• North America: 120V, 60 Hz, input</td>
</tr>
<tr>
<td></td>
<td>• UK, Australia: 240V, 50 Hz, input</td>
</tr>
<tr>
<td></td>
<td>• Europe: 230V, 50 Hz, input</td>
</tr>
<tr>
<td></td>
<td>• All regions (output): 12V/1.2 ADC output</td>
</tr>
<tr>
<td>Dimensions (width x depth x height)</td>
<td>N600 WiFi DSL Modem Router, Model D3600: 240 x 181 x 41 mm (9.44 x 7.12 x 1.61 in.)</td>
</tr>
<tr>
<td></td>
<td>• AC750 WiFi DSL Modem Router, Model D6000: 240 x 182 x 41 mm (9.44 x 7.16 x 1.61 in.)</td>
</tr>
<tr>
<td>Weight</td>
<td>• N600 WiFi DSL Modem Router, Model D3600: 400 g (0.88 lb)</td>
</tr>
<tr>
<td></td>
<td>• AC750 WiFi DSL Modem Router, Model D6000: 393 g (0.86 lb)</td>
</tr>
<tr>
<td>Operating temperature</td>
<td>0° to 40°C (32° to 104°F)</td>
</tr>
<tr>
<td>Operating humidity</td>
<td>90% maximum relative humidity, noncondensing</td>
</tr>
<tr>
<td>Electromagnetic emissions</td>
<td>EN 55 022 (CISPR 22), Class B C-Tick N10947</td>
</tr>
</tbody>
</table>
### Table 5. Modem router specifications (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN</td>
<td>10BASE-T or 100BASE-TX, RJ-45</td>
</tr>
<tr>
<td>WAN</td>
<td>10BASE-T or 100BASE-TX, RJ-45</td>
</tr>
<tr>
<td>WiFi</td>
<td>Maximum WiFi signal rate complies with the IEEE 802.11 standard. See the footnote for the table in <em>Factory Settings</em> on page 199.</td>
</tr>
<tr>
<td>Radio data rates</td>
<td>Auto rate sensing</td>
</tr>
</tbody>
</table>
| Data encoding standards       | • IEEE 802.11ac 2.0 (AC750 WiFi DSL Modem Router, Model D6000)  
• IEEE 802.11n version 2.0  
• IEEE 802.11n 256QAM IEEE 802.11g, IEEE 802.11b 2.4 GHz  
IEEE 802.11n, IEEE 802.11a 5.0 GHz |
| Maximum computers per WiFi network | Limited by the amount of WiFi network traffic generated by each node (typically 16 nodes).                                                 |
| Operating frequency range     | • 2.4 GHz band  
- US: 2.412–2.462 GHz  
- Europe: 2.412–2.472 GHz  
- Australia: 2.412–2.472 GHz  
- Japan: 2.412–2.472 GHz  
• 5 GHz band  
- US: 5.18–5.24 + 5.745–5.825 GHz and DFS (5.25–5.35 + 5.50–5.70)  
- Europe: 5.18–5.24 GHz and DFS (5.25–5.35 + 5.50–5.70)  
- Australia: 5.18–5.24 + 5.745–5.825 GHz and DFS (5.25–5.35 + 5.50–5.70)  
- Japan: 5.18–5.24 GHz and DFS (5.25–5.35 + 5.50–5.70) |
| 802.11 security               | WPA2-PSK, WPA/WPA2, WPA-PSK, and WEP                                                                                                      |